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1. Release Notes

Backaground / Environment

Oracle Financial Services Software Limited has developed Oracle Financial Services Lending and
Leasing solution. The suite is a comprehensive, end-to-end solution that supports full lifecycle of
direct and indirect consumer lending business with Origination, Servicing and Collections modules.
This enables financial institutions to make faster lending decisions, provide better customer service
and minimize delinquency rates through a single integrated platform. It addresses each of the
lending processes from design through execution. Its robust architecture and use of leading-edge
industry standard products ensure almost limitless scalability.

Purpose

The purpose of this Release Note is to highlight the enhancements included in the Oracle Financial
Services Lending and Leasing Release.

Abbreviations

Abbreviation Detailed Description
OFSLL Oracle Financial Services Lending and Leasing

ACX Account Boarding

TXN Transaction Processing

UIX User Interface
ORG Origination

CS Customer Service

SEC Securitization

LN Loan / Line

LS Lease

OE Open Ended

CE Close Ended

XAE Web service Application Entry

XCS Web service Customer Service

GAIl Generic Auction Interface

ORACLE



1.4

1.5

Abbreviation Detailed Description

GRI Generic Recovery Interface

CRB Credit Bureau

WFP Wholesale floor Planning

SQL Structured Query Language

XML Extensible Mark-up Language

XSD XML Schema Definition
POJO Plain Old java Object

API Conversion Open Interface

LHS Left Hand Side

Product Summary

Oracle Financial Services Lending and Leasing Release is built to meet various challenges faced
by financial institutions. It addresses each of the lending processes from design through execution.
Its unique value lies in its ability to provide the business with predefined processes and a world-
class framework that takes care of business risk and compliance needs.

Release Highlights

The key highlight of this release is to enhance the industry specific requirements for the current

release of the product.

ORACLE



2. Enhancements

Ref No.

Enhancement

Description

OFSLL_PMG_INTERFA
CE_RQT_095

Restful Web Service
Authorization

New ‘Webservice’ tab is introduced to configure
responsibility access for each web service.

OFSLL_PMG_INTERFA
CE_RQT_094

Restful Web Service
Refactoring

Refactoring of Restful Web Services is done to
support the following:

e Single response for all XSD request errors
e Remove XSD response validation

e Send valid HTTP status code

e Adding root element for JISON request

e Deprecate USE_CONTAINER_AUTH

header

e Marking User Name input parameter as
optional

All single parameter Web Services now supports
Path Parameter instead of Query Parameter

OFSLL_PMG_RQT_804

‘Products, Assets
and Asset Sub
Type’ Restful Web
Service

New Restful Web Service is developed to Fetch
‘Products’, ‘Assets’ and ‘Asset Sub Type’ details.
This service is used while integrating OFSLL with
3 party systems like customer self-service portals,
application-sourcing portals and so on.

OFSLL_PMG_RQT_809

Process Files
Enhancement

OFSLL Process Files interface is enhanced to
support the following:

e Access Incoming/Outgoing files through
Restful Web Service

e Mask file location details and
history details

record

Incoming process file service can be leveraged to
receive incoming file [ex: Payment upload, Nacha
return file, title tracking] using web service.

Outgoing process files service can be used and
leveraged by 3™ party vendors to GET files from
OFSLL [Ex: Statement file by 3 party vendors,
Nacha Outgoing, etc]

OFSLL_PMG_RQT 808

Document Restful
Web Service

New Restful Web Service is developed to
download and upload document for application and
accounts.
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Ref No.

Enhancement

Description

OFSLL_PMG_RQT_810

Force Job Set
Resubmit

OFSLL is enhanced with the option to forcefully
resubmit job set with status READY, COMPLETED
or FAILED.

[Note : Earlier limitation on only Failed jobs can be
resubmitted is supressed with this enhancement]

OFSLL_PMG_RQT_807

New Origination
Web Services

New Origination Restful Web Service is developed
for the following:

e Application Comments

e Application ACH

o Application Checklist

e Application Status Change

OFSLL_PMG_RQT _823

Application Entry
Restful Web
Services

‘Application Entry’ Restful Webservice is enhanced
to support SCRA fields and auto decisioning.

Also, the new Application Entry Restful Web
Service can fetch and update existing data.

OFSLL_PMG_RQT_830

Account Comment
Restful Web Service

‘Account Comment’ Web Service is introduced to
fetch account comments from external interfaces.

OFSLL_PMG_RQT _817

Account
Acceleration

OFSLL is enhanced with the option to accelerate
an account in case of default, prior to scheduled
maturity date. Acceleration effectively moves the
maturity date up to the date of the demand for full
payment and this can be the current date or a back
date

e Provide the ability to accelerate the
account.

OFSLL_PMG_RQT_196

Collateral
Remarketing

OFSLL facilitates remarketing of customer asset
while integrating with third party auction house and
is also enabled to receive invoice for the auction
performed.

This enhancement enables OFSLL with the
following remarketing capabilities:

e Ability to send repossessed vehicle to
auction house.

e Send and Receive updates from auction
house on the Asset/Collateral.

e Once Asset/Collateral is sold, receive the
invoice from auction house.

e Receive sale proceeds from Auction
house.

ORACLE




Ref No. Enhancement Description
OFSLL-7023 Account X- A new parameter is used for conversion accounts
Reference Number P . .
to decide option of account number generation.
OFSLL - 7037 Archive Vendor / The archive logic of Work Order and Invoice Data

Work Order / Invoice
Data

is modified and also new facility of archiving for
Vendor information is provided.

OFSLL_PMG_RQT_821

Change Term

On posting of a CHANGE TERM transaction,

Transaction system now updates Term and Maturity date.
OFSLL_PMG_RQT_ 533 | Vendor re- A new lookup is added to control the vendor re-
assignment assignment based on specific days.

Bug 26325828

Update for Lien
Release Entity -
Others

There is now an option to capture address details
in Tracking Attribute (ASSET LIEN/TITLE
(VEHICLE)) for ‘Others’ entity type.

Bug 26169828

Update for NACHA
file Processing
validations

The following new system parameter is introduced
to control NACHA file processing validation -
LBX_DR_CR_VALIDATE_A MT_IND.

OFSLL_PMG_RQT_826

Extension for
Seriously Delinquent
Accounts

The existing monetary transaction
‘EXTENSION_OVERRIDE’ is enhanced to post
extension on seriously delinquent accounts.

ORACLE




Ref No.

Enhancement

Description

OFSLL_PMG_RQT_805

Performance
Enhancements

Data in  below mentioned tabs are
segregated/grouped on the number of days (1 day,
1 week, 1Month and date range). This
enhancement will help for the implementations that
have huge volumes.

e Servicing/collections > Interfaces > AP
Transactions

e Servicing/collections > Batch Transactions
> Payments > “Payment Entry”

e Servicing/collections > Interfaces > GL
Transactions > GL Transactions

e Servicing/collections > Interfaces > GL
Transactions > Amortized Transactions

e Servicing/collections > Interfaces > GL
Transactions > WFP GL Transactions

e Servicing/collections/Origination >
Producers > “Transactions”

e Servicing/collections/Origination >
Vendors > “Work Orders”

e Servicing/collections/Origination >
Vendors > Invoices

¢ Following tabs in “System Monitor”.
o Jobs > Batch
o Jobs > Back Ground
o Jobs > Credit Request
o Database Server Log Files
o Parked Transactions
o Users

e Producers > Title Status Summary

OFSLL_PMG_RQT_820

Securitization
Enhancements

Securitization screen allows to securitize accounts
irrespective their status which previously was
supported only for ACTIVE accounts.

Bug 26189183

Batch Job to
Transfer Balance on
Charge-off Reversal

New batch job ‘TXNCHG_BJ_100_03 is
introduced in SET-TPE to move the expense and
fee from charge off balance to active balance.

2-4

Bug 25669696

GRI integration
should log all
communications
with external
interface system.

New system parameter
‘GRI_WEBSERVICE_LOG_IND’ is provided to
decide for logging all GRI communications with
external interfaced system. Also a radio button is
introduced to filter and view logs pertaining to GRI
communication in Database Server Log Files.
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Ref No.

Enhancement

Description

OFSLL_PMG_RQT_726

Review Request
Enhancements

Review Request tab is enhanced in Origination
and servicing to enable reviewer to take faster
decision by

e Exchange multiple comments between
Originator and Receiver and logging
comments in “Comments History” tab.

e Allowing current receiver to forward the
review request to another receiver in case
of an escalation.

OFSLL_PMG_RQT_841

Collection Queue
Enhancements

The Queue Assignment tab is enhanced to help
customer servicing/Collection agent to categorize
and prioritize work.

e New Activity fields are added to capture
the activities completed on an account
using call activities.

e A sort order and criteria definition tab is
provided to write different criteria’'s and
sort orders on top of a queue to priorities
the work.

OFSLL_PMG_RQT_842

Collections
Summary Screen

New ‘Collections’ tab is introduced in Servicing and
Collections to display the customer information
along with Due and promises, important days
related to accounts in a calendar, customer
preference details and activities done an account.
This screen will give a snapshot of important
account information required for a collection user.

OFSLL_PMG_RQT_840

Pay Day and
Customer
Preference
Enhancement

Employments details tab is enhanced to capture
customer pay day and Pay day frequency and
same should be propagated to servicing. This
information is useful for the collection users to
contact the customer on payday.

A “Customer Preference” tab is added to capture
the customer preferred communication mode as
currently different communication modes are
captured at different places.

OFSLL_PMG_RQT 813

Insurance rebate
enhancements

The following changes are introduced:

e New monetary transaction is provided to
generate insurance rebate quote.

e System shows the transaction results for
‘Insurance Cancellation’ monetary
transaction.

2-5
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Ref No. Enhancement Description

OFSLL_PMG_RQT 816 | Metro Il and e Provided the ability to update 24 month
Accounts data history from legacy system to OFSLL.
conversion
enhancements e Provided the facility to on-board the due

date history from the legacy system, in
case if the dues are not cleared those can
be tracked in OFSLL.

Some other key account columns can be on-
boarded from legacy system to OFSLL.

OFSLL_PMG_RQT_803

Backdate a Payoff
Quote

OFSLL now has the ability to backdate a Payoff
Quote for the purpose of identifying the total
balance on an account as of a specific date which
is less than the current process date.

OFSLL_PMG_RQT 812

Payment Reversal
Enhancements

The following changes are introduced:

o A facility to show the system corrected
monetary transactions as INTERNAL’ and
actual user posted monetary transactions
with the corresponding user name on
Customer Service > Transaction History >
Transactions screen.

e Through web service system allows
reversing the posted payments, along with
payment transactions posted on the exact
same day for the exact same amount,
provided the ability to correct off one or
both payments using a field ‘Reference’.

OFSLL_PMG_RQT_819

Upgrade SET-
XPR/XPR2 Batch
Jobs to support
MDB

The existing batch Jobs - ‘SET-XPR/XPR2’ are
upgraded to support MDB flow for interfacing
between OFSLL and external interfaces (Dealer
Track and Route One). MDB interface helps to
avoid current database outbound calls and session
timeout.

ORACLE




Restful Web Services Framework Enhancements

2.1.1 Overview

OFSLL Restful Web Services framework is enhanced with the below changes. These
enhancements might need some impact analysis for customers migrating from lower version to
current version.

e Anew screen is introduced to record authorization responsibility for all the Restful Web
Services available in the system.

e All request XSD validation’s will be sent as Single error [previously validated one by one]

e XSD validations removed from Web Services response.

e All request elements have to be in the order specified [strict] in published XSD element
sequence.

e All responses from services are enhanced to send standardized HTTP response status
code to below

> 200 - Success

> 201 - Success

> 400 -> Validation Error

> 401 - Authentication Error

> 403 - Authorization Error

> 500 - Infrastructure Errors (Unable to access Database etc...)

e Standardized JSON request to include root element that will facilitate for a smooth
migration of existing XML request to JSON and vice-versa.

e UserCode input parameter is made as an optional from Web Services request.

e Deprecated the use of USE_CONTAINER_AUTH header. If UserCode parameter is sent
as part of request, OFSLL will consider this user else it will use authenticated user.

e Single Query Parameter Web Services are enhanced to support Path Parameter
instead.

e Standardized database customization fields

STR_ATTR XWS_ATT_STR TAB T,
NUM_ATTR XWS_ATT NUM_TAB T,
DATE_ATIR XWS_ATT DATE TAB T

e Standardize Response elements to Status and Status Details

<Result>
<status>123 </status>
<StatusDetails>»>123 </StatusDetalils>
</Result>

2.1.2 Description

e Web Service Authorization

> OFSLL Restful Web Services framework is enhanced to support responsibility-based
authorization for all Restful Web Services.

> A new screen is added in Setup = Access = Web service to add/remove
responsibility for individual Restful Web Services.

»  This will have an impact to existing customer as it is mandatory step to include
responsibility access for all Restful Web Services.
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> The logic of including/excluding responsibility access to a Restful Web Services

works similar to Setup = Access = Screen

e Input element order

> With new framework enhancements, all the request element order should be in-line

with XSD.

> Note: This enhancement will also have an impact to existing customer, as it is now
mandatory to keep the input request element sequence in sync with XSD. If failed a

XSD validation error will be triggered from OFSLL.

2.1.3 Screenshot

Setup > Access > Web service

Access x

Data  Screen  Reports | Comespondence  Transaction  Webservice

Security Super Group
View v Format~ [ Freeze
Super Group
COMMON
INTERFACES
ORIGINATION

Security Access Definition

Wrap

View + Format v  [f5 Freeze  Efi Detach Wrap

il @
Access Code
FLL.CALCULATORRESOURCE.POST.CALCULATOR.

Security User Access Details

&

Description
ACCESS TO CALCULATOR SERVICE

3 Cose

El view | < audit

A Edit || B view | < audit

v

System Defined  Enabled

Yes | No ¥

A Edit || B view | <« audit

View v Format+ [ Freeze f; Detach Wrap 50}
2.1.4 Seed Data
SNO | Table Key Data Type
1 FLS ACCESS E’L\IL.TSAIET.UAD.ACCESSWEBSERVICESCRE INSERT
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2.2 Restful Web Services Enhancements

2.2.1 Overview

Following Restful Web Services are developed and enhanced as part of this release.

e New

a. Origination:
i. Application Entry (GET/PUT)
ii. Application Status Change (PUT)
iii. Application Checklist (GET)
iv. Application ACH (GET/POST)
v. Application Comments (GET/POST)
vi. Application Document Upload/Download (GET/POST)
b. Customer Service and Collection:
i. Account Document Upload/Download (GET/POST)
ii. Account Comments (GET/POST)
c. Setup:
i. Product (GET)
ii. Asset (GET)
iii. Asset Sub Type (GET)
iv. Process Files Upload/Download (GET/POST)
d. Common:
i. Scheduler Force Resubmit (PUT)

e Enhancements

e. Setup
i. Lookups (GET): To support searching with lookup type and description
individually.
f.  Origination

i. Application Entry (POST): To support auto decisioning and capturing
SCRA applicant details

2.2.2 Qrigination
e ‘Application Entry’ Restful Web Service (GET/PUT/POST)

> Application Entry Web Service is developed to support create/update and fetch
application details from external interfaces.

>  Existing Application entry POST service is enhanced to accept SCRA applicant
details and enabled to support auto decisioning.

> New Application Entry PUT/GET services are introduced
- Put- to update the application
- Get- to fetch the application

> If the application completed decisioning and any application details updated, system
will mark current decision indicator from ‘Y’ to ‘N’. Similarly, if application completed
contracting, any update on application will update contract instrument to blank.

> Three customization fields are added for STRING, NUMBER and DATE.
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Seed Data

SNO | TABLE KEY DATA Type

FLL.APPLICATIONSEARCHRESOURCE.GET.GETAPPLI
1 FLS_ACCESS | CATIONSEARCH INSERT

FLL.APPLICATIONDETAILSRESOURCE.POST.APPLICA
2 FLS_ACCESS | TIONDETAILS INSERT

FLL.APPLICATIONUPDATERESOURCE.PUT.APPLICATI
3 FLS_ACCESS | ONUPDATE INSERT

e ‘Application Status Change’ Restful Web Service (PUT)

> Application Status Change Web Service is introduced to enable application status
change from external interfaces.

Seed Data

SNO | TABLE KEY DATA Type
FLL.CHANGEAPPLICATIONSTATUSRESOURCE.PUT.C

1 FLS_ACCESS | HANGEAPPLICATIONSTATUS INSERT

e ‘Application Checklist’ Restful Web Service (GET)

> Application Checklist Web Service is introduced to fetch checklist details loaded for
application. If no checklist available on that application, this service will load checklist
form setup based on origination stage code.

> Three customization fields are added for STRING, NUMBER and DATE.

Seed Data

SNO | TABLE KEY DATA Type
FLL.APPLICATIONCHECKLISTRESOURCE.GET.CHECK

1 FLS_ACCESS | LIST INSERT

e ‘Application ACH’ Restful Web Service (GET/POST)

> Application ACH Web Service is introduced to support create and fetch application
ach details from external interfaces.

— Post: Send Bank details/ACH to link to the Application.
— Get: Get Bank/ACH account details linked to application.
> Three customization fields are added for STRING, NUMBER and DATE.

Seed Data
SNO | TABLE KEY DATA Type
1 FLS_ACCESS | FLL.ACHRESOURCE.GET.FETCHACH INSERT
2 FLS_ACCESS | FLL.ACHRESOURCE.POST.CREATEACH INSERT

e ‘Application Comments’ Restful Web Service (GET/POST)
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> Application Comment Web Service is introduced to support create and fetch
application comments from external interfaces.

- Post: Send application comments from external systems.
- Get: Get comments from application
> Three customization fields are added for STRING, NUMBER and DATE.

Seed Data

SNO | TABLE KEY DATA Type
FLL.APPLICATIONCOMMENTRESOURCE.GET.GETCO

1 FLS ACCESS | MMENTS INSERT
FLL.APPLICATIONCOMMENTRESOURCE.POST.POSTC

2 FLS_ACCESS | OMMENTS INSERT

e ‘Application Document’ Restful Web Service (GET/POST)

> Application Document Web Service introduced to support create and fetch
application documents from external interfaces.

Seed Data

SNO | TABLE KEY DATA Type
FLL.APPLICATIONDOCUMENTSPROCESSINGRESOUR

1 FLS_ACCESS | CE.GET.DOWNLOADAPPLICATIONDOCUMENT INSERT
FLL.APPLICATIONDOCUMENTSPROCESSINGRESOUR

2 FLS_ACCESS | CE.GET.LISTAPPLICATIONDOCUMENTS INSERT
FLL.APPLICATIONDOCUMENTSPROCESSINGRESOUR

3 FLS_ACCESS | CE.POST.UPLOADAPPLICATIONDOCUMENT INSERT

2.2.3 Customer Service and Collections

e ‘Account Comments’ Restful Web Service (GET/POST)

> Account Comment Web Service is introduced to support create and fetch account
comments from external interfaces.

> Three customization fields are added for STRING, NUMBER and DATE.

Seed Data

SNO | TABLE KEY DATA Type
FLL.ACCOUNTCOMMENTRESOURCE.GET.GETCOMM

1 FLS_ACCESS | ENTS INSERT
FLL.ACCOUNTCOMMENTRESOURCE.POST.POSTCOM

2 FLS_ACCESS | MENTS INSERT

211 ORACLE



e ‘Account Document’ Restful Web Service (GET/POST)

> Account Document Web Service is introduced to support create and fetch account
documents from external interfaces.

Seed Data

SNO | TABLE KEY DATA Type
FLL.ACCOUNTDOCUMENTPROCESSINGRESOURCE.

1 FLS_ACCESS | GET.DOWNLOADACCOUNTDOCUMENT INSERT
FLL.ACCOUNTDOCUMENTPROCESSINGRESOURCE.

2 FLS ACCESS | GET.LISTACCOUNTDOCUMENTS INSERT
FLL.ACCOUNTDOCUMENTPROCESSINGRESOURCE.

3 FLS_ACCESS | POST.UPLOADACCOUNTDOCUMENT INSERT

2.2.4 Customer Service

e ‘Product’ Restful Web Service (GET)
> Product Web Service is introduced to fetch product details from external interfaces.

Seed Data
SN
@] TABLE KEY DATA Type

FLS_ACCES | FLL.PRODUCTSASSETSRESOURCE.GET.GETPRODUC
1 S TS INSERT

e ‘Asset’ Restful Web Service (GET)
> Asset Web Service is introduced to fetch Asset Type details from setup.

Seed Data
SN
O TABLE KEY DATA Type

FLS_ACCES | FLL.PRODUCTSASSETSRESOURCE.GET.GETASSETT
1 S YPES INSERT

o ‘Asset Sub Type’ Restful Web Service (GET)
> Asset Sub Type Web Service is introduced to fetch Asset Sub Type details from

setup.
Seed Data
SN
(@] TABLE KEY DATA Type
FLS ACCE FLL.PRODUCTSASSETSRESOURCE.GET.GETASSETSU
1 SS BTYPES INSERT
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e ‘Process Files Upload/Download’ Restful Web Service (GET/POST)

> Process Files Web Service is introduced to support create and fetch incoming and
outgoing processed files from external interfaces.

Seed Data
SN
(0] TABLE KEY DATA Type
FLS_ACCE
1 SS FLL.INCOMINGFILERESOURCE.POST.INCOMINGFILE INSERT

FLS_ACCE | FLL.OUTGOINGFILELISTRESOURCE.GET.GETOUTGOIN
2 SS GFILELIST INSERT

FLS_ACCE | FLL.OUTGOINGFILERESOURCE.GET.GETOUTGOINGFIL
3 SS E INSERT

e ‘Scheduler Force Resubmit’ Restful Web Service (PUT)

> Process Files Web Service is introduced to support create and fetch incoming and
outgoing processed files from external interfaces.

Seed Data
SNO | TABLE KEY DATA Type
1 FLS_ACCESS | FLL.SCHEDULERRESOURCE.PUT.FORCERESUBMIT INSERT

Note: Refer to the following link for more details on web services -
http://docs.oracle.com/cd/E89525 01/webservice.htm

213 ORACLE


http://docs.oracle.com/cd/E89525_01/webservice.htm

2.3

Scheduler Force Resubmit

2.3.1 Overview

OFSLL is enhanced to force resubmit batch job set with status ‘READY’ or ‘COMPLETED’

2.3.2 Description

e A new button “Force Re-submit Job Set” is enhanced to resubmit batch job sets with
status ‘READY’, ‘COMPLETED’ or ‘FAILED'.

e If a useris given access to “Force Re-submit Job Set” and “Re-submit Job Set” only
“Force Re-submit Job Set” is displayed.

e Note: Earlier limitation of resubmitting only “Failed” jobs are removed.

2.3.3 Screenshot

Dashboard > System Monitor > Batch Jobs

System Monitor x

Batch Jobs ~ Jobs  Semvices

Batch Job Sets

Database Server Log Files

Parked Transactions | Users

View » Format + @ Freeze o Detach Wrap @[ Force Re-submit Job Set
¢ & B
Set Code Job Set Description  Status Frequency Frequency Value  Start Time Enabled Critical Last Run Dt Next Run Dt Pa
SET-AAL ACCOUNT CREATI... READY DAILY DAILY 10:00 AM Y N 09/21/2017 09/22/2017 10:00... RC
SET-ACR ACCRUALS AND D... READY DAILY DAILY 22:30 PM N Y 08/07/2003 08/08/2003 10:30... SE *
3
2.3.4 Seed Data
SNO | Table Key Data Type
FLS_ACCES | FLL.CMN.UUT.BATCHJOBSET.RESUBMITFORCEJOBSET.BUTT
1 - INSERT
S ON
2-14
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2.4 Account Acceleration

2.4.1 Overview

Account Acceleration is a provision that allows a lender to insist a borrower to repay all or a part of
an outstanding loan prior to the scheduled maturity date, when the borrower is identified to be
fraudulent. An acceleration clause outlines the probable reason(s) for the lender to accelerate a
loan account and demand loan repayment.

The chapter contains the following sections:

e Posting Account Acceleration
e Reversing Account Acceleration

Example to illustrate:

e Account Acceleration and Reversal with ‘Principle First’ adjustment
e Account Acceleration and Reversal with ‘Interest First’ adjustment

2.4.2 Posting Account Acceleration

Account Acceleration transaction can be posted on the identified account from the Customer
Service > Maintenance screen. For detailed information on posting this transaction, refer to
Appendix: Transaction Parameters > Monetary Transactions > Account Acceleration section.

Pre-defined validations for account acceleration

While posting the account acceleration transaction, system validates the account status with the
following pre-defined validations before proceeding with the transaction:

Account Status / Validations Validations Comments
Transaction Description before posting after posting
transaction transaction

EXTENSION No Should not
repost after
reversal

EXTENSION OVERRIDE No Should not
repost after
reversal

INDEX / MARGIN RATE No Should not
CHANGE repost after
reversal

CHANGE TERM No Should not
repost after
reversal

CHANGE BALLOON No Should not
repost after
reversal
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Account Status / Validations Validations Comments
Transaction Description before posting after posting
transaction transaction
CHANGE PAYMENT No Should not
AMOUNT repost after
reversal
DELAY FEE No Should not
repost after
reversal
CHANGE PROFIT RATE No Should not
repost after
reversal
RESCHEDULE PAYMENT No Should not
repost after
reversal
RESCHEDULE RATE No Should not
repost after
reversal
RESCHEDULE PRE-COM- No Should not
PUTE LOAN TO INTER- EST repost after
BEARING LOAN reversal

Errors during account acceleration

Account acceleration supported for accounts with 'ACTIVE' status. In case account acceleration
transaction is posted on accounts with any other status or if there are any other pre-existing

conditions posted on the account, system does not allow to post the transaction and displays an
error. The table below lists the type of errors displayed and reason for the same.

‘Account Acceleration allowed only
for Active accounts’

The status of the account is other than 'ACTIVE'.

‘Account Acceleration already
posted on account’

There is already an account acceleration trans-
action posted on account.

‘Account Acceleration is not
allowed on Non Performing
Account.’

There is already a 'Non-Accrual' condition posted
on account (i.e., Non Performing Indicator = Y).

‘Account Acceleration not allowed
as Stop Accrual is active on
account’

There is already a 'Stop Accrual' condition posted
on account.

Balance Adjustment Method
applicable for Pre-Compute
account.

The ‘Balance Adjustment’ method is selected for
non-pre compute account since its applicable only
for pre-compute accounts.
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Account changes after posting account acceleration

On successfully posting the account acceleration transaction, following are the account level
changes:

e The acceleration effective date will be the new maturity date of the account since the
original maturity date of the account is moved to either the current date or a back date.

e On an accelerated account, the periodic billing, normal interest accrual and late fee
assessment is discontinued as per the standard functionality since maturity date is
reached.

e From the acceleration effective date, post maturity interest accrual with corresponding
post maturity interest rate is calculated and added to the total account dues as per normal
processing when a monetary transaction is posted. (Post maturity rate is applied after
corresponding batch run)

e For a back dated account acceleration, all the system posted transactions on the account
(like billing, interest, and late fees) between acceleration date (i.e. back date) and current
system date is reversed, re-calculated and re-posted based on new maturity date.
(Acceleration date).

> Also the interest already accrued on the account based on the normal interest rate is
reversed from acceleration date (i.e. back date) up to current system date and is re-
calculated with post maturity interest rate and re-posted for the same period (after
post maturity interest rate batch run).

e Foran accelerated account the following account attributes are displayed in the ‘Result'
section:

» Total Accelerated Payment Due Amount
» Acceleration Effective Date

> New Maturity Date

> Post Maturity Interest Rate

Transaction posting for account acceleration

Depending up on the type of loan account (i.e. pre-compute and non-pre-compute), the account
acceleration transaction is internally categorized and processed either in single stage or two stages.

e For ‘Non Pre-Compute’ accounts the transaction is posted directly.

e For‘Pre-Compute’ accounts, the account is first converted from pre-compute to interest
bearing account by internally posting the monetary transaction ‘RESCHEDULE_PC2SI’
(RESCHEDULE PRE-COMPUTE LOAN TO SIMPLE INTEREST LOAN) based on the
following parameter values:

» Transaction Date: Specified acceleration date

> Reschedule payment start date: Next payment date as per the existing due date
history.

> Amount: Outstanding balance under ADVANCE/PRINCIPAL balance component.
> Rate: Existing normal interest rate of the account.

» Term: Calculated for the remaining term (i.e. cycles not yet billed). Term is not
relevant for account acceleration since maturity date is moved to transaction date.

> Rebate on finance and insurance charges is processed as per the normal PC2SI
transaction.

Refer to examples included in below section for details on how account acceleration is posted with
‘Principle First’ adjustment and ‘Interest First’ adjustment.
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To post an account acceleration transaction

Transaction Parameters | Description

ACCOUNT TXN DATE | Select the date from which the acceleration is
ACCELERATIO effective on the account. The same can either be the
N current date or a back date (up to ‘contract date' or

‘account back date ‘whichever is higher) but not a
future date.

The selected date will be the acceleration start date
and the new maturity date of the account.

In case of pre-compute loan accounts, the same date
is used for the following actions:

- As the effective date for PC (pre-compute) to S
(simple interest) conversion.

- As the date for calculating the account finance
charge rebate.

PC2slI For 'Pre-Compute' accounts, select one of the
BALANCE following parameter from the drop-down list. The
ADJUSTME | values in this list are populated based on the lookup
NT code ‘PC2SI_BAL_METHOD_CD (PC2SI BALANCE
METHOD ADJUSTMENT METHOD CODESY

- PRINCIPA L FIRST
- INTEREST FIRST

For details on how the PC to Sl conversion
calculation is done based on above selection, refer to
Appendix - Account Acceleration chapter.

For ‘Non-Pre-Compute' accounts, select the
parameter value as ‘Undefined’. Else, system
displays an error on selecting any other value as
‘Balance Adjustment Method mandatory for Pre-
Compute a/c'.

2.4.3 Reversing Account Acceleration

Reversal of an account acceleration can be done to reinstate the account to its previous status.
During reversal of an account acceleration, following changes are performed on the account:

e All the related transactions posted by account acceleration transaction are reversed. For
example, ‘RESCHEDULE_PC2SI’ is reversed in case of pre-compute accounts.

2.4.4 Account Acceleration and Reversal with ‘Principle First’ adjustment

Consider a loan account with following details:

e Contract Date = 01. Jan 2017
e Contract Maturity Date = 31.Dec 2017
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Rate = 4.99%
Term = 12 Months

Balances before 'Account Acceleration' for a 'Pre-Compute’ loan.

Posted Paid Waived |Adjusted Balance

ADV/INT 12300 11900
(Pre-compute) (12000 + 300)

Acceleration Transaction (PC 2 SI)

Txn Date = 16.Aug. 2017
Reschedule St Dt = 01.Sep. 2017
Amount = 11900

Rate = 4.99

Term=1

Principal Adjustment - Minus Transaction

With Interest Estimated Amount = 300

Interest Adjustment - Plus Transaction

Estimated Interest - Rebate = 300-90 = 210

On posting of 'Acceleration Txn' following transactions would be posted on account automatically:

Txn 1 - PC 2SI (with about values) =0

Txn 2 - Interest Rebate = 90$(Assumed number) - Pass 11900 for rebate calculation
Txn 3 - New Principal Adjustment Txn = Outstanding Principal = 11900

Txn 4 - Post 'Principal Adjustment minus = 300

Txn 5 - Post 'Interest Adjustment Plus = 210

Balances after posting 'Acceleration’ transaction.

Posted |Paid Waived |Adjusted Balance

ADV 11900 0 0 Principle 11600
adjustment minus
=300

ADV/ INT 12300 490 0 0 0

(Pre-compute) (400 + 90)

INT 0 0 0 Interest adjustment 210
plus = 210

Since payment is received after acceleration (i.e. same day), there is no additional interest
accrual).
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In case payment is received of $350 subsequently on account acceleration, (Interest adjustment

2.4.5

spread).
Posted |Paid Waived |Adjusted Balance
ADV 11900 140 0 -300 11460
ADV/ INT (Pre- [12300 490 0 0 0
compute) (400 + 90)
INT 0 210 0 210 0
Reversal of Account Acceleration after above Payment posting
Transactions reversed / posted on account
e Reverse Txn 6 - Payment of $350
e Reverse Txn 5 - Interest Adjustment Plus = 210
e Reverse Txn 4 - Principal Adjustment minus = 300
e Reverse Txn 3 - New Principal Adjustment Txn
e Reverse Txn 2- Interest Rebate
e Reverse Txn 1- PC 2 SI
e Re-post- Txn 6 - Payment
Balances after reversal
Posted [Paid Waived |Adjusted Balance
ADV/INT 12300 750 0 0 11550
(Pre-compute) (400 + 350)

Account Acceleration and Reversal with ‘Interest First’ adjustment

Consider a loan account with following details:
e Contract Date = 01. Jan 2017
e Contract Maturity Date = 31.Dec 2017
e Rate =4.99%

e Term =12 Months

Balances before 'Account Acceleration' for a 'Pre-Compute’ loan.

Posted

Paid

Waived

Adjusted

Balance

ADV/INT

(Pre-compute)

12300

(12000 + 300)

500

0

0

11800

Acceleration Transaction (PC 2 SI)
e Txn Date = 16.Aug. 2017

e Reschedule St Dt = 01.Sep. 2017
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Amount = 11800
Rate = 4.99
Term=1

Principal Adjustment - Minus Transaction

If 'Paid Principal Balance' > Estimated Interest -Rebate
Pass 'rebate’' amount

Else

Post transaction with ‘Estimated Interest’ Amount

Interest Adjustment - Plus Transaction

If Paid principal > Interest Estimated - Rebate

Pass 0

Else

Estimated Interest - Rebate - Posted = 300 -100 -100 = 100

On posting of 'Acceleration Transaction’, following transactions would be posted on account
automatically:

Txn 1 - PC 2SI (with about values) = 0

Txn 2 - Interest Rebate = $100 (Assumed number) - Pass 11800 for rebate calculation
Txn 3 - New Principal Adjustment Txn = Outstanding Principal = 11800

Txn 4 - Post 'Principal Adjustment minus = 100

Txn 5 - Post 'Interest Adjustment Plus = 100

Balances after posting ‘Acceleration’ transaction

Posted |Paid \Waived Adjusted Balance
ADV 11800 0 Principal 11700
Adjustment Minus
=100
INT 0 0 Interest 0
Adjustment Plus =
0
ADV/ INT (Pre- (12300 500+Rebate  |12300 - 0 0
compute) Amount (100) |(500+100)

Since payment is received after acceleration (i.e. same day), there is no additional interest
accrual).

In case payment is received of $350 subsequently on account acceleration (Principal adjustment

spread)

Posted |Paid Waived Adjusted Balance

ADV

11800 350 0 -100 11350
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ADV/ INT (Pre- [12300 500+Rebate {12300 - 0 0
compute) Amount (100) ((500+100)
INT 0 0 0 0 0

Reversal of Account Acceleration after above Payment posting

Transactions to be reversed/ posted on account

e Reverse Txn 6 - Payment Txn

e Reverse Txn 5 - Interest Adjustment Plus = 100

e Reverse Txn 4 - Principal Adjustment minus = 100
e Reverse Txn 3 - New Principal Adjustment Txn

e Reverse Txn 2 - Interest Rebate

e Reverse Txn 1 - PC 2SI (with about values) = 0

e Re-post- Txn 6 - Payment

Balances after reversal

Posted |Paid \Waived Adjusted Balance
ADV/ INT 12300 850 0 0 11450
(Pre-compute) (500 + 350)
2.4.6 Seed Data
SNO | TABLE KEY DATA Type
SYS|SYS|SYS|TXN|001994|ACCOUNTACCELERAT
1 TRANSLATION_DATA IONALLOWEDONLYFORACTIVEACCOUNTS.|SYS| | INSERT
MSG-SM
SYS|SYS|SYS|TXN|001995|ACCOUNTACCELERAT
2 TRANSLATION_DATA IONALREADYPOSTEDONACCOUNT.|SYS|MSG- INSERT
SM

SYS|SYS|SYS|TXN|001996|]ACCOUNTACCELERAT
3 TRANSLATION_DATA IONISNOTALLOWEDONNONPERFORMINGACCO | INSERT
UNT.|SYS|MSG-SM

SYS|SYS|SYS|TXN|001997|JACCOUNTACCELERAT
4 TRANSLATION_DATA IONNOTALLOWEDASSTOPACCRUALISACTIVEON | INSERT
ACCOUNT.|SYS|MSG-SM

SYS|SYS|SYS|TXN|002001|BALANCEADJUSTMEN
5 TRANSLATION_DATA TMETHODMANDATORYFORPRE- INSERT
COMPUTEACCOUNT.|SYS|MSG-SM

2-22 ORACLE



SNO | TABLE KEY DATA Type
SYS|SYS|SYS|TXN|002002|BALANCEADJUSTMEN
6 TRANSLATION_DATA TMETHODAPPLICABLEFORPRE- INSERT
COMPUTEACCOUNT.|SYS|MSG-SM
SYS|SYS|SYS|UCS|002010]COMMUNICATIONMO
7 TRANSLATION_DATA DEALREADYEXISTSFORTHISRELATIONSHIPTYP | INSERT
E|SYS|MSG-SE
8 LOOKUPS ACC_CONDITION_CDJACC_ACL INSERT
9 LOOKUPS PC2SI_BAL_METHOD_CD|PF INSERT
10 | LOOKUPS PC2SI_BAL_METHOD_CD|IF INSERT
11 | LOOKUPS TXN_GROUP_CDJACL INSERT
12 | TXN_CODE_PARAMETERS | ACCOUNT_ACCELERATION|TXN_DT INSERT
13 ACCOUNT_ACCELERATION[TXN_PC2SI_BAL ME | |\ ccnt
TXN_CODE_PARAMETERS | THOD_CD
14 | TXN_CODE_PRODUCTS ACCOUNT_ACCELERATIONJALL|LN|CE INSERT
15 | TXN_CODE_PRODUCTS ACCOUNT_ACCELERATION_REV|ALL|LN|CE INSERT
16 | TXN_CODES ACCOUNT_ACCELERATION INSERT
17 | TXN_CODES ACCOUNT_ACCELERATION_REV INSERT
18 | LOOKUP_TYPES PC2S|_BAL_METHOD_CD INSERT
19 | ACCESS_GRID_FUNCTIONS | EXTENSIONJACC_CONDITION_CDJACC_ACL INSERT
20 EXTENSION_OVERRIDEJACC_CONDITION_CDJA | |\ cEnT
ACCESS_GRID_FUNCTIONS | CC_ACL
21 | ACCESS_GRID_FUNCTIONS [ ACCRUAL_STOPJACC_CONDITION_CDJACC_ACL | INSERT
22 | ACCESS_GRID_FUNCTIONS | CHANGE_TERM|ACC_CONDITION_CD|ACC_ACL | INSERT
03 CHANGE_BALLOONJACC_CONDITION_CD|ACC_ | \\ceRT
ACCESS_GRID_FUNCTIONS | ACL
” RESCHEDULE_INDEXJACC_CONDITION_CDIACC | \\cEnT
ACCESS_GRID_FUNCTIONS | ACL
- CHANGE_PMT_AMT|ACC_CONDITION_CDIACC_ | \\ceRrT
ACCESS_GRID_FUNCTIONS | ACL
26 | ACCESS_GRID_FUNCTIONS | FDLY|ACC_CONDITION_CD|ACC_ACL INSERT
2-23

ORACLE



SNO | TABLE KEY DATA Type
. CHANGE_PROFIT_RATE|ACC_CONDITION_CDIA | \\cror
ACCESS_GRID_FUNCTIONS | CC_ACL
08 RESCHEDULE_PAYMENT|ACC_CONDITION_CD| | \\cror
ACCESS_GRID_FUNCTIONS | ACC_ACL
09 RESCHEDULE_RATE|ACC_CONDITION_CDIACC_ | \\sERT
ACCESS_GRID_FUNCTIONS | ACL
30 RESCHEDULE_PC2SIACC_CONDITION_CDIACC | \\cERT
ACCESS_GRID_FUNCTIONS | ACL
31 | FLEX_TABLE_ATTRIBUTES [INP_BMP_TXN|TXN_PC2S|_BAL_METHOD_CD INSERT
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2.5 Remarketing

2.5.1 Overview

Remarketing in auto financing space refers to resale of customer asset(s) through auctioning. To
recover bad debt, Auto-Lending institutions integrate with external auctioning service providers to
manage vehicle remarketing portfolios of repossessed customer asset(s).

OFSLL provides a generic interface to support remarketing with middle layer integration between
Auto Lending institutions and auctioning service providers. Starting from initiating a remarketing
request till invoice validation, processing, status updates, and refunds tracking, all
correspondence with the third party auctioning systems are handled within OFSLL.

Following are the stages of collateral remarketing:
> Define Vendor Assignment Criteria
> Vendor Assignment Allocation
e Remarketing Request
> Interfacing Remarketing Details with Third Party Auctioning System
e Invoicing
> Post Transaction
» Business Rules for Invoice Validation

Pre-requisites

Following are the pre-requisites while working with Collateral Remarketing.

e A Lookup code GAI (GENERIC AUCTION INTERFACE) has to be available under
VENDOR ASSIGNMENT CHANNEL CODES (VENDOR_ASG_CHANNEL_CD) in Setup
> Administration > System > Lookups to identify all the channels used for third party
auctioning system.

e A Lookup code REM (RE SALE) has to be available under VENDOR ASSIGNMENT
TYPE CODES (VENDOR_ASG_TYPE_CD) in Setup > Administration > System >
Lookups.

e The current and next status are to be defined in the cycle setup definition
(COL_REMA DISP_STATUS) in Setup > Administration > System > Collection cycles
screen.

Navigation

The link to access remarketing screen is available under Collection module in the LHS menu.
Click Collections > Remarketing. The page by default opens with Customer Service > ‘Search’
tab. Search for the required account which is already repossessed using the search options. For

more information on using Search, refer to ‘Searching for an Account and Customer’ section.

On loading the account you want to work with, navigate to Customer Service > Repo/Foreclosure
> Remarketing tab.
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2.5.2 Assignment Allocation

The first step in collateral remarketing is to define a Vendor assignment criteria and add vendors
to the defined criteria using the Assignment Allocation screen. This section consists of the

following:

e Define Vendor Assignment Criteria

e Vendor Assignment Allocation

2.5.2.1 Define Vendor Assignment Criteria
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A criteria here refers to the combination of options selected in ‘Vendor Assignment Criteria’
section. Based on the criteria, system can filter and displays only those available vendors who
provide remarketing service in that territory.

The below examples illustrate the vendor selection process in remarketing screen.

Example 1:
Channel | Work Reposs Sort Vendor
Vendor Sub Order Country | ession Order Selection for
Code Type State Remarketing
Vendor A | GAI RE SALE | USA Florida 0 Default selected
Vendor B | GAI RE SALE | USA Florida 1 Listed
Vendor C | GAI RE SALE | USA Florida 2 Listed
Example 2
Channel | Work Reposs Sort Vendor
Vendor Sub Order Country | ession Order Selection for
Code Type State Remarketing
Vendor A | GAI RE SALE | USA Florida 0 No Vendor is
selected by
default, but
Vendor B | GAI RE SALE | USA Florida 0 listed as per
‘Vendor creation
sequence id' for
Vendor C | GAI RE SALE | USA Florida 0 selection.

ORACLE



From the LHS menu, navigate to Collections > Vendors > Work Order > Assignment Allocation
screen. Click ‘Add’ in the Vendor Assignment Criteria section and specify the required field
details.

The ‘Vendor Assignment Criteria’ section by default consists of Channel, Work Order Type,
Company and Branch fields for selection. For defining Remarketing criteria, select the Channel
which has sub code as ‘GAI’ and Work Order Type as ‘RE SALE’.

On selection, two additional fields - ‘Repo Storage Country’ and ‘Repo Storage State’ are enabled
for selection. Details in these two fields indicates the current location of the repossessed asset.
This facilitates to identify vendor based on repossession (storage) - State and Country while
creating remarketing request.

For more information on field selection, refer to ‘Vendor Assignment Criteria’ section in Vendors
chapter.

2.5.2.2Vendor Assignment Allocation

In the Vendor Assignment Allocation section, you can add vendors to the defined Vendor
Assignment Criteria. Unlike other vendor assignment criteria, on selecting a remarketing criteria,
an ‘Add’ button is enabled in ‘Vendor Assignment Allocation’ header allowing you to add
Vendor(s) and define the Sort order.

Note

For remarketing criteria (Channel sub code= ‘GAI’) system does not auto-populate the
vendor list with Assigned Cases and % Allocation. Also the option to define the weightage
for each vendor is disabled.

The Vendor drop-down list is populated based on the selected Channel, Work Order Type,
Company, and Branch. For every Vendor Assignment Criteria you can add a Vendor(s) and
define the sort order irrespective of Repossession State and Country.

2.5.3 Remarketing Request

Through the remarketing screen, you can trigger remarketing request and auto generate re-sale
work orders. A collateral remarketing request is an instruction to the vendor of third party
auctioning system to pick-up the repossessed asset from the storage location and proceed with
auction.

In an integrated environment, a remarketing request to third party auctioning system is always
triggered though a Work Order and contains the following details:

e Collateral details where you want to remarket the asset.
e Vendor who needs to be allocated for servicing the request.

To proceed with creating remarketing request, navigate to Customer Service > Repo/Foreclosure
> Remarketing tab and click ‘Add’.

To record a remarketing request, populate the following details:
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Field: Do this:

Current This check box is auto-selected and indicates if this is the current
enabled collateral remarketing record in the account.

Though OFSLL support multiple auctions of single collateral, only
one of them is enabled with current indicator for each collateral in
an account. If a second record is added for same collateral,
previous record is marked as 'N' automatically indicating that there
can only be one Current record at any given instance.

However, system does not allow to add remarketing record if the
Collateral status is SOLD.

Remarketing # Indicates OFSLL auto generated reference number for remarketing
record.

External Ref # Indicates remarketing external reference number generated in
third-party auction interface.

Dt Current date selected as Remarketing creation date.

Status Indicates the current status of remarketing request which is NEW
by default. The status is based on cycle setup defined in
Remarketing Collection Cycle. For details on all the available
status, refer to ‘Remarketing Status List’ section.

Status Dt Indicates the date when the status was last updated.

Priority Select the Priority of remarketing request from the drop-down list.
The available options are NORMAL (default), HIGH, and LOWER.

Last Updated Indicates the date when any of the remarketing attributes were last
Dt updated.
Comment Enter additional information, if any.

Note that during status changes (either done manually or auto),
system auto updates a comment with old status in Status History
tab. In case a comment is updated manually without any status
changes, the same is not updated into Status History.

Collateral Details: Details of this section are auto updated from repossession tab.
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Field:

Do this:

Asset Desc

Select the repossessed asset from the drop-down list.

Identification #

Indicates the collateral identification number.

Year Indicates the year when the collateral was manufactured.
Make Indicates the manufacturing company of the collateral.
Model Indicates the collateral model.

Storage Location:

Location where the repossessed asset is currently available.

Address Storage location address.

Country Storage location Country.

Zip Storage location zip code.

State Storage location State.

Name Contact person name at storage location.

Phone Contact person contact number at storage location.
Fax # Contact person fax number at storage location.

Work Order: Details of the work order for remarketing request.

Workorder #

Indicates the work order number which is auto generated by the
system. On successful work order creation, the same is enabled
with a link and clicking on the same opens Vendors > Work Orders

tab with details.
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Field: Do this:

Channel Select the remarketing channel from the drop-down list. This list

consists of only those vendor channels with sub code ‘GAI'.

Workorder Indicates the work order type as RE SALE.
Type
Vendor Select the vendor who should serve the remarketing request from

the drop-down list. The list is populated based on storage location
of the repossessed asset and vendors who provide auction service
in that territory. System auto generates the list based on the
defined Vendor Assignment Criteria.

Work Order Indicates the current status of work order and by default is OPEN
Status for new remarketing request.

On updating all the required parameters, click ‘Save and Stay’ or any of the Basic Actions
mentioned in Navigation chapter.

On successful update, a Work Order with the specified details is created. The same can be
viewed by clicking on the Workorder#.

The Work Order screen allows you to change the selected Vendor, select ‘Override Reason’ (if
any) and also select the ‘Collector’. For more information on updating Work Order details, refer to
Vendors > Work Orders section.

The Remarketing screen consists of the following sub tabs:

Remarketing Proceed Details
Status History sub tab
Tracking Attributes sub tab
Expenses sub tab

Refunds sub tab

2.5.3.1 Interfacing Remarketing Details with Third Party Auctioning System

The following types are interfaces are supported between OFSLL and third party auctioning
system:

JMS notification
Web services

2.5.3.2 JMS Notification
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On every manual status change in collateral remarketing, a JMS (Java Message Service)
notification is sent to third party auctioning system to act upon the notification.
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For example, after the remarketing request is created with work order details, the same is to be
registered in third party auctioning system for further action. A JMS notification is sent with status
as ‘NEW’ and subsequently when the status of Remarketing request is changed to ‘SEND TO
AUCTION’, another notification is sent with this status.

However, it is up to the discretion of third party auctioning system to accept/reject and
acknowledge the notifications. When accepted, an auction is created in third party auctioning
system and a reference number for the same is shared as acknowledgement. This is then
appended to the remarketing request as External Ref # and status is updated as ‘AUCTION
ACCEPTED'. The external reference number can be used for further interactions.

When there are subsequent changes to the existing remarketing request in OFSLL, the same is
updated in Remarketing/ Work Orders screen and status of remarketing request is changed to
‘UPDATE TO AUCTION’. Another JMS noatification is triggered for updating the details in third
party auctioning system and response as either UPDATE ACCEPTED / REJECTED are tracked
back into the system.

Similarly, if there are any changes to auction in third party auctioning system, the details are
updated in OFSLL and the status of the remarketing is updated to “RECEIVED UPDATE'’.

For details on all the available status, refer to ‘Remarketing Status List’ section.
A sample instance of JIMS natification is indicated below:

2.5.3.3 Web Service Request / Response

To support collateral remarketing, the following web services are hosted by OFSLL to interface
with third party auctioning system:

e Get Remarketing - to receive latest remarketing details from OFSLL.

e Put Remarketing - to update remarketing request details from third party auctioning
system into OFSLL.

e Get Invoice - to receive invoice details from OFSLL to third party auctioning system.
e Post Invoice - to create invoice details in OFSLL Vendors > Invoice screen.

For details about each web services with sample request and response files, refer to ‘Collection
web services’ document in OTN library. (http://docs.oracle.com/cd/E82458 01/webservice.htm).

2.5.3.4 Remarketing Status List

Following are the status available for collateral remarketing. Based on each status, there can be
interaction between OFSLL and third party auctioning system. Ensure that the ‘Current’ and ‘Next
status are defined in cycle setup definition (COL_REMA_DISP_STATUS) in Setup > Collection
Cycles screen.

Note that the status indicated as (manual) in the below table are to be updated manually in
OFSLL Remarketing screen.

Status Description

NEW (Manual) New remarketing request created in OFSLL.

2-31 ORACLE



2-32

Status

Description

SEND TO AUCTION (Manual)

Remarketing request sent from OFSLL to third
party auctioning system.

AUCTION ACCEPTED

Response from third party auctioning system
indicating that the remarketing request is accepted.

AUCTION REJECTED

Response from third party auctioning system
indicating that the remarketing request is rejected.

UPDATE TO AUCTION (Manual)

Changes to remarketing request sent from OFSLL
to update in third party auctioning system.

UPDATE ACCEPTED

Response from third party auctioning system
indicating that the changes to remarketing request
are accepted.

UPDATE REJECTED

Response from third party auctioning system
indicating that the changes to remarketing request
are rejected.

RECEIVED UPDATE

Response from third party auctioning system on
updates to the remarketing request.

HOLD (Manual)

Hold remarketing request sent from OFSLL to third
party auctioning system (Ex: payment/updates from
customer).

HOLD ACCEPTED

Response from third party auctioning system
indicating that Hold remarketing request is
accepted.

HOLD REJECTED

Response from third party auctioning system
indicating that Hold remarketing request is rejected.

VOID (Manual)

Void (decline) remarketing request sent from
OFSLL to third party auctioning system.

VOID ACCEPTED

Response from third party auctioning system
indicating that Void remarketing request is
accepted.

VOID REJECTED

Response from third party auctioning system
indicating that Void remarketing request is rejected.

REDEEM (Manual)

Redeem (pull back) remarketing request sent from
OFSLL to third party auctioning system.

REDEEM ACCEPTED

Response from third party auctioning system
indicating that Redeem remarketing request is
accepted.
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Status Description

REDEEM REJECTED Response from third party auctioning system
indicating that Redeem remarketing request is
rejected.

INVOICING Implicit status updated in OFSLL on receiving
Invoice from third party auctioning system.

INVOICE REJECTED Implicit status updated in OFSLL if the Invoice
received from third party auctioning system is
rejected.

COMPLETED Implicit status updated in OFSLL to indicate as
remarketing complete.

2.5.3.5 Remarketing Proceed Details

Subsequent updates of collateral auctioning are tracked and updated in the Remarketing Proceed
Details section against the remarketing request. This tab gives insight on individual collateral re-
sale proceeds that are provided by the third party auctioning system and the total percentage of
debt recovered for each asset re-sale.

Following are the Remarketing Proceed Details updated:

Remarketing Proceed Details

Sales Indicates the Gross Sales Amount.

Expense Indicates the total expense incurred in sales.

Refunds Indicates the Refunds arising post the sales.

Net Proceeds Indicates the Gross Sale Amount (Total Expense + Total Refunds).

Balance Indicates the Payoff Quote of Account when payment is posted.

Net Gain/Loss Indicates the profit or loss of sales (Net Proceeds - Balance).

Recovery % Indicates the total recovery percentage which is calculated as
((Net Proceeds - Balance) / Balance)x100
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2.5.3.6 Status History sub tab

The Status History sub tab records all the status updates (both manual and auto) of a particular
remarketing request. This tab consists of the following details:

Field: View:

Status Previous status before the current update.

User User who updated the status.

Start Dt Status change start date.

End Dt Status change end date.

Comments Comments recorded in remarketing comments field.

2.5.3.7 Tracking Attributes sub tab

Tracking attributes allows you track and update the details of each integration element between
OFSLL and third party auctioning system, and notify the same with status change in the
remarketing request along with a comment.

In the Tracking Attributes sub tab, you can load all the available tracking attributes and define the
parameter value for various parameters listed.

1. Click ‘Load Tracking’ button and select the required parameter from the list.

2. Click ‘Edit’ and update the required details.

2.5.3.8 Expenses sub tab

The Expenses sub tab records all the expenses received as part of Invoice. This tab consists of
the following details:

Field: View:

Expense-Type Work Order service name.

Currency Expense currency.

Amt Payment amount charged by vendor.
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2.5.3.9 Refunds sub tab

When customer has opted for an extended warranty or have insured the collateral and the same
has been re-sold within the warranty period, then there is a refund to be paid to the customer.
However, note that only the details of the refund are recorded in the system and the process of
refunds settlement to customer account and accounting are to be handled manually.

In the Refunds sub tab, click ‘Add’ and update the following details:

Field: Do this:

Refund Select the type of refund from the drop-down list.

Currency Select the refund currency from the drop-down list.

Refund Amt Specify the refund amount to be paid to customer.

Manual Checked by default indicating that all refunds are settled manually.

Save the refund details clicking ‘Save and Stay’ or any of the Basic Actions mentioned in
Navigation chapter.

2.5.4 Invoicing

When a repossessed asset is sold by the third party auctioning system, an invoice is created in
OFSLL (through POST INVOICE web service) with the total value of sale and the additional cost
incurred. For more information, refer Web Service Request / Response section.

Unlike other invoices where one invoice is generated for each asset, those received for Channel
sub code ‘GAI’ will have details of multiple assets sold in any given auction. Hence the invoice
would be on per-auction basis with details of all the vehicles auctioned.

The invoice received in OFSLL will have the following two components:

e Incoming payment (Proceed) - An amount generated for resale of the asset to be added
into the system.

e Vendor Fees (Invoice Details) - Cost that the vendor has charged for the service such as
service fee, vehicle repair and so on.

To view the invoice information, navigate to Collections > Vendors > Invoices tab.
On selecting an invoice received from channel sub code ‘GAl’, the invoice screen will have a
rearrangement of following sub tabs:

e Details sub tab

e Proceeds sub tab

e Tracking Attributes sub tab
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Before posting the invoice details, system auto validates the invoice information against specific
pre-defined Business Rules. For more information on the Business Rules, refer to ‘Business
Rules for Invoice Validation’ section.

It is mandatory for every invoice to satisfy all the pre-defined business rules. Else, the invoice is
either marked for approval or is rejected. However, auto-update of status is controlled by the
‘Current/Next’ status definition defined in Cycle Setup screen and an invoice can also be rejected
when cycle setup is not configured.

Post the validation, the invoice is categorized into the following status:

e FOR APPROVAL - Auto-update for manual approve/reject.

e APPROVED - Auto-update if auto validation succeeds.

e REJECTED - Auto-update if auto validation fails.

e IN PROCESS - Auto-update if transaction posting onto the account fails.

Note the following details in the invoice information screen:

Field: View this:

Invoice Type PAYABLE or PAYMENT RECEIVED.

Indicates if the invoice is already paid or a payment to vendors is to
be initiated from OFSLL.

Funds Indicates the date on which the invoice amount is received from third

Received Dt party auctioning system. This date is used to post payment
transaction on the account from Invoice screen, when the status is
APPROVED.

This field is also editable if the invoice type is PAYABLE.

Total Gross Indicates the total of Gross Proceed Amount recorded at each Work
Proceed Amt Order.

Total Net Indicates the total of Net Proceed Amount recorded at each Work
Proceed Amt Order.

Total Expense | Indicates the total Invoice Amount at individual invoice details
Amt expenses.

Actual Net Indicate the difference in Total Gross proceed Amount - Total Net
Proceed Amt Expense Amount.

For more information about other options available in Invoices screen, refer to Vendors chapter.
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2.5.4.1 Post Transaction

Once the invoice details are approved, user is allowed to post a transaction for the approved
invoice through the Invoice screen by clicking on ‘Post Txns’ button. The button is enabled only
for invoice with status APPROVED and IN PROCESS.

Before posting the transaction, verify the status of ‘Collectible’ in Invoice Details section. During
auto invoice validation, the Collectible field is automatically marked as 'Y’ if the same combination
of a service and work order status matches with the state specific rule defined in Setup >
Administration > System > Vendors > Invoice Rules tab.

If the Collectible field is ‘Y’ then the transaction is posted as ‘Expense’ onto the account based on
the setup. Else, if the Collectible field is ‘N’ accounting for the same needs to be manually
handled.

On clicking ‘Post Txns’ button in invoice screen, the following transactions are initiated:

1. Sale of Asset transaction - indicates the amount received after selling the asset. Also
while posting this transaction, system calculates the Spread based on matching spread
in Spread Matrix or from Contract Spread.

2. Expense transactions. Indicates the additional charges incurred by vendor to sell the
asset and corresponding association of those transactions that are in-turn posted on to
the account.

Depending on the Vendor Services setup defined in Setup > Administration > System > Vendors
> Vendor Services > Work Order Types tab, specific transactions are posted. However, the same
is configurable.

All the transactions posed on the account are recorded and listed in the Collections > Customer
Service > Transaction History > Transactions tab.

Note

The posted transaction can be reversed in the Transactions tab, but this does not
impact/change the status of Invoice or Remarketing.

2.5.4.2 Business Rules for Invoice Validation
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The pre-defined business rules facilitate to validate all incoming invoices. For all the invoices
received, for collateral remarketing should have an invoice type as ‘PAYMENT RECEIVED’.

Following are the pre-defined business rules in the system and every incoming invoice need to
satisfy the below rules for auto updating the invoice status as APPROVED. Else, the same is
marked FOR APPROVAL / REJECTED.

e Rule 1: Each work order that is part of the invoice should have the status as OPEN and
Work Order type as RE SALE. Else, the invoice is updated as REJECTED.

e Rule 2: Validate invoice for the status of ‘Collectible’ in Vendors > Invoice tab > Invoice
Details section.

e During invoice processing, if the combination of Service, Work Order Status and State
matches with any of the state specific rule defined in Setup > Administration > System >
Vendors > Invoice Rules tab, the ‘Collectible’ check box is selected and invoice is
allowed to process the next business rule.

¢ In case the above combination does not exist in Invoice Rules tab, the ‘Collectible’ check
box is NOT selected and the invoice is still allowed to process the next business rule.
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e Rule 3: Validate invoice details based on Estimated and invoiced amount and update the
corresponding status in Invoice Details sections of Vendors screen.

>  If the Invoice Amount is ‘Less than or equal to’ Estimated amount, the status of
Invoice Details is updated to ‘APPROVED’.

> If the Invoice Amount is ‘greater than’ the estimated amount, then the invoice details
need manual approval and the status of Invoice is updated ‘FOR APPROVAL'.

e Rule 4: Validate Invoice Proceed based on the difference between Net and Gross
Proceeds to sum of Invoice amount received at invoice details per work order.

If the difference is zero, Proceed is auto APPROVED. Else, marked FOR APPROVAL.

e Rule 5: Based on the Invoice Details status and Invoice Proceed status, the status of
Invoice, Work Order, and Remarketing are auto updated as indicated below:

Invoice Invoice . Work .
. Invoice Remarketing
details Proceed Order
status status
status status Status

APPROVED | APPROVED | APPROVED INVOICING | INVOICING

REJECTED REJECTED REJECTED OPEN INVOICE
REJECTED
FOR FOR FOR INVOICING | INVOICING

APPROVAL | APPROVAL | APPROVAL

¢ Inthe above table, the status is updated based on the below consideration:
> APPROVED - if all the other status are APPROVED.
> REJECTED - if at least one of the status is REJECTED.

> FOR APPROVAL - if at least one of the status is FOR APPROVAL and the rest are
APPROVED.

2.5.4.3 Details sub tab

The Details sub tab displays the Invoice details received from the third party auctioning system,
and allows to Approve or Reject the invoice with status marked FOR APPROVAL. An invoice is
auto-updated to status FOR APPROVAL based on the business rule validation.

To Approve/Reject an invoice, ensure that you have the necessary access rights assigned to your
login. Select the required invoice record and click ‘Accept’ or ‘Reject’ in the Invoice Details
section. Click ‘Yes’ to confirm the action and refresh to view the status updates.

2.5.4.4 Proceeds sub tab

The Proceeds sub tab helps the financial institutions to know the Net amount that remains in the
account post the re-sale of all assets in the auction. The Proceed Details sub tab displays the
following information:

e Work Order #
e Status
e Gross Amt
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Net Amt
Fee Amt
Authorized By
Authorized Dt

The Net amount is the total amount paid by the third party auctioning system with the close of

auction.

The following tabs are available under Proceed Details sub tab:

The Transaction Results tab records all the errors (if any) for the posted transaction.

Related Invoice/Work Orders

Txn Results

2.5.4.5 Tracking Attributes sub tab

In the Tracking Attributes sub tab, you can load all the available tracking attributes and define the
parameter value for various parameters listed.

2.5.5 Seed Data
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SNO | TABLE KEY DATA Type

1 LOOKUP_TYPES | REM_STATUS_CD INSERT
1 LOOKUP_TYPES | REM_PRIORITY_CD INSERT
2 LOOKUP_TYPES | INVOICE_TYPE_CD INSERT
3 LOOKUP_TYPES | VPC_STATUS_CD INSERT
4 LOOKUP_TYPES | PICKUP_LOCATION_TYPE_CD INSERT
5 LOOKUP_TYPES | SOLD_CHANNEL_CD INSERT
6 LOOKUP_TYPES | HOLD_REASON_CD INSERT
7 LOOKUP_TYPES | TRUE_FALSE_CD INSERT
8 LOOKUPS VENDOR_ASG_CHANNEL_CD|GAI INSERT
9 LOOKUPS REM_STATUS_CD|NEW| INSERT
10 LOOKUPS REM_STATUS_CDI|SA INSERT
11 LOOKUPS REM_STATUS_CDI|AA INSERT
12 LOOKUPS REM_STATUS_CDJAR INSERT
13 LOOKUPS REM_STATUS_CDJ|UX INSERT
14 LOOKUPS REM_STATUS_CD|UA INSERT
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SNO | TABLE KEY DATA Type

15 LOOKUPS REM_STATUS_CD|UR INSERT
16 LOOKUPS REM_STATUS_CD|RU INSERT
17 LOOKUPS REM_STATUS_CD|[H INSERT
18 LOOKUPS REM_STATUS_CD|HA INSERT
19 LOOKUPS REM_STATUS_CD|HR INSERT
20 LOOKUPS REM_STATUS_CD|V INSERT
21 LOOKUPS REM_STATUS_CD|VA INSERT
22 LOOKUPS REM_STATUS_CD|VR INSERT
23 LOOKUPS REM_STATUS_CD|R INSERT
24 LOOKUPS REM_STATUS_CD|RA INSERT
25 LOOKUPS REM_STATUS_CD|RR INSERT
26 LOOKUPS REM_STATUS_CD|I INSERT
27 LOOKUPS REM_STATUS_CD|IR INSERT
28 LOOKUPS REM_STATUS_CD|L INSERT
29 LOOKUPS REM_PRIORITY_CD|1 INSERT
30 LOOKUPS REM_PRIORITY_CD|2 INSERT
31 LOOKUPS REM_PRIORITY_CD|3 INSERT
32 LOOKUPS VENDOR_ASG_TYPE_CD|REM INSERT
33 LOOKUPS INVOICE_TYPE_CDI|PR INSERT
34 LOOKUPS INVOICE_TYPE_CDI|PA INSERT
35 LOOKUPS VPC_STATUS_CD|O INSERT
36 LOOKUPS VPC_STATUS_CD|V INSERT
37 LOOKUPS VPC_STATUS_CDI|A INSERT
38 LOOKUPS VPC_STATUS_CD|F INSERT
39 LOOKUPS VPC_STATUS_CD|R INSERT
40 LOOKUPS VPC_STATUS_CD|E INSERT
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SNO | TABLE KEY DATA Type

41 LOOKUPS CYC_TYPE_CD|COL_REM_STA INSERT
42 LOOKUPS TRUE_FALSE_CD|TRUE INSERT
43 LOOKUPS TRUE_FALSE_CD|FALSE INSERT
44 LOOKUPS PICKUP_LOCATION_TYPE_CDI|AUCTION INSERT
45 LOOKUPS PICKUP_LOCATION_TYPE_CD|BODY INSERT
46 LOOKUPS PICKUP_LOCATION_TYPE_CD|SHOP INSERT
47 LOOKUPS PICKUP_LOCATION_TYPE_CD|BUSINESS INSERT
48 LOOKUPS PICKUP_LOCATION_TYPE_CD|DEALERSHIP INSERT
49 LOOKUPS PICKUP_LOCATION_TYPE_CD|GOVERNMENT INSERT
50 LOOKUPS PICKUP_LOCATION_TYPE_CD|IMPOUND_LOT INSERT

PICKUP_LOCATION_TYPE_CD|MARSHALLING_Y

51 LOOKUPS ARD INSERT
52 LOOKUPS PICKUP_LOCATION_TYPE_CD|REPAIR_SHOP INSERT
53 LOOKUPS PICKUP_LOCATION_TYPE_CD|REPO_AGENT INSERT
54 LOOKUPS PICKUP_LOCATION_TYPE_CD|RESIDENCE INSERT
55 LOOKUPS PICKUP_LOCATION_TYPE_CDI|STREET INSERT
56 LOOKUPS PICKUP_LOCATION_TYPE_CD|TOW_COMPANY INSERT
57 LOOKUPS PICKUP_LOCATION_TYPE_CD|UNKNOWN INSERT
58 LOOKUPS SOLD_CHANNEL_CDI|ONLINE INSERT
59 LOOKUPS SOLD_CHANNEL_CDILIVE INSERT
60 LOOKUPS HOLD_REASON_CD|BANKRUPTCY INSERT
61 LOOKUPS HOLD_REASON_CD|CORRECTIONS INSERT
62 LOOKUPS HOLD_REASON_CD|DEALER_REPURCHASE INSERT
63 LOOKUPS HOLD_REASON_CD|ERROR INSERT
64 LOOKUPS HOLD_REASON_CDI|INSPECTION INSERT
65 LOOKUPS HOLD_REASON_CDI|INSURANCE INSERT
66 LOOKUPS HOLD_REASON_CDIKEYS INSERT
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SNO | TABLE KEY DATA Type

67 LOOKUPS HOLD_REASON_CD|MECHANICAL INSERT

68 LOOKUPS HOLD_REASON_CD|MOVED INSERT

69 LOOKUPS HOLD_REASON_CDI|PAINT_AND_BODY INSERT

70 LOOKUPS HOLD_REASON_CD|REDEMPTION INSERT

71 LOOKUPS HOLD_REASON_CDITITLE_PROBLEM INSERT

72 LOOKUPS HOLD_REASON_CD|TRANSPORTATION_DELAY INSERT

73 LOOKUPS INVOICE_STATUS_CD|IP INSERT
FLL.SER.UCS.ACCOUNTREMARKETING.EDIT.BU

74 FLS_ACCESS TTON INSERT
FLL.SER.UCS.ACCOUNTREMARKETING.VIEW.BU

75 FLS_ACCESS TTON INSERT
FLL.SER.UCS.ACCOUNTREMARKETING.AUDIT.B

76 FLS_ACCESS UTTON INSERT

77 FLS_ACCESS FLL.SER.UCS.ACCOUNTREMARKETING.TAB INSERT
FLL.SER.UCS.ACCOUNTREMARKETING.ADD.BUT

78 FLS_ACCESS TON INSERT
FLL.SER.UCS.ACCOUNTREMARKETINGTRACKIN

79 FLS_ACCESS G.TAB INSERT
FLL.SER.UCS.ACCOUNTREMARKETINGTRACKIN

80 FLS_ACCESS G.EDIT.BUTTON INSERT
FLL.SER.UCS.ACCOUNTREMARKETINGTRACKIN

81 FLS_ACCESS G.VIEW.BUTTON INSERT
FLL.SER.UCS.ACCOUNTREMARKETINGTRACKIN

82 FLS_ACCESS G.AUDIT.BUTTON INSERT
FLL.SER.UCS.ACCOUNTREMARKETINGSTATUSH

83 FLS_ACCESS ISTORY.TAB INSERT
FLL.SER.UCS.ACCOUNTREMARKETINGSTATUSH

84 FLS_ACCESS ISTORY.VIEW.BUTTON INSERT
FLL.SER.UCS.ACCOUNTREMARKETINGREFUND

85 FLS_ACCESS DETAIL.TAB INSERT
FLL.SER.UCS.ACCOUNTREMARKETINGREFUND

86 FLS_ACCESS DETAIL.ADD.BUTTON INSERT
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SNO | TABLE KEY DATA Type
FLL.SER.UCS.ACCOUNTREMARKETINGREFUND

87 FLS_ACCESS DETAIL.EDIT.BUTTON INSERT
FLL.SER.UCS.ACCOUNTREMARKETINGREFUND

88 FLS_ACCESS DETAIL.VIEW.BUTTON INSERT
FLL.SER.UCS.ACCOUNTREMARKETINGREFUND

89 FLS_ACCESS DETAIL.AUDIT.BUTTON INSERT
FLL.CMN.UVN.VENDORASSIGNMENTALLOCATIO

90 FLS_ACCESS N.ADD.BUTTON INSERT
FLL.CMN.UVN.VENDORINVOICEPROCEEDINVOIC

91 FLS_ACCESS EDETAILMAIN.VIEW.BUTTON INSERT
FLL.CMN.UVN.VENDORINVOICEPROCEED.VIEW.

92 FLS_ACCESS BUTTON INSERT
FLL.CMN.UVN.VENDORINVOICEPROCEED.AUDIT

93 FLS_ACCESS .BUTTON INSERT
FLL.CMN.UVN.VENDORINVOICEPROCEEDINVOIC

94 FLS_ACCESS EDETAILMAIN.TAB INSERT

95 FLS_ACCESS FLL.CMN.UVN.VENDORINVOICEPROCEED.TAB INSERT
FLL.CMN.UVN.VENDORASSIGNMENTALLOCATIO

96 FLS_ACCESS N.ADD.BUTTON INSERT
FLL.CMN.UVN.VENDORINVOICEDETAILTRASACTI

97 FLS_ACCESS ONRESULTMAIN.TAB INSERT
FLL.SER.UCS.ACCOUNTREMARKETINGEXPENSE

98 FLS_ACCESS DETAIL.TAB INSERT
FLL.SER.UCS.ACCOUNTREMARKETINGEXPENSE

99 FLS_ACCESS DETAIL.VIEW.BUTTON INSERT
FLL.SER.UCS.ACCOUNTREMARKETINGEXPENSE

100 FLS_ACCESS DETAIL.AUDIT.BUTTON INSERT
FLL.CMN.UVN.VENDORINVOICE.POSTTXN.BUTT

101 FLS_ACCESS ON INSERT
FLL.CMN.UVN.VENDORINVOICEPROCEED.ACCE

102 FLS_ACCESS PT.BUTTON INSERT
FLL.CMN.UVN.VENDORINVOICEPROCEED.REJE

103 FLS_ACCESS CT.BUTTON INSERT

104 FLS_ACCESS FLL.COL.UCS.REMARKETING.MENU INSERT
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SNO | TABLE KEY DATA Type
105 | CYCLES COL_REM_STATUS INSERT
SYS|SYS|SYS|UCS|000832|CANNOTLOADREMAR

TRANSLATION_ | KETINGTRACKINGASRECORDALREADYEXIST.|S

106 | DATA YS|MSG-SE INSERT

SYS|SYS|SYS|UCS|001791|REMARKETINGCANNO

TRANSLATION_ | TBEINTIATEDWITHOUTREPOFORECLOSURE.|SY

107 | DATA S|MSG-SE INSERT
TRANSLATION_ | SYS|SYS|SYS|UVN|001776[TOTALPERCENTAGEN

108 | DATA OTEQUALTO100.|SYS|MSG-SE INSERT
TRANSLATION_ | SYS|SYS|SYS|UVN|001777|DUPLICATESORTNUM

109 | DATA BER.|SYS|MSG-SE INSERT
TRANSLATION_ | SYS|SYS|SYS|UVN|001778|DUPLICATEVENDORN

110 | DATA UMBER.|SYS|MSG-SE INSERT

111 | TXN_CODES EREM INSERT

112 | TXN_CODES EREM_REV INSERT

113 | TXN_CODES EREM_ADJ_MINUS INSERT

114 | TXN_CODES EREM_ADJ_MINUS_REV INSERT

115 | TXN_CODES EREM_ADJ_PLUS INSERT

116 | TXN_CODES EREM_ADJ_PLUS_REV INSERT

117 | TXN_CODES EREM_BILL INSERT

118 | TXN_CODES EREM_BILL_REV INSERT

119 | TXN_CODES EREM_CHGOFF INSERT

120 | TXN_CODES EREM_CHGOFF_REV INSERT

121 | TXN_CODES EREM_WAIVE INSERT

122 | TXN_CODES EREM_WAIVE_REV INSERT
TXN_CODE_PRO

123 | DUCTS SALE_OF_ASSET|ALLJALL|ALL UPDATE
TXN_CODE_PRO

124 | DUCTS SALE_OF_ASSET_REV|ALLJALL|ALL UPDATE
TXN_CODE_PRO

125 | DUCTS EREM|ALL|ALLJALL INSERT
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SNO | TABLE KEY DATA Type
TXN_CODE_PRO

126 | DUCTS EREM_REV|ALLJALLIALL INSERT
TXN_CODE_PRO

127 | DUCTS EREM_ADJ_MINUS|ALL|ALLJALL INSERT
TXN_CODE_PRO

128 | DUCTS EREM_ADJ_MINUS_REV|ALLJALLJALL INSERT
TXN_CODE_PRO

129 | DUCTS EREM_ADJ_PLUS|ALLIALL|ALL INSERT
TXN_CODE_PRO

130 | DUCTS EREM_ADJ_PLUS_REV|ALLJALLJALL INSERT
TXN_CODE_PRO

131 | DUCTS EREM_BILL|ALLJALLIALL INSERT
TXN_CODE_PRO

132 | DUCTS EREM_BILL_REV|ALL|ALLJALL INSERT
TXN_CODE_PRO

133 | DUCTS EREM_CHGOFF|ALL|ALL|ALL INSERT
TXN_CODE_PRO

134 | DUCTS EREM_CHGOFF_REV|ALLJALLIALL INSERT
TXN_CODE_PRO

135 | DUCTS EREM_WAIVE|ALL|ALL|ALL INSERT
TXN_CODE_PRO

136 | DUCTS EREM_WAIVE_REV|ALL|ALLIALL INSERT
TXN_CODE_PAR

137 | AMETERS EREM|TXN_DT INSERT
TXN_CODE_PAR

138 | AMETERS EREM|TXN_AMT INSERT
TXN_CODE_PAR

139 | AMETERS EREM_ADJ_MINUS|TXN_DT INSERT
TXN_CODE_PAR

140 | AMETERS EREM_ADJ_MINUS|TXN_AMT INSERT
TXN_CODE_PAR

141 | AMETERS EREM_ADJ_PLUS|TXN_DT INSERT
TXN_CODE_PAR

142 | AMETERS EREM_ADJ_PLUS|TXN_AMT INSERT
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SNO | TABLE KEY DATA Type
TXN_CODE_PAR

143 | AMETERS EREM_CHGOFF|TXN_DT INSERT
TXN_CODE_PAR

144 | AMETERS EREM_WAIVE|TXN_DT INSERT
TXN_CODE_PAR

145 | AMETERS EREM_WAIVE|TXN_AMT INSERT
TXN_CODE_PAR

146 | AMETERS SALE_OF_ASSET|TXN_REASON_CD INSERT
TXN_CODE_PAR

147 | AMETERS SALE_OF_ASSET|TXN_ASE_NBR INSERT

148 | FLEX_TABLES TAB_REM_CMN INSERT
FLEX_TABLE_AT

149 | TRIBUTES TAB_REM_CMN|PICK_UP_DATE INSERT
FLEX_TABLE_AT

150 | TRIBUTES TAB_REM_CMN|DROP_OFF_DATE INSERT
FLEX_TABLE_AT

151 | TRIBUTES TAB_REM_CMN|PICK_UP_LOCATION_TYPE INSERT
FLEX_TABLE_AT

152 | TRIBUTES TAB_REM_CMNI|PICKUP_LOCATION_NAME INSERT
FLEX_TABLE_AT

153 | TRIBUTES TAB_REM_CMN|PICKUP_CONTACT _PERSON_2 | INSERT
FLEX_TABLE_AT

154 | TRIBUTES TAB_REM_CMN|PICKUP_CONTACT_PHONE2 INSERT
FLEX_TABLE_AT

155 | TRIBUTES TAB_REM_CMN|PICKUP_CONTACT_FAX_2 INSERT
FLEX_TABLE_AT

156 | TRIBUTES TAB_REM_CMN|PICKUP_CONTACT _EMAIL_1 INSERT
FLEX_TABLE_AT

157 | TRIBUTES TAB_REM_CMN|PICKUP_CONTACT_EMAIL_2 INSERT
FLEX_TABLE_AT

158 | TRIBUTES TAB_REM_CMN|PICKUP_OR_DROP_OFF NOTE | INSERT
FLEX_TABLE_AT

159 | TRIBUTES TAB_REM_CMN|VEHICLE_IS_OPERABLE INSERT
FLEX_TABLE_AT | TAB_REM_CMN|TRANSFER_ACKNOWLEDGED_D

160 | TRIBUTES ATE INSERT
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SNO | TABLE KEY DATA Type
FLEX_TABLE_AT

161 | TRIBUTES TAB_REM_CMNJAUCTION_ARRIVAL_DATE INSERT
FLEX_TABLE_AT

162 | TRIBUTES TAB_REM_CMN|MILEAGE_AT_AUCTION INSERT
FLEX_TABLE_AT

163 | TRIBUTES TAB_REM_CMNJ|INVENTORY_NUMBER INSERT
FLEX_TABLE_AT

164 | TRIBUTES TAB_REM_CMN|SOLD_CHANNEL INSERT
FLEX_TABLE_AT

165 | TRIBUTES TAB_REM_CMNI|LEGAL_SALE_DATE INSERT
FLEX_TABLE_AT

166 | TRIBUTES TAB_REM_CMN|REQUESTED_FLOOR_PRICE INSERT
FLEX_TABLE_AT

167 | TRIBUTES TAB_REM_CMN|FLOOR_PRICE INSERT
FLEX_TABLE_AT

168 | TRIBUTES TAB_REM_CMN|SALEABLE_DATE INSERT
FLEX_TABLE_AT

169 | TRIBUTES TAB_REM_CMN|SCHEDULED_SALE_DATE INSERT
FLEX_TABLE_AT

170 | TRIBUTES TAB_REM_CMNJAUCTION_CHANNEL INSERT
FLEX_TABLE_AT

171 | TRIBUTES TAB_REM_CMN|AUCTION_DATE INSERT
FLEX_TABLE_AT

172 | TRIBUTES TAB_REM_CMN|SOLD_DATE INSERT
FLEX_TABLE_AT

173 | TRIBUTES TAB_REM_CMN|HIGHEST_BID INSERT
FLEX_TABLE_AT

174 | TRIBUTES TAB_REM_CMN|NUMBER_OF_BIDS INSERT
FLEX_TABLE_AT

175 | TRIBUTES TAB_REM_CMN|LANE_NUMBER INSERT
FLEX_TABLE_AT

176 | TRIBUTES TAB_REM_CMN|BUYERS_NAME INSERT
FLEX_TABLE_AT

177 | TRIBUTES TAB_REM_CMN|BUYER_ID INSERT
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SNO | TABLE KEY DATA Type
FLEX_TABLE_AT

178 | TRIBUTES TAB_REM_CMN|BUYER_DEALER_NUMBER INSERT
FLEX_TABLE_AT | TAB_REM_CMN|AUCTION_GUIDED_BOOK_PRIC

179 | TRIBUTES E INSERT
FLEX_TABLE_AT

180 | TRIBUTES TAB_REM_CMN|FUNDS_RECEIVED_DATE INSERT
FLEX_TABLE_AT

181 | TRIBUTES TAB_REM_CMN|HOLD_REASON INSERT
FLEX_TABLE_AT

182 | TRIBUTES TAB_REM_CMN|HOLD_RELEASE_DATE INSERT
FLEX_TABLE_AT

183 | TRIBUTES TAB_REM_CMN|TITLE_SENT_DATE INSERT
FLEX_TABLE_AT

184 | TRIBUTES TAB_REM_CMN|TITLE_RECEIVE_DATE INSERT
FLEX_TABLE_AT

185 | TRIBUTES TAB_REM_CMN|TITLE_RETURNED_DATE INSERT
FLEX_TABLE_AT

186 | TRIBUTES TAB_REM_CMN|REPAIR_REQUIRED INSERT
FLEX_TABLE_AT

187 | TRIBUTES TAB_REM_CMN|CONDITION_REPORT_DATE INSERT
FLEX_TABLE_AT | TAB_REM_CMN|VEHICLE_GRADE_BEFORE_REP

188 | TRIBUTES AIR INSERT
FLEX_TABLE_AT | TAB_REM_CMN|VEHICLE_GRADE_AFTER_REPAI

189 | TRIBUTES R INSERT
FLEX_TABLE_AT

190 | TRIBUTES TAB_REM_CMN|REPAIR_APPROVAL_AMOUNT INSERT
FLEX_TABLE_AT

191 | TRIBUTES TAB_REM_CMN|REPAIR_COMPLETE_DATE INSERT
FLEX_TABLE_AT

192 | TRIBUTES TAB_REM_CMN|DAMAGE INSERT
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2.6 Automatic Generation of ‘Account Number’

2.6.1 Overview

New parameter is used for conversion accounts to decide option of account number generation
when an account is received from origination system to OFSLL servicing using account on-
boarding RESTFUL service.

2.6.2 Description

New parameter AUTO_GEN_ACC_NBR_CONYV is used for conversion accounts to decide option
of account number generation. If the value of parameter is set to ‘Y’ the account number is
automatically generated in OFSLL during conversion and if the value is ‘N’, then external
reference number (generated in third party system) itself is appended as the account number.

2.6.3 Seed Data

SNO | TABLE KEY DATA Type

SYSTEM_PARA | AUTO_GEN_ACC_NBR_CONV|SET_SYP_SYSTEM|
1 METER ALL|ALL|ALL|ALL|ALL|ALL|ALL INSERT
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2.7 Archive —Vendor / Work Order / Invoices

2.7.1 Overview

Archival logic of ‘Work Order and Invoices’ is enhanced and new parameter and batch job
created to archive Vendor information.

2.7.2 Description

Changes to existing batch job — Work Orders / Invoices

SET_PUR > pvaarc_bj_100_02 - Archive Vendor Assignments data to O-Tables.

e This process archives vendor assignment data from TABLE to OTABLE.

e The criteria for archival is based on following validation - Work Order Status = Closed /
Completed / Repossessed + Days mentioned in system parameter
‘PVA_ARCHIVE_DAYS'.

SET_PUR > pviarc_bj_100_01 - Archive Vendor Invoice Data to O-Tables.

e This process archives vendor Invoice data from TABLE to OTABLE.

e The criteria for archival is based on following validation — Invoice Status = Close + Days
mentioned in system parameter ‘PVI_ARCHIVE_DAYS'.

New batch job / System parameter — Vendor Archive

Two new system parameters are introduced to specify archive days of vendor to O tables and OO
tables.

PVE_ARCHIVE_DAYS — This parameter stores the number of days for archival of regular
vendors. Input parameter value is numeric.

PVE_OARCHIVE_DAYS — This parameter is used to specify the number of days post which the
regular vendors are to be moved from ‘O’ tables to ‘OO’ tables. Input parameter value is numeric.
SET_PUR > pvearc_bj_100_01 - Archive Vendor data to O-Tables.

e This process archives vendor data from TABLE to OTABLE.
e The criteria for archival is based on following validation
e Vendor end date is less than system date — Days mentioned in system parameter -
‘PVE_ARCHIVE- DAYS'.
SET_PUR > pvearc_bj_100_02 - Archive Vendor Invoice Data to OO-Tables.

e This process archives vendor Invoice data from OTABLE to OOTABLE.

e The criteria for archival is based on days mentioned in the system parameter — PVE-
OARCHIVE_DAYS

2.7.3 Seed Data

SNO | TABLE KEY DATA Type

1 JOBS SET-PUR|PVEARC_BJ_100_01 INSERT
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SNO | TABLE KEY DATA Type

2 JOBS SET-PUR|PVEARC_BJ_100_02 INSERT
3 JOB_THREADS SET-PUR|PVEARC_BJ_100_01|1 INSERT
4 JOB_THREADS SET-PUR|PVEARC_BJ_100 012 INSERT
5 JOB_THREADS SET-PUR|PVEARC_BJ_100 01|3 INSERT
6 JOB_THREADS SET-PUR|PVEARC_BJ_100_01|4 INSERT
7 JOB_THREADS SET-PUR|PVEARC_BJ_100 02|1 INSERT
8 JOB_THREADS SET-PUR|PVEARC_BJ_100 022 INSERT
9 JOB_THREADS SET-PUR|PVEARC_BJ_100 023 INSERT
10 JOB_THREADS SET-PUR|PVEARC_BJ_100_02|4 INSERT

11 SYSTEM_PARAMETERS PVE_ARCHIVE_DAYS|SET_SYP_SYSTEM INSERT

12 SYSTEM_PARAMETERS PVE_OARCHIVE_DAYS|SET_SYP_SYSTEM | INSERT

13 FLEX_TABLE_ATTRIBUTES | SET_SYP_SYSTEM|PVE_ARCHIVE_DAYS INSERT

14 FLEX_TABLE_ATTRIBUTES | SET_SYP_SYSTEM|PVE_OARCHIVE_DAYS | INSERT
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2.8 Change Term - Transaction Updates

2.8.1 Overview

On posting of CHANGE TERM transaction, system updates Term and Maturity date.

2.8.2 Description

On posting of ‘Change Term’ transaction, system does the following actions:

e New Term is calculated from ACC_DUE_DT_NEXT onwards. (Say, New Terms)

e Calculates the number of terms from Contract date to ACC_DUE_DT_NEXT (Say,
Passed Terms).

o Updates ACC_TERM_CUR with sum of PASSED TERMS + NEW TERMS.
o Updates ACC_MATURITY_DT_CUR with sum of ACC_DUE_DT_NEXT + NEW TERMS.

2.8.3 Screenshot

Customer Service > Summary screen
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Eleche X Good Teaugh 0t Agresd At PadTIOL
2.8.4 Seed Data
SNO | TABLE KEY DATA Type
1 TXN_CODE_PARAMETERS | CHANGE_TERM|TXN_BALLOON_ PMT_AM | UPDATE
T
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2.9

29.1

Case Re-assignment

The Batch job ‘AUTOMATIC VENDOR REASSIGNMENT is used to reassign a Case to a new

vendor, if the Case is in ‘Open’ status for specific numbers of days.

Description

Earlier, this functionality was driven by system parameter - VEN_REASSIGNMENT_DAYS.

Currently, instead of system parameter a lookup is added to indicate ‘Days’ (sub code against
each work order type) for a CASE. VEN_REASSIGN_DAYS_CD (VENDOR REASSIGNMENT
DAYS CODES).

Reassignment is handled as indicated in the following scenarios:

Scenario 1:

If the Case is in “NEW FROM CLIENT” status in GRI and user tries to reassign the Case to a new

Vendor.

GRI will reassign to new vendor.

No New CASE gets created.

Scenario 2:

If the Case is “OPEN” status in GRI and user tries to reassign the Case to a new Vendor.

1. System puts the Current Case in “Pending on Close” status in GRI

Creates a New Case with New Case #

Assign to New Vendor.

2.9.2 Seed Data
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SNO | TABLE KEY DATA Type

1 LOOKUP_TYPES | VEN_REASSIGN_DAYS_CD INSERT
2 LOOKUPS VEN_REASSIGN_DAYS_CD|BKR INSERT
3 LOOKUPS VEN_REASSIGN_DAYS_CD|COL INSERT
4 LOOKUPS VEN_REASSIGN_DAYS_CDI|IIR INSERT
5 LOOKUPS VEN_REASSIGN_DAYS_CD|DRK INSERT
6 LOOKUPS VEN_REASSIGN_DAYS_CD|IRP INSERT
7 LOOKUPS VEN_REASSIGN_DAYS_CD|VRP INSERT
8 LOOKUPS VEN_REASSIGN_DAYS_CD|RCV INSERT
9 LOOKUPS VEN_REASSIGN_DAYS_CD|REM INSERT
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SNO | TABLE KEY DATA Type

10 LOOKUPS VEN_REASSIGN_DAYS_CD|RPO INSERT
11 LOOKUPS VEN_REASSIGN_DAYS_CD|SKP INSERT
12 LOOKUPS VEN_REASSIGN_DAYS_CD|SVC INSERT
13 LOOKUPS VEN_REASSIGN_DAYS_CD|IVR INSERT
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2.10 Update for Lien Release Entity — Others

2.10.1 Description

In Collateral management - Collateral Details tab, on selecting the Lien Release Entity type as
‘Others’ from the drop-down list, system captures the address details maintained in the following
tracking attribute - (ASSET LIEN/TITLE (VEHICLE)).

However, user has to ensure that the data (i.e. address details) in above tracking attribute is
maintained since system does not auto validate the same.

2.10.2 Seed Data
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SNO | TABLE KEY DATA Type

1 FLEX_TABLE_ATTRIBUT | ATA_4_ITM_9|9|RELEASE STREET UPDATE
ES ADDRESS

2 FLEX_TABLE_ATTRIBUT | ATA_4_ITM_10|10|RELEASE CITY UPDATE
ES

3 FLEX_TABLE_ATTRIBUT | ATA_4_ITM_11|11|RELEASE STATE UPDATE
ES

4 FLEX_TABLE_ATTRIBUT | ATA_4_ITM_12|12|RELEASE ZIP CODE UPDATE
ES
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2.11 Update to NACHA file Processing Validations

2.11.1 Description
To facilitate NACHA file validation, new system parameter ‘LBX_DR_CR_VALIDATE_AMT _IND’

is introduced and based on the status of this parameter, system is either allowed to validate the
file or process without validation.

If LBX DR CR VALIDATE AMT IND =NO

Validation will be based on original DLS/OFSLL 14.1 code where total of entry details (record 6 &
7) and amounts in the details are validated with total in record 8 (record 8 will have only credit
amount populated) and no separation of CREDIT & DEBIT amounts in record 8 is done.

If LBX DR CR VALIDATE AMT IND =YES

Addenda record is used to determine if the amount in ENTRY DETAIL RECORD (record 6) is a
PAYMENT or PAYMENT_REVERSAL. If ADDENDA RECORD has '05' in TYPE CODE, then
record 6 entry is considered as PAYMENT,; if ADDENDA RECORD has '99' in TYPE CODE, then
record 6 is PAYMENT_REVERSAL.

Record 6 will have amount in fields 30-39.

Each batch will always have only PAYMENT entries or PAYMENT_REVERSALS. Batch cannot
have mixed entries.

Assumption is that there will always be ADDENDA record for both PAYMENTS &
PAYMENT_REVERSALS for this process to work.

If the batch contains only PAYMENTS - Validation will be for TOTAL OF AMOUNTS in all record
6's vs TOTAL CREDIT AMT in record 8 (present in fields 33-44).

If the batch contains only PAYMENT _REVERSALS - Validation will be for TOTAL OF AMOUNTS
in all record 6's with TOTAL DEBIT AMT in record 8 (present in fields 21-32).

2.11.2 Seed Data

SNO | TABLE KEY DATA Type

LBX_DR_CR_VALIDATE_AMT _IND|SET_S
1 SYSTEM_PARAMETERS | YP_SYSTEM|ALL|ALL|ALL|ALLJALLJALL|AL | ADDED
L

FLEX_TABLE_ATTRIBU | SET_SYP_SYSTEM|LBX_DR_CR_VALIDA

TES TE_AMT_IND ADDED
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2.12 Extension for Seriously Delinqguent Accounts

2.12.1 Overview

Existing monetary transaction ‘EXTENSION_OVERRIDE’ is enhanced to post extension on
seriously delinquent accounts. Earlier, system used to display an error message “Account is
serious delinquent. Extension is not allowed” on posting of this transaction.

Note: This change is applicable for LOAN products and only for ‘IBL’ (not for pre-compute loans
or amortized loans).

2.12.2 Description

On posting the transaction on seriously delinquent accounts, system processes the transaction
along with the following changes:

e The Due buckets are moved from ‘Oldest Due Date’ (currently doing from 5th bucket) and
update the ‘Oldest Due Date’ under Accounts > Header block.

e The ‘Days Past Due’ is updated and shown based on revised ‘Oldest Due Date’.
e The ‘Amount Due’ is updated and shown based on revised ‘Oldest Due Date’.

2.12.3 Seed data

NA
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2.13 Performance Enhancements

2.13.1 Overview

To enhance the usability and improve performance of data intensive screens, data in below listed
screens are grouped depending on the number of days (1 day, 1 week, 1 Month) and date range.
Users can now filter and search transaction data based on required range.

e Servicing/collections > Interfaces > GL Transactions > GL Transactions

e Servicing/collections > Interfaces > GL Transactions > Amortized Transactions
e Servicing/collections/Origination > Producers > Transactions

e Servicing/collections - Interfaces - AP Transactions

e Servicing/collections - Batch Transactions > Payments > Payment Entry

e Servicing/collections - Interfaces - GL Transactions > WFP GL Transactions
e Servicing/collections/Origination - Vendors - Work Orders

e Servicing/collections/Origination - Vendors - Invoices

e Servicing/collections/Origination - Producers > Title Status Summary

e DashBoard > System Monitor - Jobs - Batch

e DashBoard > System Monitor - Jobs - Back Ground

e DashBoard - System Monitor - Jobs - Credit Request

e DashBoard > System Monitor > Database Server Log Files

e DashBoard - System Monitor > Parked Transactions

e DashBoard - System Monitor > Users

This enhancement helps for product implementations with huge volumes.

2.13.2 Description

Following are the Ul changes and properties of new radio buttons introduced:

e Radio buttons of 1 Day/1 Week/1 Month/By Date are available for selection.
e By default the first option ‘1 Day’ radio button is selected.

e On selecting ‘By Date’ option, Start Dt and End Dt fields are enabled to select the date
using calendar.

e ‘Search’ button is provided next to date range fields to search based on Start date and End
date specified.

Following validations are introduced while searching for transactions:

e If the Start and End dates are not specified, system displays an error message indicating
“Error: Enter Start/End date”.

o If the date range specified is more than 3 months, system displays an error message
indicating “Error: Date range more than 3 months”.

If the Start date is more than End date, system displays an error message indicating “Error:
Start date is more than end date”.
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2.13.3 Screensh

GL Transa
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Servicing/collections > Interfaces > GL Transactions > GL Transactions
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Amortized Transactions

Servicing/collections > Interfaces > GL Transactions > Amortized Transactions
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Producer Transactions

Servicing/collections/Origination > Producers > Transactions

Financial Services Lending and Leasing
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Collateral Managemer CA-00006 CA-00006 SIMI VALLEY CHRY... USO1 usHQ 05/27/1994 12/31/4000 ACTIVE ¥ JACK NOT DEFINED
Reports Tl CO-00001 CO-00001 PHIL LONG MITSU... USO1 USHQ 05/27/1994 12/31/4000 ACTIVE Y JACK NOT DEFINED
Producers C0-00002 C0-00002 MILE HIGH MITSUB... USO1 UsHQ 05/27/1994 12/31/4000 ACTIVE ¥ JACK NOT DEFINED
Jerdors C0-00003 C0-00003 ED CARROLL MITS... USO1 usHQ 05/27/1984 12/31/4000 ACTIVE ¥ JACK NOT DEFINED
Batch Transactions f CO-00004 CO-00004 DALE SPRADLEY M... USO1 USHQ 05/27/1994 12/31/4000 ACTIVE Y JACK NOT DEFINED
Ad E CO-00005 CO-00005 EHRLICH MITSUBL... USO1 USHQ 05/27f1994 12/31/4000 ACTIVE Y JACK NOT DEFINED
vances
« i »
Payments L I
Columns Hidden 32
Fees
Interfaces Payment Details Subvention i HoldbackjLoss Reserve || Tracking Attributes | Statements  Contacts | Comments  Summary | Titie Status Summary
AP Transactions
GL Transactions = Transactions
il ' View Formatv &P Freeze FfiDetach | ol Wrap W)  © Others® Subvention |View Last © 1Day ©) 1Wesk® 1Month @) ByDate  start Dt
> Collections Effective Dt Transaction Account Amount Reference FostDt
> WFP 05/16/2017 HOLDBACK FROM PRODUCER COMPENSATIONRESERVE  NO ACCOUNT 150.00 TestReference  05/16/2017
> Tools
> Setup

AP Transactions

Servicing/collections - Interfaces > AP Transactions

ORACLE’
Financial Services Lending and Leasing

< i 1

Details  Hitory

AP Transactions x [®] Close
Requisitions
AEdt || Fview | o Audit
Payee Type Pmt Mode Status
@ Al @ Producer (0 Third Party &) Vendor ) Customer 8 All ) ACH ©) Check @ AlIl®) Open ) Close ©) Hold © Void
view = Format~ B Fresze i Detach ¢l Wrap o) |wew Last @ 1Day (@ 1Week(@ 1Month @ By Date  StartDt End Dt (] |
Requisition Id Company Branch Transaction Date  Status Sub Status Sub Status Dt Payee Type Payee Currency -
8083 Uso1 UsHQ 05/28/2017 OPEN READY PRODUCER CA-00002-RANDYS AUTO SA... USD
» 8104 Uso1 UsHQ 05/25/2017 OPEN READY PRODUCER CA-00002-RANDYS AUTO SA... USD
3085 Uso1 UsHQ 05/25/2017 OPEN READY PRODUCER CA-0D002-RANDYS AUTO SA... USD
3086 Uso1 UsHQ 05/25/2017 OPEN READY PRODUCER CA-0D002-RANDYS AUTO SA... USD
3087 Uso1 UsHQ 05/25/2017 OPEN READY PRODUCER CA-0D002-RANDYS AUTO SA... USD
3083 Uso1 UsHQ 05/25/2017 OPEN READY PRODUCER CA-0D002-RANDYS AUTO SA... USD
8108 Uso1 UsHQ 05/25/2017 OPEN READY PRODUCER CA-00003-ACE HEADQUART... USD L
3084 Uso1 UsHQ 05/25/2017 OPEN READY PRODUCER CA-0D002-RANDYS AUTO SA... USD
8105 Uso1 UsHQ 05/25/2017 OPEN READY PRODUCER CA-00003-ACE HEADQUART... USD
8106 Uso1 UsHQ 05/25/2017 OPEN READY PRODUCER CA-00003-ACE HEADQUART .. USD

ORACLE
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Payment Entry

Servicing/collections - Batch Transactions - Payments - Payment Entry

ORACLE
Financial Services Lending and Leasing

Payments

Payment Entry PaymentMaintenance  Search

@ 1Day @ 1 Week® 1Month © By Date

Mo data to display.

Batch
View Last
View Options o
@ Open Batches Only () All Batches
Start Dt
view ¥ Format~ [ Fresze 5 Detach o) Post L) Reverse
Company Branch Batch # Date Batch Type
Uso1 ALL PAY-2017-143-00008018 05/29/2017  PMT MANUAL

Payments

view = Format~ [y Freeze 5 Detach ol Wrap @) o Create Multiple Payments
MU count = Title Account Status PmtDt
Account

[l Hold/Open

Currency

&
L, Print Receipt
Batch Status Total #  CtrlTotal # Total Amt  Ctrl Total Amt
OPEN 0 150,00 000 |F
e Add | A Edit @ View | o Audit
Pmt Amt Spread Mode Reason R

dpadd | AEdt || 5] view | of Audit

4 i

Payment Txns
view ¥ Format~ [ Freeze g Detach

Elview | o Audit

WEP GL Transactions

Servicing/collections - Interfaces - GL Transactions > WFP GL Transactions

ORACLE'
Financial Services Lending and Leasing

GL Transactions 5

Company  Account

Company
View v Formatv B Freeze ffipetach | ol Wrap 5]
Short Name Name
Uso1 DEMO BANK USA
NLO2 DEMO BANK NL
5A03 DEMO BANK 5A
P04 DEMO BANK TP

GL Transactions ~ Amortized Transactions ~ WFP GL Transactions

Currency
US DOLLAR
EURO
SAUDIRIYAL
YEN

n

2 1Week © 1Month|

DByDate StartDt

End Dt & L4

Ho data to display.
< i I

Trancartinne

GL Entries
View v Formatv [ Freeze  fiDetach | ol Wrap o) | View Last @ 1Day
GL PostDt Debit Amt Credit Amt GL FilefBatch # Date

Created

Segment #1

Description Segment £2 Description Seqm

ORACLE
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Work Orders

Servicing/collections/Origination - Vendors - Work Orders

Financial Services Lending and Leasing
Vendors [3€] Close
Vendors | Assignment Allocation  Work Orders | Follow-up | Invoices ol
Work Order
o Add || 7 Edit @ View | < Audit
View Options  OPEN [=] [viewLast @ 1Day @ 1week© 1Month© By Date Start Dt 5End Dt ]
View v Format~ [Ep Freeze etach ol Wrap 5]
Wark Order # Case # Channel Account ] Vend SEES Branch Statu R Wark Order Ty Assigned B
ark Order # ase & annel ccoun St endor S ompany ran g eason ork Order Type  Assigned By
No data to display. g
< | m ] 3
Services | Work Order History  Tracking Attributes
Services b add | AEdt || [ View || o Audit
view v Format~ [y Freeze i Detach ¢l Wrap oo o Load Services
Service # Service Currency Estimated Biled Amt Paid Amt Status Status Dt
No data to display.

Invoices

Servicing/collections/Origination - Vendors - Invoices

ORACLE’
Financial Services Lending and Leasing
Vendors x 3] Close
Vendors || Assignment Allocation || Work Orders | Folow-up | Invaices e
Invoice Information qpadd | AEdt || [ uew | o Audit
View Options ~ OFEN [+ | View Last @ 1Day () 1Week(© 1 Month O By Date start Dt End Dt &8 |
View v Format~ [ Freeze EfiDetach ol Wrap [50)] Validate Invoice
Vendor Company Branch Invoice # External Ref = Invoice Dt Due Dt Status Channel
1L-00001-DECATUR ALITO AUCTION uso1 usHQ 123455 05/29/2017 05/23/2017 OPEN INTERNAL A
1L-00004-JAY A STEINBERG, ESQ Us01 UsHQ 1234 45673 05/28/2017 05/23/2017 = INTERNAL 3
IL-00006-8 AND K TOWING uso1 USHQ 234567 78900 05/29/2017 05/29/2017 OPEN INTERNAL
»
Details  Tracking Attributes
Invoice Details Apadd | AEdt | [ vew | o audit
View > Format = [P Freeze  E Detach &l wirap 5] L4
Work Order & Estimated Invoice Amt Agreed Amt Paid Amt Txn Post Dt Status Status Dt Authorized By Authorized Dt Collectible
Mo data to display.

<

Payment Schedule | Related Invoice/Work Orders

.

ORACLE
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Producer - Title Status Summ

ary

Servicing/collections/Origination - Producers - Title Status Summary

ORACLE’
Financial Services Lending and Leasing

Producers x

Producer Details

View v Format v Freeze  [fiDetach | ¢l wrap zh)
Producer = OldProducer #  Name Company Branch StartDt
CA-00002 CA-D0002 RANDYS AUTO SA... USOL usHQ 05/27/19%4
€A-00003 CA-00003 ACE HEADQUARTE .. US01 usHQ 05/27/1954
CA-00004 CA-00004 VOLKSWAGEN OF ... USO1 UsHQ 05/27/1954
CA-00005 CA-00005 AUTO JUNGLE usoi USHQ 05/27/1334
€A-00006 CA-00006 SIMI VALLEY CHRY... US01 usHQ 05/27/1934
€o-00001 CO-00001 PHIL LONG MITSU... USOL UsHQ 05/27/1954
€0-00002 CO-00002 MILE HIGH MITSUS... US01 USHQ 05/27/1334
€0-00003 €0-00003 ED CARROLL MITS... US01 usHQ 05/27/1934
¥ coooooe CO-00004 DALE SPRADLEY M... USOL UsHQ 05/27/1954
€0-00005 €O-00005 EMRLICH MITSUBL.. USO1 UsHQ 05/27/1934

End Dt

12/31/4000
12/31/4000
12/31/4000
12/31/4000
12/31/4000
12{31/4000
12/31/4000
12/31/4000
12/31/4000
12/31/4000

padd || Zedt | [E]view || o Audt

Enabled Contact Group

i\ JACK. GROUP 1

v JACK. NOT DEFINED
v JaCK NOT DEFINED
\ JACK NOT DEFINED
i JACK. NOT DEFINED
v JacK NOT DEFINED
\ JACK NOT DEFINED
\ JACK. NOT DEFINED
v JacK NOT DEFINED
Y JACK NOT DEFINED

<[

.

Columns Hidden 32

PaymentDetals |~ Compensation | Subvention Transactions Holdback/Loss Reserve

Title Status Summary

Tracking Attributes || Statements

Contacts | Comments | Sum

mary  Title Status Summary

view v Format v Ep Freeze  fiDetach &l Wrap ml View Last @ 1Day O 1 Week © 1Month © By Date  StartDt

End Dt L) |

New Status Perfection Processing Status

Mo data to display.

Perfected Status T CBSE PIOESING by Shatus
Status

Hold Release Status

To Be Released
s Closed Status

Exception Status  Lien Event Date

[ Close

Type zp
DEALER 91767 »
DEALER 91804
DEALER 9136¢
DEALER 91352
DEALER 93062
DEALER 80501
DEALER 8001¢
DEALER 8052¢
DEALER 81002
DEALER 80831 =

Jobs - Batch Monitor

DashBoard - System Monitor - Jobs - Batch

ORACLE'
Financial Services Lending and Leasing

Producers | System Monitor x
Batch Jobs | Jobs | Services | Database Server Log Files | Parked Transactions | Users

Batch BackGround CreditRequest

Last @ 1Day(® 1Week® 1Month @ ByDate StartDt

End Dt

Job Details
view v Format v Ep Freeze EfiDetach | ol Wrap zh) | View
Request Type Status Job Set Job
PROCEDURE COMPLETED SET-QRT QCSPRC_BI_100_
PROCEDURE COMPLETED SET-QRT QCSPRC_BI_100_
PROCEDURE COMPLETED SET-ESC OEDPRC_B1_100_
4 PROCEDURE COMPLETED SET-GRIZ RONFRH_BJ_100_
PROCEDURE COMPLETED SET-GRI2 RONFRH_BI_100_
PROCEDURE COMPLETED SET-GRI2 RONFRH_BI_100_
PROCEDURE COMPLETED SETANT OFDPRC_BJ_111_
PROCEDURE COMPLETED SET-ODD2 CBUUTL_BI_100_0
PROCEDURE COMPLETED SET-QRT QCSPRC_BI_100_
PROCEDURE COMPLETED SET-TAM TAMPRC_BJ_100_.

Description

QCSPRC_BJ_100_
QCSPRC_BI_100
OEDPRC_BJ_100_
RDNFRH_BJ_100_
RDNFRH_BJ_100_
RDNFRH_BJ_100_.
OFDPRC_BI_111_.
chuut_bj_100_03.
QCSPRC_BJ_100_...
TAMPRC_B1_100_

Thread

Errors

Records Run Start Date/Time Run End Date/Time:

2 06/12/2017 02:01:... 06/12/2017 02:
2 06/12/2017 01:01:... 06/12/2017 01
0/06/12/2017 12:5: .. 06/12/2017 12:29
1 06/08/2017 04:48:... 06/08/2017 04:48:
1 06/08/2017 04:42: .. 06/08/2017 0%
1 06/08/2017 04:3%:... 06/08/2017 04:40:
0/ 06/08/2017 04:20: .. 06/08/2017 04:21:
0 06/08/2017 04:13: .. 06/08/2017 04:13:
0 06/05/2017 03:01:... 06/05/2017 03:0%:
513 06/05/2017 02:53:... 06/05/2017 02:53:

(M) Close.
View @ Faied @ Al

valid Execution
Process Dt Period Start

Date/fTime
05/12/2017 06/12/2017 02 » L
05/12/2017 06/12/2017 01 | 1
05/12/2017 06/12/2017 12
05/13/2017 06/08/2017 04
05/13/2017 06/08/2017 04
05/13/2017 06/08/2017 04
05/13/2017 06/08/2017 04
05/13/2017 06/08/2017 04
06/30/2017 06/05/2017 03
05/30/2017 06/05/201702 ~

<

i

Job Detail Description
QCSPRC_BJ_100_02.QCSPRC_B1_100_02(7622)

5 L4

ORACLE
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Jobs - Back Ground Monitor

DashBoard - System Monitor - Jobs - Back Ground

ORACLE

Financial Services Lending and Leasing

Producers x

Batch Jobs | Jobs

Job Details

View v Format v

Request Type

Baich  Back Ground

System Monitor 5

@ Close
Services | Datbase Server Log Files | Parked Transactions | Users £
Credit Request
=3 Freeze G Detach @ | View Last @ 1Day @ 1 Week® 1Month © By Date  startDt End Dt @ View (@ Faied @ Al
Valid Execution
Status Job Set Job. Description Thread Errors Records Run Start Date/Time Run End Date/Time  Process Dt Period Start
Date/Time
SUBMITTED UNDEFINED UNDEFINED- 0 o 0 08/12/2017 02:20: 06/12/2017 06/12/201701 L
SUBMITTED UNDEFINED UNDEFINED- e o 0 0 08/12/2017 02:20: 06/12/2017 06/12/2017 01
COMPLETED UNDEFINED UNDEFINED- DECLARE Iv_tgt_r o o 0 06/12/2017 01:18:... 06/12/2017 01:18:... 06/12/2017 06/12/2017 01
SUBMITTED UNDEFINED UNDEFINED- MODULE=laur_e o o 0 05/12/2017 02:20: 06/12/2017 06/12/2017 01 £
SUBMITTED UNDEFINED UNDEFINED- MODULE=leurlt_e. o o 0 05/12/2017 02:20: 06/12/2017 06/12/2017 12|
COMPLETED UNDEFINED UNDEFINED- DECLARE Iv_tgt_r o o 0 06/12/2017 12:31:... 06/12/2017 12:31:... 06/12/2017 06/12/2017 12| |
COMPLETED UNDEFINED UNDEFINED- DECLARE Iv_tot_r o o 0 08/12/2017 12:29: . 06/12/2017 12:35: .. 06/12/2017 06/12/2017 12
COMPLETED UNDEFINED UNDEFINED- DECLARE ly_axri_r o o 0 06/08/2017 04:48: .. 06/13/2017 06/08/2017 04
COMPLETED UNDEFINED UNDEFINED- DECLARE Iv_axn_r. o o 0 06/08/2017 04:43:... 06/13/2017 06/08/2017 04
COMPLETED UNDEFINED UNDEFINED- DECLARE lv_sn_r o o 0 05/08/2017 04:32:_.. 06/08/2017 04:32: .. 06/13/2017 06/08/2017 04 =

Job Detail Description
MODULE=LCURLT_EM_100_01 DESTYPE=PRINTER DESNAME=ARCHIVE COPIES=1P_CRT_BATCH_JOB_IND=N P_EATCH_PRINTER =UNDEFINED P_USR_CODE=BATCH P_APP_ACC_NER=ALL P_LTR_JRQ_ID=7621P_DATE=06/12/2017 P_EMAIL_ADDR=

» L4

Dash Board = System Monitor = Jobs = Credit Request

ORACLE

Financial Services Lending and Leasing

System Monitor 5,

View v Format ~

Request Type

No data to display.
Columns Hidden

53 Freeze i Detach

BatchJobs  Jobs  Services Database Server Log Files = Parked Transactions || Users
Batch  BackGround  Credit Request
Job Details

[ ose

1] wrap @_siv\ew Last @ 1Day ) 1 Week (@) 1Month &) By Date  Start Dt

Status Job

5

End Dt 6 View () Failed @ Al
Valid Execution
Run Start Date/Time Run End Date/Time  Description Period Start End Dt [ Tme
Date/Time

Dash Board = System Monitor = Database Server Log Files

ORACLE

Financial Services Lending and Leasing

bility

DashBoard x

Batch Jobs | Jobs

View v Format v
File Name
No data to display.

File Content
»  View~ Formatv
Text
No data to display.

Users Productivity x

Services

Database Server Log Files

=4

Process Files % | Producer Analysis x = System Monitor x

[ cloze

iew @ Alert(®) Debug © Interfaces

Database Server Log Files | Parked Transactions  Users
View @ 10ay® 1Week®
e 10ay © 1Week® 1Month OBy Date . Y
Freeze  ifi Detach I] wrap o) istFies [ Download File
File Type
Freeze i Detach 1] wrap @ OBegining@End #oflines 50 Show File

<[

L,

File Size File Tme

ORACLE



DashBoard = System Monitor 2 Parked Transactions

ORACLE’

Financial Services Lending and Leasing

Batch Jobs | Jobs

System Monitor

Services | Datsbase Server LogFiles  Parked Transactions | Users

Transaction Details

) 1 Week @ 1 Month © By Date  StartDt

End Dt

View v Formatv By Freeze ffiDetach | ¢l Wrap @lwew Last @ 1Day
Date Account # : Title
No data to display.
Transaction Results
View v Formatv [} Fresze  {ff Detach v o]
Transaction Processing Details
No data to display.

Transaction

View ©) Failed® Al

Status

[®] Jlose

Monetary

DashBoard = System Monitor = Users

ORACLE

Financial Services Lending and Leasing

DashBoard s

Batch Jobs | Jobs

User Logins

User

SURABHL
ABSHEKAR
TESTUSER
SURABHL
ABSHEKAR

» RBOINA
REOINA
SURABHL
MADHUKARAN
SURABHL
SURABHL
SURABHL
RMACHARL

SURABHL
RMACHARL
ARUN
RMACHARL
SURABHL

Users Productivity x

View v Formatv Freeze i Detach

ProcessFiles ¢ | Producer Analysis x  System Monitor 5

Services  Datsbase Server LogFlles | Parked Transactions  Users

o Wrap

gl view Last| @ 1Day

1Week () 1Month () By Date  Start Dt

End Dt

User Name:

SURABHI DESAT
ANAND SHEKAR
TESTUSER TESTUSER
SURABHI DESAT
ANAND SHEKAR
RAKESH BOINA
RAKESH BOINA
SURABHI DESAT
MADHU R

SURABHI DESAT
SURABHI DESAL
SURABHI DESAT
RAJESH MACHARLA
ARLIN KIIMAR
SURIYA VELUSAMY
SURABHI DESAT
RAJESH MACHARLA
ARLIN KIIMAR
RAJESH MACHARLA
SURABHI DESAT

Details

View User (©
Login Date and Time

07/07/2017 05:15:
07/07/2017 05:14:
07/07/2017 05:01%:
07/07/2017 04:58:
07/07/2017 04:53:
07/07/2017 04:50:
07/07/2017 04:41:
07/07/2017 04:37:
07/07/2017 04:31:
07/07/2017 04
07/07/2017 04:03:
07/07/2017 02:12¢
07/07/2017 02:06:
07/07/2017 02:05:
07/07/2017 02:02:
07/07/2017 01:39:
07/07/2017 01:37:
07/07/2017 01:27:
07/07/2017 01:12:
07/07/2017 01:02:

Current User @) All Users.

[ Qose

Logout Date and

Time

12/30/4000 06:00:... ~
12/30/4000 06:00:
12/30/4000 06:00:...
07/07/2017 05:12¢
07/07/2017 05:04;
07/07/2017 05:03:
07/07/2017 0%:45:... —
07/07/2017 04:51:
07/07/2017 0434
07/07/2017 04:32:
07/07/2017 0%:17:...
07/07/2017 02:30:
07/07/2017 02:30:
07/07/2017 02:35:...
07/07/2017 02:39
07/07/2017 02:12¢
07/07/2017 02:06: L4
07/07/2017 01:55:
07/07/2017 01:34:

07/07/2017 0137« T

I

I

2.13.4 Seed Data

NA
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2.14 Securitization Enhancements

2.14.1 Overview

The Securitization screen has been enhanced to consider the accounts with all statuses, which
previously was supported for only ACTIVE accounts that were available for securitization. This
helps to securitize accounts irrespective their status.

2.14.2 Description

A new system parameter ‘Securitization pool creation with Active Accounts [Other statuses not
allowed] has been added to default ‘ACTIVE’ status accounts available for securitization.

By default this parameter is set to ‘Y’ (enabled).

e When the parameter is “Y’, system by default includes the accounts with ‘ACTIVE’ status.

> When the parameter is ‘Y’ and user tries to add “Status” in Account Selection Criteria,
on click of either ‘Check Criteria’ or ‘Create pool’ buttons, system displays an error
indicating ‘Parameter is set only to include Active accounts in pool; change the
Parameter’.

e When the parameter is ‘N’, user is expected to add ‘STATUS’ column in Securitization
criteria.

Note: The existing validation of ‘Only ACTIVE accounts available for Securitization’ is removed and
the validation now depends on this System parameter and Account statuses defined at ‘Account
Selection Criteria’.

2.14.3 Seed Data

SNO | TABLE KEY DATA Type

1 FLEX_TABLE_A | SET_SYP_SYSTEM|POOL_ACTIVE_ACCOUNTS_ | INSERT
TTRIBUTES ONLY

2 FLEX_TABLE_A | SEC_ACCOUNTS|ACC_STATUS_CD INSERT
TTRIBUTES

3 SYSTEM_PARA | POOL_ACTIVE_ACCOUNTS_ONLY|SET_SYP_SY | INSERT
METERS STEM|ALL|ALL|ALL|ALL|ALL|ALLIALL

4 TRANSLATION_ | SYS|SYS|SYS|SEC|001901|PARAMETERISSETON | INSERT
DATA LYTOINCLUDEACTIVEACCOUNTSINPOOL;CHAN

GETHEPARAMETER|SYS|MSG-SE
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2.15 Batch Job to Transfer Balance on Charge-off Reversal

2.15.1 Description

On posting a charged off reversal transaction successfully, the new batch job

‘TXNCHG_BJ_100_03’ introduced in SET-TPE facilitates to move the remaining expense and fee
from charge off balance to active balance.

2.15.2 Seed Data

2-67

SNO | TABLE KEY DATA Type

1 JOBS SET-TPE|TXNCHG_BJ_100_03 INSERT
2 JOB_THREADS SET-TPE|TXNCHG_BJ_100_03|1 INSERT
3 JOB_THREADS SET-TPE|TXNCHG_BJ_100_03|2 INSERT
4 JOB_THREADS SET-TPE|TXNCHG_BJ_100_03|3 INSERT
5 JOB_THREADS SET-TPE|TXNCHG_BJ_100_03|4 INSERT

ORACLE



2.16 Logqging GRI Communications

2.16.1 Overview

The GRI Web service communication with external system is logged based on a system parameter.
This enhancement will allow user to identify the errors as part of the integration.

2.16.2 Description

GRI web service communication can be logged based on a system parameter.

2-68

The system parameter ‘GRI_WEBSERVICE_LOG_IND’ is provided to enable the system
to log the GRI communication based on existing parameter
‘CMN_FILE_PROCESS TO _LOB’.

Note: System writes the GRI web services logs only when the GRI_WEBSERVICE_LOG_IND
parameter is enabled.

The following web services communications are logged when the parameter is enabled:
> Add Case

» Update Case Account info

> Update Case Address

> Update Case Collateral

> Update Case Debtor

> Update Case Cosigner

» Hold Case

> Reopen Case

> Close Case

> Reassign Case

> Add Case Update (Case Comments)
» FireHose

> Get Repossession Details

» Get Case Invoice Details

The GRI communication logs are displayed in System Monitor > Database Server Log
Files. An ‘Interfaces’ radio button is available next to Debug radio button. On selecting the
same, system displays all the logs related to GRI web services communication with
following parameters.

> File Name: GRI_WS_<<Web Service Name>>_<<Date>>_<<Time>>
> File Type: lob (or) file

> File Size

> File Time

ORACLE



2.16.3 Screen Shot

System Monitor x 3] Close
BatchJobs Jobs  Senices Database Server Log Files  FParked Transactions = Users
Database Server Log Files
fLI::t ® 1Day () 2Days () 50ays ) All Days  view @ Alert Del:ug
View » Format » ﬁ Freeze HEDetach Wrap G@ 1S List Files Download File
File Name File Type File Size File Time
No data to display.
File Content
View v Format » Freeze T Detach rap &) Beginning ® End = of Lines 50
Text
No data to display.
2.16.4 Seed Data
SNO | TABLE KEY DATA Type
L FLEX_TABLE_A | INP_BMP_TNM[TNM_EMP_ACTUAL_FREQ_C | \crnT
TTRIBUTES D
FLEX_TABLE_A | INP_BMP_TNM|TNM_EMP_ACTUAL_PAY_ DA
2 TTRIBUTES Y_DT INSERT
TXN_CODE_PA | CUS_EMPL_MAINT|TNM_EMP_ACTUAL_FRE
3 RAMETERS Q_CD INSERT
TXN_CODE_PA | CUS_EMPL_MAINT|TNM_EMP_ACTUAL_PAY
4 RAMETERS _DAY_DT INSERT
SYS|SYS|SYS|ULN|001094|PAYDAYDATESH
TRANSLATION_ | OULDBEGREATEROREQUALTOSYSTEMDAT
5 DATA E.|SYS|MSG-SE INSERT
SYS|SYS|SYS|UCS|001094|PAYDAYDATESH
TRANSLATION_ | OULDBEGREATEROREQUALTOSYSTEMDAT
6 DATA E.|SYS|MSG-SE INSERT
SYS|SYS|SYS|TNM|001094|PAYDAYDATESH
TRANSLATION_ | OULDBEGREATEROREQUALTOSYSTEMDAT
7 DATA E.|SYS|MSG-SE INSERT
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2.17 Review Request Enhancements

2.17.1 Overview

The Review Request tab is enhanced to enable reviewer to take faster decision by exchanging
multiple comments between Originator and Receiver and logging the comments in “Comments
History” tab in Origination and servicing. Forwarding of review request is allowed from current

receiver to another receiver in case of an escalation.

2.17.2 Description

Following fields are added in ‘Review Request’ table in Servicing >Review Request/Transaction
Authorisation tabs, which will help reviewer to take faster decision without going to Account

screen.
. Field
Field Name T Reference Default Mandatory
ype
Request # Read only | System Generated UNDEFINED [Y
Days Past Read Only Servicing >Accounts > Days NA NA
Due Past Due
Total Servicing >Balances >Current
Outstanding Balance Total
Balance Read Only | (\cc outsTanping ToT | NA NA
AL_AMT)
Customer Populated Based on Primary
Customer of selected account
Read Only (Servicing > Customer Details NA NA
>Customer>Name) (TITLE)
Phone Servicing > Customer Details
>Customer> Addresses>
Read Only | Phone NA NA
Where Current = “Y” and
Mailing = “Y”
Address Servicing > Customer Details
>Customer> Addresses
Read Only | (Primary Customer address NA NA
where Current = “Y” and
Mailing = “Y”).
Email Servicing > Customer Details
Read Only >Customer> Email NA NA

Customer Servicing > Review Request

ORACLE



ORACLE
Financial Services Lending and Leasing
Customer Service x
Search | Customer Service  Review Request (Pending: 0)
Review Requests
Query
user - Originator
View v Format =  [Ep & Detach ¢l wrap
Request = Originator
5001
Review Requests
» Originator
= Priority | HIGH v
* Receiver PHANINDRA CHODA -
Comment | REVIEW
Comment History
View v Format - Ep Freeze  E4 Detach ol wrap
Type Sub Type
No data to display.

Receiver

Queue Assignment

Both View All Forwarded Only

oo (2 Open Account B
Priority

Send Request  [3 Send Response

Receiver Account #

Sender
= Account # | 2017001001PJ10
* Reason  REVIEW ACCOUNT v

Status
Date 09/26/2017 05:31:30 FM
Send Request

Comment

[#% Close Request

+ 2dd

Email

£ Originator

Days Past Due

[ save and Add

[5% Complete Request

[ save and stay

A Edit | Bl view || <2 Audit

5 Receiver

Total Qutstanding Balance Customer

[ save and Retum

&2 Return

Days Past Due
Total Outstanding Balance
Customer

Phone

Address

Email

135

10,154

ALIVE PRI { DARY SECO
9728663378

HOME - 745
,NEWYORK,MASSACHUSETTS,34038
EDW.SIRSI@GMAIL.COM

Comment By

[l view

(Comment Dt

Customer Servicing > Transaction Authorisation > Review Request

Financial Services Lending and Leasing
Transaction Authorization x
Authorization | Authorization History Review Requests (Pending: 0)
Review Requests
Query
User - Originator () Receiver (1 Both  View All Forwarded Only
View v Format v [ Freeze  EfiDetach | ¢J Wrap (50} (D) Open Account  [3 Send Request  [5 Send Response
Request # Originator Priority Receiver Account #
7001
Review Requests
Sender
i . * Account = 20170010012345 -
= Priority | HIGH v
=Transaction ADJUSTMENT TO BANKRUPTCY EXPENS (=
* Receiver PHANINDRA CHODA -
=Reason REVIEW ACCOUNT v
Comment | TEST status
Date 09/27/2017 12:43:51 FM
Send Request
4
Comment History
View v Format v [ Fresze Efipetach  Jwrap B
Type Sub Type ‘Comment
No data to display.

[ig% Close Request

= add

Email

£ Originator

[ complete Request
Days Past Due

& save and Add

& save and Stay

A Edit || B view || 2 audit

&5 Receiver

Total Qutstanding Balance Customer

B save and Retum

<& Return

Days Past Due
Total Qutstanding Balance
Customer

Phone

Address

Email

591

15,450

LANGDON ROBERT [ BRUMMER MIKE
9728663378

HOME - 2342323 N MOESIA ROAD BCH
N2

745,PITTSFIELD, MASSACHUSETTS, 34038
EDWIN.SIRSI@GMAIL.COM

Comment By

=l view

‘Comment Dt

e These fields are auto populated once the Account number is selected.
e Above fields are displayed, when user clicks on “Add or Edit or View” buttons.

Following fields are added in “Review Request” table in Origination >Review Request, which will
help reviewer to take faster decision without going to Application screen.
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N ld Field Type Reference Default | UNDEFINED
ame
Request # Read only System Generated UNDEFINED Y
Application Read Only Origination >Application > Status NA NA
Status
Applicant Populated Based on Primary
Customer of selected account
Read Only (Origination > Applicant >Name(First NA NA
Name/Ml/Last Name)
Phone Origination > Applicant> Addresses>
Read Only Phone NA NA
Where Current = “Y” and Mailing = “Y”
Address Origination > Applicant> Addresses>
Read Only (Primary Customer address where NA NA
Current = “Y” and Mailing = “Y”).
Email Read Only Origination > ApEprI::aai\InD Addresses> NA NA

Origination > Review Request

ORACLE
Financial Services Lending and Leasing

& Welcome, HMACHA +  pccessibility 4§ Sign out

Origination x [3€] Close

Search/Task | Application Entry ~ Review Requests (Pending: 0)

Review Requests
4k add | 7 Edit =] view || <2 Audit
Query

Email
User Originator () Receiver () Both View Al Forwarded Only 5 Originator F Receiver
View - Format = [ Freeze i Detach Wrap @  Q open Application [i3 Send Request [ Send Response 3 Close Request f% Complete Request
Request Originator Priority Receiver Application # Application Status Applicant Phone
6003

Review Requests

Save and Add Save and Stay Save and Return || @ Return

Sender Application Status APPROVED - VERIFYING
b = application # | 0000001001 - Applicant JENA PRITAM
* Priority | HIGH v . " v Phone 2434234234
. ~ Reason | REVIEW APPICATION Address NORMAL ADDRESS - 123 N PR BCH N
Receiver PHANINDRA CHODA - # 123, ATLANTA, GEORGIA, 30348
Status Email PRITAM.JNEABORACLE.COM
Comment | TEST Date 09/27/2017 12:17:04 PM

Send Request

Comment History
View v Format -~ [ Freeze EA: Detach wrap |

Type Sub Type Comment Comment By Comment Dt
No data to display.

e These fields are auto populated once the Application number is selected.
e Above fields are displayed, when user clicks on “Add or Edit or View” buttons.

“Complete Request” button is added above the Origination/Servicing >Review Request >Review
Requests table.
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e Following buttons are moved to table header next to refresh button.
> Open Application/Account
> Send Request
> Send Response
> Close Request
> Complete Request

o New status values “Completed” is added to “REQUEST_STATUS_CD” lookup type.

e Once the “Complete Request” button is clicked, system will update the “Review Request”
status to “Completed” status.

e Once the status updated to “Completed” following buttons are disabled (Similar to “Close
Request” button action”) and record is read only.

> Send Request

> Send Response

> Close Request

>  Email > Originator
» Email >Receiver

e Once the status updated as “Completed”, Review request is displayed in “Originator” or
“Receiver” radio button only when “View All” check box is selected.

e This button is access controlled.

ORACLE’

Financial Services Lending and Leasing

2 Welcome, HMACHA ~  Accessibility 1 Sign Out )

Origination x
@ Information

Search/Task | Application Entry

Review Requests

Query
User

View v Format v [

Request #
7002

Comment History
¥ View~ Formatv [P

Type
REVIEW REQUEST

Transaction Completed Successfully.

Review Requests (Pending: 0)

3 Close

Fpadd | A Edt | Evew | o audit
Email

£4 Originator 9 Receiver

[EB send Response [ Close Request  [E Complete Request I

=  ® originator O Receiver O'Both  View Al Forwarded Only
eze i Detach Wrap [oh) |L]gpen Application [2 send Reques
Originator Priority Receiver
HARISH MACHA HIGH ARUN KUMAR
eze i Detach wap G
Sub Type Comment
ORIGINATOR TEST

‘Application #
1000001005

‘Application Status ‘Applicant Phone
APPROVED - DEAL UPDA... KALLAM NAVEEN 1 0

B view

Comment By Comment Dt
HMACHA 09/27/2017 02:15:36 PM

“Comment” field is added in Origination/Servicing >Review Request >Review Requests table.

Field Name Field Type Default Mandatory Comments
Comment Comr’rgt(a)?(t Text NA N This field should be transient
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ORACLE’
Financial Services Lending and Leasing

4 Welcome,

HMACHA ~  Accessinility i Sign ot &)

Origination x

Search/Task  Application Entry  Review Requests (Pending: 0)

Review Requests

Query

User Originator

Both View All

View v Format v [Ep Freeze Ef: Detach Wrap @  open Application
Requast = Originator Priority
7002 HARISH MACHA HIGH
Review Requests
Request = 7002
v Originator HARISH MACHA

Priority HIGH
Receiver ARUN KUMAR

Comment

Sender
Application # 0000001005
Reason REVIEW APPLICATION

Status WAITING FOR RESPONSE
Date 09/27/2017 02:15:20 PM

Send Request

[ lose
G add | AEdit | B view || 2 Audit
Email
Forvarded Only 5 Originator 7 Receiver
[ sendRequest  [5 Send Response [ Close Reguest 3% Complete Request
Receiver Application = Application Status Applicant Phone
ARUN KUMAR 0000001005 APPROVED - DEAL UPDA . KALLAM NAVEEN 1 0
»

Save and Stay Save and Retum | <3 Retumn

Application Status
Applicant
Phone

Address

Email

APPROVED - DEAL UPDATE
KALLAM NAVEEN 1
0

NORMAL ADDRESS - AR N AR1 ALY N
# AR1,LOIZA,PUERTO RICO,00772

e When user enters the comment in “Comment” field and clicks on save and
Add/Stay/Return, system will push the comment to “Comment History” tab and stamp the

user and comment date.

e Note: Existing “Originator Comments” and “Receiver Comment” fields are not used for
comment exchange going forward, so these fields are hidden.

o “Send Request” button is enabled for “originator” till the review request gets “Closed or

Completed”.

>  If the review request status is “RETURN TO ORIGINATOR” after getting a response
from receiver. Once the request is resend to “Receiver” status will go back to

“WAITING FOR RESPONSE”.

e “Send Response” button is enabled for “Receiver” till the review request gets “Closed or

Completed”.

>  If the review request status is “WAITING FOR RESPONSE” after receiving the
request from Originator. Once the request is resend to “Originator” status will go back
to “RETURN TO ORIGINATOR”.

Note: Apart from above mentioned change rest of button functionalities are As-Is.

New “Comments History” table is created in Servicing >Review Request and Origination

>Review Request tabs.
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Origination
(D Information
Transaction Completed Successfully.

Search/Task = Application Entry

Review Requests

Query

User

Review Requests (Pending: 0)

- ® Originator () Receiver () Both View All

Forvarded Only

B add | A Edit | E] view || o Audit

Email

E9 Originator £ Receiver

[ gose

View » Format~ Ep Freeze g, Detach Wrap @ 2 open Application [[3 sendRequest  [B Send Response [ Close Request g Complete Request

Request # Originator Priority Receiver Application # Application Status Applicant Phone

7002 HARISH MACHA HIGH ARUN KUMAR 0000001005 APPROVED - DEAL UPDA.. KALLAM NAVEEN 1 0

»
Comment History 5] view

View v Format~ [} Freeze Ef; Detach wap @

Type Sub Type Comment Comment By Comment Dt

REVIEW REQUEST ORIGINATOR TEST HMACHA 09/27/2017 02:15:36 PM

e Comments History table will display the log of comments for a review request.

e Application comments table is used to store the Origination >Review request>Comments
History and Account comments table for Servicing >Review Request> Comments History

table.

e Following fields are added in “Comments History” table.

Field Name Field Type Reference
Type ReadR%g'Zég)eVieW COMMENT_TYPE_CD
Sub Type Read Only COMMENT_SUB_TYPE_CD
Comment Comment Text Box Comment text
Comrg;nted Read Only User Name
Comment Dt Read Only Comment date

o New type “REVIEW REQUEST” value is added to COMMENT_TYPE_CD lookup.
e Following new sub type values are added to COMMENT_SUB_TYPE_CD.
> ORIGINATOR
» RECEIVER
> SYSTEM DEFINED

e If the comment is posted by a user Comment Type will be marked as “REVIEW
REQUEST” and Sub Type will be marked based on radio button selected “Originator or
Receiver”.

e |f the comment is posted by the system Comment Type will be marked as “REVIEW
REQUEST” and Sub Type will be marked as “SYSTEM GENERATED”.

e  Only comments with “Type” as review request will be shown in Origination/Servicing

>Review Request >Comments History tab.

e Whenever a comment is posted, by default Alert will be sent as “N”.
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Migration impact

In case of data migration for existing review requests, system will show the existing review

Originator and Receiver comments in “Comment History” table.

“Send Request” check box is added in Origination/Servicing >Review Request >Review Requests

table.

> When user selects this check box, system will send the request to “Receiver” and
same in case of sending reviewer comments from “Receiver” to “Originator”.

> When user selects the “Send Request” check box and save the record, system will

do the following actions.
- Save the record

- Send the request from “Originator” to “Receiver” and vice versa. (all the existing

validations are As Is)
- Make the “Send Request” button as read-only.

— Save the comment record to “Comments History” table.

Origination x

search/Task = Application Entry | Review Requests (Pending: 0)

Review Requests

Review Requests

Request £ 7002 Sender
> Originator HARISH MACHA Application # 0000001005
Priority HIGH

Resson REVIEW APPLICATION
Receiver ARUN KUMAR
Status WAITING FOR RESPONSE

Comment /27/2017 02:15:20 PM

Comment History

View v Format v [} Freeze [ Detach wrap G
Type Sub Type Comment
REVIEW REQUEST ORIGINATOR. TEST

[3% Close Request 3% Complete Request

Query
User Originator () Receiver () Both View All Forwarded Only
View v Format v [ Freeze i Detach Wrap B2 (D open Application 3 Send Request  [E3 Send Response
Request & Originator Priority Receiver Application &
7002 HARISH MACHA HIGH ARUN KUMAR 0000001005

[ Close

g add | FEdt | S view | < aude
Email

7 Originator &9 Receiver

Application Status Applicant Phone
APPROVED - DEAL UPDA... KALLAM NAVEEN 1 0

save and stay || [ save and Retun || 2 Retun

Application Status APPROVED - DEAL UFDATE
Applicant KALLAM NAVEEN 1
Phone 0
Address NORMAL ADDRESS - AR N AR1 ALY N
# AR1,LOIZA PUERTO RICO,00772
Email

Comment By Comment Dt
HMACHA 09/27/2017 02:15:36 PM

“Review Request Supervisor” LOV is added in setup > users tab.

Field Name

Field Type Default

Mandatory

Review Request Supervisor LOV NONE

Y
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sers e

User Definition 9k add | A Edt | [E] view || < Audit
View ~ Format ~ | [[5¢° Freeze g Detach Wrap [0
Yes
& HMACHA ) )
No
User Organization Division Department Start Dt End Dt System Defined Enabled First Name MI Last Name Responsibility
HMACHA DMC uso1 ORG 07/18/2016 12/31/2020 Yes # No ¥ HARISH MACHA SUPERUSER

3

User Definition
Save and Stay || [ Save and Retun || <2 Return

User HMACHA MI Fax 2 (000)-000-0000
™ Organization DMC v = Last Name MACHA Replacement User =
ision | USO1 v * Responsibility COLLECTOR M ot By
* Department ORG v + Review Reguest Superv =] =Type  EMPLOYEE r
*start Dt 07/18/2016 |y + phone 1 |CHIDAMBRANATHAN KATHIRVELU Reference = -
=End Dt 12/31/2000 |8 DEMO COLLECTOR
» / Extn 1 Email

DEMO LEAD
Phone 2 NONE * Default Language
Extn2 PAVANS SUPERVISOR
= First Name HARISH ©pag 1 PAVANM MANAGER, .
EANTNDRA Cooms Time Zone Level | APPLICATION SERVER TIME ZONE ¥
VICKY KUMAR
Search...

* System Defined () Yes ® No

*Enabled (¢

e This LOV will display the users with higher Level than the selected user responsibility.

Note: the user Level will be decided based on the sub code of “RESPONSIBILITY_CD”
lookup values

e  “NONE” value is available in “Review Request Supervisor’ LOV.

Note: this will impact only the Review request “User” LOV, rest of functionalities are As-
Is.

The “User” LOV is added in Servicing >Review Request and Origination >Review Request tabs.

Field Name | Field Type Default Mandatory

User LOV Null NA

e This LOV will display the “Users”, where the logged in user as “Review Request
Supervisor”.

e If any user is selected from the LOV, system will show the review requests of that
respective user in review request table based on the selected radio button.

o By default system will display the review request of logged in user and users with logged
in user as “Review Request Supervisor”.

o |f the Supervisor is responding to a review request, system will post a comment with Type
as “REVIEW REQUEST” and Sub type as “Receiver”.
The Receiver field is editable in Servicing >Review Request and Origination > Review Request
tab > Receiver.
e The receiver field is editable, when the review request is under “Receiver” radio button.
e This is based on “Edit all” functionality.
o If the logged user doesn’t have the edit all responsibility, system wouldn’t allow to edit the
“Receiver” field.

A new “Sender” (Read only) field is added to Servicing >Review Request and Origination
>Review Request tab > Review Requests table

A “Forwarded only” radio button is added to show the forwarded review requests next to “View
All” radio button.

o |If user forwards a review request by changing the “Receiver” name.
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System will post an automated comment with following attributes.

Type: REVIEW REQUEST
Sub-Type: SYSTEM DEFINED

Comment: “Review request: <<>>Request #>> forwarded from <<Current Receiver
Name>> to <<Receiver Name>>

Commented by: Internal

Commented dt: Commented date

Once the receiver is changed, previous receiver will be stamped in “Sender” field and
review request is shown under “Forwarded only” radio button of previous receiver.

> This record will be read only no add and edit buttons will be available.
> Following buttons are disabled

- Send Request

- Send Response
- Close Request

- Email > Originator
- Email >Receiver

> This review request is moved to forwarded receiver bucket.
Ex: if the Review request is initially assigned to User X

If the User X needs a second opinion for the review request, user X will reassign the
request to user Y by changing the “Receiver” LOV. In this case User X will
become “Sender” and User Y will become new receiver.

In this case request will be moved under User Y “Receiver” radio button and showed
in User X “Forwarded only” radio button.

2.17.3 Seed Data

SNO TABLE KEY DATA Type

1 LOOKUPS COMMENT_TYPE_CD|RR INSERT

2 LOOKUPS COMMENT_SUB_TYPE_CD|RR_OR | INSERT
G

3 LOOKUPS COMMENT_SUB_TYPE_CD|RR_RE | INSERT
C

4 LOOKUPS REQUEST_STATUS_CDIL INSERT

5 FLS_ACCESS FLL.CMN.RRQ.REVIEWREQUESTS | INSERT
ENSITIVEDATA.EDIT.BUTTON
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2.18 Collection Queue Enhancements

2.18.1 Overview

The Queue Assignment tab is enhanced to help customer servicing/Collection agent to categorize
and prioritize work.

e New Activity fields are added to capture the activities completed on an account using call
activities

e A sort order and criteria definition tab is provided to write different criteria’s and sort
orders on top of a queue to priorities the work.

2.18.2 Description

A new “Activity Tracking” tab is added in Setup >Queues next to “Call Action Results” tab.

e A new lookup for “Activity Type” with “Activity 1, Activity 2 upto Activity 36” values is
added to Setup > Lookups.

e Anew “Activity Tracking” tab is added in Setup >Queues next to “Call Action Results”
tab.

e Following fields are available in “Activity Tracking” tab.

Field Data Type Mandatory Lookup
Activity Code LOV Yes New Activity Type LOV
Description Text Box Yes NA
Action LOV Yes LOV W|Fh Call Activity
Action Codes
Result LOV with Call Activity
LOV Yes Result Codes
Activity Expiry Days Text Box (Numeric) Yes NA
Enable Check Box Yes NA

e Activity code is unique in “Activity Tracking” tab.

e Activity code, Action and Result combination is unique in this tab.

e Once the Activity code is added in activity tracking tab, it will not editable.

e System will show an error message, if user tries to add a duplicate combination
e Error Message: “Activity code, Action and Result combination exists”.

e When user posts a call activity for which an Activity column is defined, system will update
the column value to “Y” and on Ul it will be shown as “Checked”.

e Based on the “Activity Expiry Days” defined activity field value will be updated to “N”
(Uncheck).
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Ex: if the Activity was updated as “Y” by posting call activity on 6/1/2017 and the expiry of
the activity is “10” day; system is expected to update the activity value as “N” on

6/11/2017.

Setup> Queues >Activity Tracking

ORACLE come, HMACHA + g
Financial Services Lending and Leasing
S
Queues % [ Close
Origination  Customer Service ~ Call Action Results User Groups
Activity Definition P add | A Edt | B View | o Audit
View » Format = ﬁ Freere B Detach ¢l Wrap @ﬁ
Activity Code Description Action Result Activity Expiry Days Enabled
N
A3 ACTIVITY 3 LETTER RECEIVED  FILED/FILINGBA.. 0 Y
A7 ACTIVITY 7 CUSTOMER CALLED HUNG UP 3 Y
A2 ACTIVITY 2 ATTQRMEY/GENE... NO PROMISE 10 Y
At ACTIVITY 1 ATTQRMEY/GENE... CALLBACK 1 Y
Activity Definition
E Save and Add E Save and Stay E Save and Retum (:2 Retumn
* Activity Code v * Result v
Description * Activity Expiry Days
* v
Action *Enabled
Customer Service % Queues (2]
Search | Customer Service: 20160700010521  Review Request (Pending: 0)  Queue Assignment
Search Criteria
Hard Assigned Queue Acc# Responsibility User Search List By
HARISH_DLQ 90 - o S ® Queue O User @8 search || P Reset
Queues  Criteria
Queues
View » Format v [P Freeze Ef Detach [oH]
Queue name Queue Desc Account Condition Priority Company  Branch Hard Assigned S:’]“n"d Followr- NearReal  pyaler extract Enabled
HARISH_DLG 90 HARISH_DLG 90 DELINQUENT 0 coo01 cB-001 ¥ [ ¥ N ¥
Queue Assignment
View = Format = -I Freeze o Detach o) 8% Update Queue Sort Order Type = {hsubmit ¢ Reset
b Del Outstand
Company Branch Date Title Products Status EINQUENTY  pmount Due  DUBIANGING  progycer Secured  Reason ADL  AD2 AOS
Days Balance
usoL uUsHQ 07/01/2016  PRECOMPUTE KR 1 LOAN VEHICLE (FR) ACTIVE:DELQ 143 9,891.19 14522.79  CA-D000Z : RAND.. N
uso1 UsHg 07/01/2016 NS FEE LOAN LOAN VEHICLE (FR) ACTIVE:DELQ:REPO 174 12,410.80  16,78.85  CA-00D0Z: RAND.. N v v
usot UsHG 07/01/2016  ACCOUNT SETTLE... LOAN VEHICLE (FR) ACTIVE:DELQ 174 11,410.80  16,041.69  CA-00D0Z : RAND.. N
usol UsHQ 07/01/2016  ACCELERATION T... LOAN VEHICLE (FR) ACTIVE:DELQ 53 25667.32  26,047.97  CA-00DOZ :RAND.. N
uso1 UsHg 01/01/2017  NAVEEN KR 1 LOAN VEHICLE (FR) ACTIVE:DELQ 226 18,792.04  23,029.33  CA-0000Z : RAND.. N
usot UsHQ 01/01/2017  NAVEEN KR 1 LOAN VEHICLE (FR) ACTIVE:DELQ:REPO 167 10338.05  16,999.15  CA-00DOZ:RAND.. N
usol UsHQ 01/01/2017  NAVEEN KR 2 LOAN VEHICLE (FR) ACTIVE:DELQ 167 1151534 17,5338 CA-00D0Z:RAND.. N
uso1 UsHg 01/21/2017  TEST CHARGEOFF  LOAN VEHICLE (FR) ACTIVE:DELQ 206 59,937.71  103,465.08  CA-0000S : AUTO . N
usot UsHQ 01/01/2017  NAVEEN KR 3 LOAN VEHICLE (FR) ACTIVE:DELQ 167 1181634 17,79035  CA-00DOZ : RAND.. M
usol usHQ 01/01/2017  NAV LINE LINE UNSECURED... ACTIVE:DELQ 198 5,676.68 2543675  CA-D000Z: RAND.. N =

A new “Queue Activity” tab is added under Setup >Queues > Customer Service next to “Group

Assignment”

tab.

e A new “Queue Activity” tab is added under Setup >Queues > Customer Service next to

“Group Assignment” tab.
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e Following fields are available in “Queue Activity” tab.

Field Data Type Mandatory Lookup
Activity Code LOV Yes New Activity Type LOV
Enable Check Box Yes NA

o Activity Code LOV display the enabled activities added in “Activity Tracking” tab.

Note: if an “Activity” record is disabled from “Activity Tracking” tab after adding it to
“Queue Activity” tab, user is expected to disable the respective activity from “Queue

Activity” tab manually.
o “Activity” code is unique in this tab

o |If user tries to add a duplicate Activity code, system will display an error message
“Activity Code already exists” and wouldn’t allow adding the record.

e Queue Assignment tab display the “Activity” columns based on the “Queue Activity”

setup.

Ex: if Activity 1, Activity 2 and Activity 3 are added under Queue 1; when the queue is
selected in Queue assignment screen, system should display the Activity 1, Activity 2 and

Activity 3 columns for accounts un

Setup> Queues > Customer Service

der Queue 1.

Queves x

Origination ~ Customer Service = Call Action Results = Activity Tracking ~ User Groups

Queue Definition

View = Format + @ Freeze E4; Detach Wrap W & undate Quese
¢
Queue Name Queue Desc
HARTSH_DLQ 90 HARISH_DLQ 90
SAI_TEST SAI_TEST
BKRP_CH_7 BANKRUPTCY QUEUE CHAPTER 7: NEW REQUESTS
DEF DEFICIENCY QUEUE : NEW REQUESTS
SCHGOFF SCHEDULED FOR. CHARGEOFF QUEUE
FORECLOSURE FORECLOSURE QUEUE: NEW REQUESTS
REPQ REPOSSESSION QUEUE: NEW REQUESTS
TP PAYOFF{TERMINATION IN PROGRESS QUEUE

Selection Criteria = Sort ~ Responsibilities and Users

Queue Activity Definition
» View v Format~
Activity Code

Fresze i Detach Wrap o)

Queue Activity Definition

32 un-assigned

Account Condition

DELINQUENT

DELINQUENT

BANKRUPTCY

DEFICIENCY

SCHEDULE FOR CHARGEOFF
FORECLOSURE

REPOSSESSION
PAYOFF/TERMINATION IN PROGRESS

Data Node Assignments ~ Group Assignment | Queue Activity

= Activity Code

* Enabled

(2] Close
dpadd | FEdt | S view || & Audt
Priority Company Branch Hard Assig
0 Uso1 USHQ Y
1ALL ALL Y
1ALL ALL Y
1AL ALL N
1AL ALL N
1AL ALL ¥
1AL ALL ¥
1AL ALL N 57
b
G add | AEdt | E view || o audit
Enabled
N
¥
¥
¥
Save and Add Save and Stay Save and Return || (3 Return
v

New Activity fields are added to Servicing/Collections > Queue Assignment tab.

o Activity fields are displayed based on the “Queue Activity” setup in Servicing/Collections

> Queue Assignment tab.

e Activity field is checked when the respective call activity is posted.

e These fields are available only for Search List By = Queue. If the Search List By = User,

these fields are not displayed.
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Servicing >Queue Assignment

Customer Service x  Queues x
Search | Customer Service: 20160700010521 | Review Request (Pending: 0)  Queue Assignment
Search Criteria
Hard Assigned Queue Acc# Responsibility User
HARISH_DLQ 90 - -
Queues  Criteria
Queues
View » Format~ [ Freeze 4 Detach o wrap 50
Queue name Queue Desc Account Condition Friority
[ HaRISH_DLG 90 HARISH_DLQ 90 DELINQUENT )
Queue Assignment
View v Format v Fresze & Detach o wrap oh] 4§84 update Queue Sert Order Type
b Delinquenc
Campany Branch Date Title Products Status qu Y
Us01 USHQ 07/01/2016  PRECOMPUTE KR 1 LOAN VEHICLE (FR) ACTIVE:DELQ 143
. uso1 UsHQ 07/01/2016  INS FEE LOAN LOAN VEHICLE (FR) ACTIVE:DELQ:REPO 174
usp1 USHQ 07/01/2016  ACCOUNT SETTLE.. LOAN VEHICLE (FR) ACTIVE:DELQ 174
us01 UsHQ 07/01/2016  ACCELERATION T... LOAN VEHICLE (FR) ACTIVE:DELQ 53
uso1 USHQ 01/01/2017  NAVEEN KR 1 LOAN VEHICLE (FR) ACTIVE:DELQ 226
us01 USHQ 01/01/2017  NAVEEN KR 1 LOAN VEHICLE (FR) ACTIVE:DELQ:REPQ 167
us01 UsHQ 01/01/2017  NAVEEN KR 2 LOAN VEHICLE (FR) ACTIVE:DELQ 167
usp1 USHQ 01/21/2017  TEST CHARGEOFF  LOAN VEHICLE (FR) ACTIVE:DELQ 206
us01 UsHQ 01/01/2017  NAVEEN KR 3 LOAN VEHICLE (FR) ACTIVE:DELQ 167
uso1 USHQ 01/01/2017  NAV LINE LINE UNSECURED... ACTIVE:DELQ 198
«

I — ¥

Search List By
v ® Queue () User

Company  Branch
€-0001 c8-001
ameunt pue  Outstanding
Balance
9,591.19 14,522.79
12,410.80  16,378.85
11,410.80  16,041.69
25,667.32  26,047.97
18,792.04  23,020.33
10,338.05  16,995.15
1151534 17,533.38
50,937.71  103,465.08
11,816.34  17,790.35
5,676.68 25,436.75

8 search || P Reset

Dialer Extract Enabled
Y N Y N ¥

Hard Aseigned Group Follovi- Near Real-
up Ind Time

= {Shsubmit @ Recet

Producer Secured  Reason AL ADZ A0S
CA-00002 : RAND...
CA-DODO2 : RAND.__
CA-DOODZ : RAND
CA-D0002 : RAND...
CA-D0002 : RAND
CA-00002 : RAND...
CA-D0002 : RAND
CA-DOODS : AUTO

CA-D0002 : RAND...

zZ =2 =22z =2 2z 2 2 2 =

CA-D0002 : RAND

A New “Criteria” tab is added next to Queue Assignment table to define the sort criteria for

accounts to be displayed.

Servicing >Queue Assighment

> Criteria

Quewes % Customer Service x

Search | Customer Service

Search Criteria

Hard Assigned Queue
HARISH_DLQ 90 5

Queves

View » Format~ [

Freeze {, Detach

Qﬂ Wrap

Name Description
e ]

P1_DELQ P1_DELQ
SKSK_TEST SKSK_TEST
TEST TEST
SHAL SHAL

Selection Criteria  Sort

r

Selection Criteria

View v Format~ Freeze ffiDetach ¢l Wrap
Seq Paramater
. 1 ACTIVITY 05 INDICATOR

Review Request (Pending: 0)  Queue Assignment

Acc# Responsibility User

@

Hard Assigned Queue
HARISH_DLQ 90
HARISH_DLG 90

SAI TEST

ALL

ALL

W o ched ciiteria

Search List By

> ® Queus () User
o add | A kit || D view | o audt
Enabled
Y a
Y
Y
Y
Y -
o add | A Edtt || [E] vView | o hudit
(Comparison mn Logical
Operator Criteria Value ) Bapressicn Enabled
LIKE Y Y

“ Search 0 Reset

Criteria Definition table is added to “Servicing >Queue Assignment > Criteria” tab with following

fields.
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Field Name Data Type Mandatory Lookup
Name Text box Yes NA
Description Text Box Yes NA
Hard Assigned Queues Similar to “Hard Assigned Queue”
Lov Yes | pssignment. This LOV shoud nave
“ALL” value.
Enabled Check Yes NA

A sub tab “Selection Criter

ia” tab is added under “Criteria

Definition” table with following fields.

Field Name Data Type Mandatory Lookup

>ed box(Lﬁ)r(r:eric) Yes NA
Parameter LOV Yes Th_is LOV ﬁhould Qisplay the “Queue
Assignment” table fields as parameters
Comparison Operator LOV Yes COMPARISON_OPERATOR_CD
Criteria Value Text Box Yes NA
Logical Operator LOV NO LOGICAL_OPERATOR_CD

Enabled Check Yes NA

e “Parameter’ LOV display the following fields.

» User Name

> Account #

> Responsibility
> Company

> Branch

> Date

> Title

> Products
> Status

» Delinquency Days

» Amount Due
» Outstanding B
> Producer

> Secured

» Reason

alance

> 36 Activity columns.

e A new “Check Criteria” button is added to Selection Criteria table, this will run and

validate the criteria given in “Select criteria” table.

ORACLE




Note: this Select Criteria tab is similar to Setup >Queues >Customer Service >Selection
Criteria tab.

A new “Sort” sub tab is added under “Criteria Definition” table with following fields.

Field Name Data Type Mandatory Lookup
Seq Text box(Numeric) Yes NA
Sort field This LOV should display the
LOV Yes “Queue Assignment” table fields

as parameters

Order LOV Yes SORT_CD

Based on above, the Servicing >Queue Assignment tab will have the following changes:

e Criteria defined in “Queue Assignment >Criteria” tab will be displayed in “Sort Order
Type” LOV in Queue Assignment >Queue Assignment table.

e A new “Submit” button is added next to “Sort Order Type” LOV to run the selected Sort
Order Type.

e Anew “Reset” button is added next to “Submit” button to remove the “Sort Order Type”
applied on the queue and go back to the total accounts (with original sort ordered defined
in setup) in the queue.

e Anew “Filtered Account” button is added in servicing > Queue Assignment tab.

o After selecting “Sort Order Type” from LOV and clicks on “Submit” button, if user clicks on
Filtered Account button, system will open the accounts in selected Sort Order in
customer servicing screen [Functionality should work when Multi — Customer Servicing
tab option is enabled].

e Access control for “Filtered Account” button is ensured.

e If user selects Sort Order from the LOV and clicks on submit button, system will display
the accounts in that Filter criteria and sort order.

¢ In Queue Assignment “Account #’ field is having a hyperlink to open that particular
account in “Customer Service”.

e "Submit” button next to Sort Order Type LOV is used to refresh the queue data showing
in “Queue Assignment” table after applying a sort order type.

The “Filtered Account” button is added in following tabs.

e Customer Servicing >Quick Search
e  Customer Servicing > Right Splitter

Once the queue sort order type is selected in “Queue Assignment” tab. If user clicks on
“Filtered account” button, system will open the accounts in same sort order selected in
gueue assignment table.

Example:

e If user runs a Sort Order Type on a queue and opens the first account in list by clicking
on “Filtered Account” button.

e Subsequently if user want to open second account from the list, either of the following
options can be used:

> Same “Filtered Account’ button
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> “Filtered Account” button in Customer Servicing >Quick Search

Customer Servicing >Queue Assignment

> “Filtered Account” button in Customer Servicing > Right Splitter.

Hard Assigne:

User | @0 Search

N

o Reset

d Group Follow- Near Real-
up Ind Time

N

[®] Close

Dialer Extract Enabled
N Y

= {é} Submit o Reset B Filkered Accountl

Date

05/01/2017
05/01/2017
01/18/2017
05/01/2017
05/01/2017
05/01/2017
05/01/2017
05/01/2017
05/01/2017
05/01/2017

Customer Service ¥ Queuss x = System Monitor x
Search = Customer Service = Review Request (Pending: 0)  Queue Assignment
Search Criteria
Hard Assigned Queue Acc # Responsibility User Search List By
DEL 3160 - - > ® quese
Queues  Criteria
Queues
View = Formatv [ Freeze fiDetach ¢l Wrap 5]
Queue name Queue Desc Account Condition Priority Company Branch
. DEL_MORE_THAN_365 DEL 31-60 DELINQUENT ALL ALL
Queue Assignment
View v Formatv [ Freeze gffiDetach ¢ Wrap 5] Update Queue Sort Order Type
Se\eﬁ User Name Account £ Replacement User  Queue Name Queue Desc Responsibility ‘Company Branch
+
NAVEEN REDDY 2017050000233 w| DEL_MORE_.. DEL31-60 SUPERUSER uso1 UsHQ
NAVEEN REDDY 20170500010366 >| DEL_MORE_.. DEL31-60 SUPERUSER uso1 UsHQ
BISWARUP NATH  20170100010055 w| DEL_MORE_.. DEL31-60 SUPERUSER uso1 USHQ
SURABHI DESAI 2017050001007 x| DEL_MORE_.. DEL31-60 SUPERUSER uso1 USHQ
SURABHI DESAI 20170500010209 x| DEL_MORE_.. DEL31-60 SUPERUSER uso1 UsHQ
SURABHI DESAI 20170500010225 x| DEL_MORE_.. DEL31-60 SUPERUSER uso1 UsHQ
BISWARUP NATH  20170500010556 >| DEL_MORE_.. DEL31-60 SUPERUSER uso1 UsHQ
PRITAM JENA 20170500010275 w| DEL_MORE_.. DEL31-60 SUPERUSER uso1 USHQ
NAVEEN REDDY 20170500010316 x| DEL_MORE_.. DEL31-60 SUPERUSER uso1 USHQ
BISWARUP NATH ~ 20170500010324 x| DEL_MORE_.. DEL31-60 SUPERUSER uso1 UsHQ
4

Title

AS LINE
REPQSSESSION 3
ACCELERATION T
KALLAM NAVEEN 2
NAVEEN LINE
KALLAM NAVEEN /..
NAVEEN LEASE
NAVEEN INSURAN
NAVEEN INSURAN...
NAVEEN INSURAN...

Products Status

LINE UNSECURED... ACTIVE:D ~
LOAN VEHICLE (FR) ACTIVE:DE
LOAN VEHICLE (FR) ACTIVE:DE
LOAN VEHICLE (FR) ACTIVE:DE
LINE UNSECURED... ACTIVE:DE
LOAN VEHICLE (FR) ACTIVE:DE
LEASE VEHICLE  ACTIVE:D
LOAN VEHICLE (FR) ACTIVE:DE
LOAN VEHICLE (FR) ACTIVE:DE
LOAN VEHICLE (FR) ACTIVEDI
3

Customer Service >Right Splitter

ORACLE’
Financial Services Lending and Leasing

Customer Service x ~ Queuss x = System Monitor

Search ~ Customer Service: 20170500010233  Review Request (Pending: 0) ~ Queue Assignment

Effective Dt 05/01/2017  Customer Score 0
Current Pmt_849.11

Due Day 1 A

Behaviour Score 0

Account(s): 20170500010233: AS LINE View || o Audit
View v Formatv [ Freere pfiDetach | oJ Wrap @ 5 @ curent O ShowAll O Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt
.USﬂl USHQ UNDEFINED 2017050000233 LINE UNSECURED (VR) 110 UsD 26,700.82
1 3
Broken 0 Kept 0 PR/ /2 R
Promises Promises 1 4
(¥ear) (Year)
Activities Employment Information
Active Dt 09/19/2017 ¥-Ref Charge OF Dt Type Current r:’c";‘n”"’" Employer Next Pay Day Frequenc
Last Acﬁvg U9/18/2017  Paid OFF Ot Miltary Duty N FULLTIME Y Y UNDEFINED MONTHL.

b

Quick Search
A=

Customer 1d

55N
Identification
Submit 0 (Clear
Queue/ v
Condition
Auto Run

Add Comment
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Customer Servicing >Quick Search

ORACLE’ #, Welcome, HMACHA v pccessibifty 1) Sign Out

Financial Services Lending and Leasing
Customer Service ¥ Queues % System Monitor x @Q
Search  Customer Service: 20170500010233 = Review Request (Pending: 0)  Queue Assignment

Quick Search

Acc # Customer Id S5N Identification # @ Submit

Queue/ Condition ¥ Auto Run @ MNext Account

> Search Criteria

quen Account

Search Results

View = Formatv g Freere it Detach Wrap

Company Branch Account Date Tite Product Status §:$:auencv Amount Due g;‘:n'::d‘”ﬂ Producer

No data to display.

2.18.3 Seed Data

SNO TABLE KEY DATA Type
1 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|AO1 INSERT
2 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A02 INSERT
3 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A03 INSERT
4 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A04 INSERT
5 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A05 INSERT
6 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A06 INSERT
7 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A07 INSERT
8 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A08 INSERT
9 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A09 INSERT
10 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A10 INSERT
11 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|Al1l INSERT
12 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A12 INSERT
13 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A13 INSERT
14 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|Al14 INSERT
15 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A15 INSERT
16 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A16 INSERT
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SNO | TABLE KEY DATA Type
17 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A17 INSERT
18 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJA18 INSERT
19 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJA19 INSERT
20 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJ|A20 INSERT
21 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJ|A21 INSERT
22 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A22 INSERT
23 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJ|A23 INSERT
24 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A24 INSERT
25 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJ|A25 INSERT
26 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJ|A26 INSERT
27 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A27 INSERT
28 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJ|A28 INSERT
29 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJ|A29 INSERT
30 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJ|A30 INSERT
31 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJ|A31 INSERT
32 LOOKUPS QUEUE_ACTIVITY_TYPE_CD|A32 INSERT
33 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJA33 INSERT
34 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJ|A34 INSERT
35 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJA35 INSERT
36 LOOKUPS QUEUE_ACTIVITY_TYPE_CDJA36 INSERT
37 LOOKUPS ASSIGNMENT_TYPE_CD|QAS INSERT
38 LOOKUPS FLEX_TABLE_TYPE_CD|ASG_QAS_PARAME | INSERT
TER_CD
39 LOOKUP_TYPES QUEUE_ACTIVITY_TYPE_CD INSERT
40 FLS_ACCESS FLL.SET.UQU.QUEUEACTIVITYTRACKING.TA | INSERT
B
41 FLS_ACCESS FLL.SET.UQU.QUEUEACTIVITYTRACKING.AD | INSERT
D.BUTTON
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SNO TABLE KEY DATA Type

42 FLS_ACCESS FLL.SET.UQU.QUEUEACTIVITYTRACKING.ED | INSERT
IT. BUTTON

43 FLS_ACCESS FLL.SET.UQU.QUEUEACTIVITYTRACKING.VI | INSERT
EW.BUTTON

44 FLS_ACCESS FLL.SET.UQU.QUEUEACTIVITYTRACKING.AU | INSERT
DIT.BUTTON

45 FLS_ACCESS FLL.SET.UQU.CUSTOMERSERVICEQUEUEA INSERT
CTIVITY.TAB

46 FLS_ACCESS FLL.SET.UQU.CUSTOMERSERVICEQUEUEA INSERT
CTIVITY.ADD.BUTTON

a7 FLS_ACCESS FLL.SET.UQU.CUSTOMERSERVICEQUEUEA INSERT
CTIVITY.EDIT.BUTTON

48 FLS_ACCESS FLL.SET.UQU.CUSTOMERSERVICEQUEUEA INSERT
CTIVITY.VIEW.BUTTON

49 FLS_ACCESS FLL.SET.UQU.CUSTOMERSERVICEQUEUEA INSERT
CTIVITY.AUDIT.BUTTON

50 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUECRITERIA.TA | INSERT
B

51 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUECRITERIA.AD | INSERT
D.BUTTON

52 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUECRITERIA.ED | INSERT
IT. BUTTON

53 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUECRITERIA.VI INSERT
EW.BUTTON

54 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUECRITERIA.AU | INSERT
DIT.BUTTON

55 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUECRITERIADE | INSERT
FINITION.TAB

56 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUECRITERIADE | INSERT
FINITION.ADD.BUTTON

57 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUECRITERIADE | INSERT
FINITION.EDIT.BUTTON

58 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUECRITERIADE | INSERT
FINITION.VIEW.BUTTON
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SNO | TABLE KEY DATA Type
59 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUECRITERIADE | INSERT
FINITION.AUDIT.BUTTON
60 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUESORT.TAB INSERT
61 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUESORT.ADD.B | INSERT

UTTON
62 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUESORT.EDIT.B | INSERT
UTTON
63 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUESORT.VIEW. | INSERT
BUTTON
64 FLS_ACCESS FLL.SER.UCS.ACCOUNTQUEUESORT.AUDIT. | INSERT
BUTTON
65 FLS_ACCESS FLL.SER.UCS.QUEUEASSIGNMENT.SUBMIT. | INSERT
BUTTON
66 FLS_ACCESS FLL.SER.UCS.QUEUEASSIGNMENT.RESET.B | INSERT
UTTON
67 FLS_ACCESS FLL.SER.UCS.QUEUEASSIGNMENT.FILTERE | INSERT
DACCOUNT.BUTTON
68 FLS_ACCESS FLL.SER.UCS.QUICKSEARCH.FILTEREDACC | INSERT
OUNT.BUTTON
69 FLS_ACCESS FLL.SER.UCS.QUICKSEARCHSPLITTER.FILT | INSERT
EREDACCOUNT.BUTTON
70 FLS_ACCESS FLL.SER.UCS.QUICKSEARCH.NEXTACCOUN | INSERT
T.BUTTON
71 FLS_ACCESS FLL.SER.UCS.QUICKSEARCHSPLITTER.NEX | INSERT
TACCOUNT.BUTTON
104 FLEX_TABLES QUE_CS_QAS_ACCOUNTS INSERT
105 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS_USR_CODE | INSERT
BUTES
106 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS_ACC_NBR | INSERT
BUTES
107 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS_RESPONSIB | INSERT
BUTES ILITY_CD
108 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS_PTC_COMP | INSERT
BUTES ANY
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SNO | TABLE KEY DATA Type

109 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS_PCB_BRAN | INSERT
BUTES CH

110 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS_DT INSERT
BUTES

111 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS_TITLE INSERT
BUTES

112 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS_PRD_PROD | INSERT
BUTES ucT

113 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS_STATUS_C | INSERT
BUTES D

114 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS DLQ DAYS | INSERT
BUTES

115 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS_AMT DUE | INSERT
BUTES

116 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS_OUTSTANDI | INSERT
BUTES NG_BAL

117 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS_PRO_ID INSERT
BUTES

118 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|QAS_SECURED_ | INSERT
BUTES CLASS_TYPE_IND

119 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_AO01

120 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A02

121 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_AO03

122 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A04

123 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A05

124 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A06

125 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A07
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SNO | TABLE KEY DATA Type

126 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_AO08

127 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A09

128 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A10

129 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED_ | | INSERT
BUTES ND_A11

130 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A12

131 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A13

132 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_Al4

133 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A15

134 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED_ | | INSERT
BUTES ND_A16

135 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A17

136 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A18

137 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A19

138 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A20

139 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A21

140 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A22

141 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A23

142 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A24
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SNO | TABLE KEY DATA Type
143 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A25
144 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A26
145 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A27
146 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED_ | | INSERT
BUTES ND_A28
147 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A29
148 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A30
149 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A31
150 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A32
151 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED_ | | INSERT
BUTES ND_A33
152 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A34
153 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A35
154 FLEX_TABLE_ATTRI | QUE_CS_QAS_ACCOUNTS|DSP_ENABLED | | INSERT
BUTES ND_A36
155 TRANSLATION_DAT | SYS|SYS|SYS|UCS|002002|CHECKCRITERIAI | INSERT
A SINERRORSTATUSHENCECANNOTUPDATET
HEQUEUEENABLEINDICATORASYES.|SYS|M
SG-SE
156 TRANSLATION_DAT | S|SYS|UCS|000055|SETTINGUPOFQUEUESU | INSERT
A SINGCOMPARISONOPERATORSFORVARCH
AR2DATATYPECANADVERSELYAFFECTTHE
PERFORMANCEOFTHESYSTEM.|SYS|MSG-
sSw
157 TRANSLATION_DAT | SYS|SYS|SYS|UCS|000903|INCORRECTOPER | INSERT
A ATORFORDATATYPEDATE|SYS|MSG-SE
158 TRANSLATION_DAT | SYS|SYS|SYS|UCS|000904/INCORRECTOPER | INSERT
A ATORFORDATATYPENUMBER|SYS|MSG-SE
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SNO TABLE KEY DATA Type
159 TRANSLATION_DAT | SYS|SYS|SYS|UCS|000906|INCORRECTVALU | INSERT
A EFORDATATYPEDATE|SYS|MSG-SE
160 TRANSLATION_DAT | SYS|SYS|SYS|UCS|000907|INCORRECTVALU | INSERT
A EFORDATATYPENUMBER|SYS|MSG-SE
161 TRANSLATION_DAT | SYS|SYS|SYS|UCS|000908|INCORRECTVALU | INSERT
A EFOROPERATORIS/ISNOT|SYS|MSG-SE
162 TRANSLATION_DAT | SYS|SYS|SYS|UCS|000909|INCORRECTVALU | INSERT
A EFOROPERATORTYPELIKE/IN|SYS|MSG-SE
163 TRANSLATION_DAT | SYS|SYS|SYS|UCS|000911|MISSING,INVALUE | INSERT
A FOROPERATORTYPEIN|SYS|MSG-SE
164 TRANSLATION_DAT | SYS|SYS|SYS|UCS|002005|ACTIVITIESDEFIN | INSERT
A EDASPERSORTSELECTIONCRITERIAARENO
TENABLEDFORTHESELECTEDQUEUE|SYS|M
SG-SE
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2.19 Collection Summary Enhancements

2.19.1 Overview

“Collections” tab is added in Servicing/Collections to display the customer and account
information (due and promises, important days related to accounts in a calendar, customer
preference details and activities done an account etc.). This screen will give a snapshot of
important account information required for a collection user.

2.19.2 Description

e A *“Collections” tab is added next to summary and before customer service tab.
> Following widgets are added to the “Collections” tab.
- Customer Information
- Address Information
- Employment Information
-  Telecom Information
- Collateral Information
- References & Other Contacts
- Dues & Promises

- Eligibility
- Customer Calendar
- Checklists

e  Customer Information:

» This section is part of “Account Details” widget and display the customer’s
information starting with primary customer.

>  This section display the following information
-  Customer #
- Name of the Customer
- Relation
- SSN number with first five digits masked
- National ID
- date of birth
- Gender
- Emall

e By default “Primary” customer record is selected from widget.

Customer Information

Customer £ Name Relation S5M Mational ID Birth Dt
0000023001 BAUER CHRISTIAM PRIMARY W-0-3977 --0 11/11/1987
0000023002 JAMES BOND SPOUSE W-a0a-9 0580 --10 10/10/1982

b
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Address Information:

> This section is part of “Account Details” widget and display the corresponding
address information of customer selected in “Customer Information” Section.

>  This section display the following fields.

- Type

- Current

- Permission to call

- Mailing

- Address (Concatenate - Address 1, Address 2, Address 3, City, State, Zip and
Zip Extn).

- Phone

Address Information

Permissicn
to Call

HOME Y Y Y

Type Currant Mailing Address Phone

3104 ADD1 ADDZ LAREDO TX-78046 (999)-999-9999

Employment Information:
>  This section is part of “Account Details” widget and display the corresponding
Employment information of customer selected in “Customer Information” Section.
> This section display the following fields.
- Type
- Current
- Permission to call
- Employer
- Address (Concatenate - Address #, Address 1, Address 2, City, State, Zip and
Zip Extn)
- Phone

Employment Information

Type Current E;rcrralﬁsmn Employer Mext Pay Day Frequency Address
FULLTIME Y Y 123 10/13/2017 MONTHLY 125 AD1 ADDZ REC

4

Telecom Information:
> This section is part of “Account Details” widget.

> A “Telecom Information” section is added to “Account Details” widget in “Collections”
tab in servicing/Collections screen.

> Following fields are added in to “Telecom Information” section.
- Type
- Permission to Call
- Time Zone
- Best Day to Call
- Best Time to Call
- Current Indicator
- Phone
- Extn

“Telecom Information” section display telecom details of selected customer in “Customer
Details” section.
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Telecom Information

Type Current E;rt:n;ilssiun Phone  Extn Time Zone  Best Day to Call
PHOME Y Y (775)-220-6998 1JS/EASTERN MONDAY 0
OTHER HOMEPH... Y Y (775)-886-3207 1JS/EASTERN ALL O

4

Collateral Information:
> A “Collateral Information” section is added to “Account Details” widget in “Collections’
tab.
> “Collateral Information” section is having following fields.
— Description
- ldentification #
-  Primary Indicator
- Year
— Asset Class
- Asset Type

- Sub Type

Collateral Information
Primary Description Identification # Year  Asset Class  Asset Type Sub T
Y 2017 HONDA ACCORD 2017 NEW VEHICLE CAR.

b

References & Other Contacts:

> A new “References & Other Contacts” section is added to “Account Details” widget in
“Collections” tab.

> References & Other Contacts section is having following fields.
— Relationship

- Name
- Phone 1
-~ Phone 2

- Comment
This widget reflect the data stored in Customer Service >References tab.
>  This widget show only the references with ACTIVE status.

Reference & Other Contacts

Relationship Name Phone Phone Comment
BROTHER-IN-LAW  HENRRY (011)-893-4582
BROTHER JOHN [011)-399-8953
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Dues & Promises:

> A new “Dues & Promises” widget is added in “Collections” tab.

>  This widget is having following fields.
- Total Due Amount
- Arranged (Sum of Amounts that are promised as part of “PTP”)
— Unarranged (Total Due Amount — Arranged)

> A pill Graph is added on the right side of the total amount due, and this displays the
breakdown of the total due amounts (Dues and fees).
- Pill graph display latest 4 unpaid due buckets and one “Historical Dues” bucket
for consolidated previous dues.

— If a Due is partially paid, then system display the remaining due amount not the
full due amount.

- For dues it display the title as Due Date xx/xx/xxxx (Date)
- Due amount and consolidated due amount below the due date.
- In case of Fees, it display the fee name as title.
- Fee amount and consolidated due amount is displayed below the title.
» The second pill Graph has the Promised Payments and Unarranged Amounts.

- In case of Promised Payments the title is “PTP for xx/xx/xxxx” and below the title
Promised amount is displayed.

— Unarranged amount is calculated “Total Due amount — Arranged Amount”.

Dues & Promises

Mistorical  06/13/207  07/13/2017 ~ 08/13[2017 ~ 09/13/2017  lateFee
205526 10,277.63 1027763 1027763 1027743 15000
61,815.78 20,5526 30,332.89 41,1052 51,388.45 £1,56578 6131578

Total Amt Dug

PTP for
Aranged 10,280.00 | ggy20/2017 Unarranged
Unarranged 51,535.78 10,280.00 51,535.78

Eligibility:

An “Eligibility” widget is added to “Collections” tab.
This widget consist of following sections.

» Extension

> DDC

If the account is eligible to take an extension, the same is marked in the “Extension”
section with Check Mark (v), if not display a (x) Mark.

If the account is eligible for Due day change, the same is marked in the “DDC” section
with Check Mark (v') else display a Red ().

Eligibility

Extension ¥ poc &

Customer Calendar:

A “customer calendar” widget is added in “Collections” tab.
User is able to select a particular month in a year from this widget.
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e This “Customer Calendar” display the following important dates of an account.

> Due Date
> Pay Day
> Paid Date

> Promised Date

> Current Date
e Due Date: Due date in a month is displayed with “Due Dt” label.
e Pay Day: Pay day in a month is displayed with “Pay Day” label.

> Primary customer latest current employment ‘Next Pay Day’ is displayed in the
calendar.

e Paid Date: Payment processed date in a month is displayed with “Paid Dt” label.

o Promised Date: Future PTP date in a month, which is greater than current date with
broken promise indicator is ‘N’, is displayed with “PTP Dt”

e Current Date: Current date in a month is displayed with “Current Dt” label.

o If multiple important dates fall on the same day, system display multiple labels in same
date. Also, based on the configured Time Zone, the events are either marked on specific
date or extended across two days.

| e 4 b | Today | September 2017
Sun Mon Tue Wed Thu Fri Sat
27 28 29 30 3 1 b
3 4 5 & 7 3 9
10 11 12 13 14 15 16
T
17 18 19 20 21 22 23
24 25 26 27 28 29 30
e Activities:

> An “Activities” widget is added in “Collections” tab.

>  This widget show the checklist columns shown in “Queue Assignment” screen.

>  This widget display all 36 checklist Activity fields.

»  This widget display the checklist details captured at “Queue Assignment” screen.

Activities
ADL ADZ AD3 AD4 AODS AOG AO7 AOS ADS ALD ALl AlZ AI3 A4 AIS AL6 AL7 AIR AL A
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Customer Servicing >Collections

tab

Customer Service x 3] gose
Search  Customer Service: 20170300013536 | Review Request (Pending: 0)  Queue Assignment =
Account(s): 20170300013536: CHRISTIAN BAUER / BOND JAMES View || < Audit

View v Format »  [Ep Freeze  Efi Detach o wrap w & ®) current () show All () Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt DLQ
[ usoi UsHQ UNDEFIHED 20170300013536  LOAH VEHICLE (FR) 155 USD. 123,243.80 61,665.78 ACTIVE:DELQ 04/13/2017 15TI
. »
Summary  Collections  Customer Service | Account Details | Customer Details | Customer Preferences | Transaction History ~PmtModes | Bankruptcy | Repo/Foreclosure  Deficiency  Collatersl | Bureau | Timeline | Cross/Up > ~
Dues & Promises
Total Amt Due Historical 06/13/2017  07/13/2017  08/13/2017  09/13/2017 Late Fee
o 20,555.26 10,277.63 10,277.63 10,277.63 10,277.63 150.00
61,815.78 20,555.26 30,832.89 41,110.52 51,388.15 61,665.78 61,815.78
PTP for
amanged 10,280.00  pgj9/2017 ~ Unarranged
Unarranged 51,535.78 10,280.00 5193578
Account Details 4 b | Todsy | September 2017 <
Customer Information Hen Tue ed Thy Fi sat
Customer # Name Relation ssu National 1D Birth Dt z = 2 0 3t B 2
7] 0000023001 BAUER CHRISTIAN  PRIMARY 00063977 -0 11/11/1987
0000023002 JAMES BOND SPOUSE 0-200-9090 --0 10/10/1952
“ »
3 4 5 6 7 8 0
Address Information
Type Current PEMESO  waiing  Address Phone D = - B - - -
HOME ¥ ¥ v 3104 ADD1 ADD2 LAREDO TX-78046  (999)-999-9999
Employment Information
T 17 18 19 20 21 22 23
Type Current P Employer Nest Pay Day Frequency Address
FULLTIME ¥ ¥ 123 10/13/2017 MONTHLY 125 AD1 ADD2 REL
“« »
24 25 2% 27 28 23 30
¥ Telecom Information
Type Current f:[l"‘i;fs‘“” Phone  Exin Time Zone  Best Day to Cal
PHONE Y Y (775)-220-6995 US/EASTERN MONDAY 0 i
OTHER HOMEPH... Y ¥ (775)-886-3207 US/EASTERN ALL 0 ty
! ¥ Extension ¥ ooc R
- Activities
Collateral Information AL AO2 AD3 AD4 ADS AD6 AO7 AOB AD9 AL All SASZ AI3 A4 AIS Al6 A7 AI8 Al AZ
Primary Description Identification # Year  AssetClass  AssetType  SubT
Y 2017 HONDA ACCORD 017 NEW VEHICLE AR
i X « Sort Ascending »
Reference & Other Contacts
Relationship name Phone Phone Comment
[77] BROTHER-IN-LAW  HENRRY (011)-898-4562
BROTHER, JOHN (011)-899-5958
Customer Preferences
Communication Mode Value Type Time Zone Best Day to Call Best™
No data to display.
“ »

2.19.3 Seed Data
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2.20 Customer Preference and Pay Day Enhancements

2.20.1 Overview

Employments details tab is enhanced to capture customer pay day and Pay day frequency and
same should be propagated to servicing. This information is useful for the collection users to
contact the customer on payday.

A “Customer Preference” tab is added to capture the customer preferred communication mode as
currently different communication modes are captured at different places.

2.20.2 Description

e Anew “Pay Day’ field is added to Origination >Applicant >Employments > Employment
Details (Actual and Stated) tab.

Field Name Data Type Validation Mandatory
Pay Day Date Greater than or N
equal system date

Employment Information ok add | A Edit | [E view || o audit
View v Format~  [Ep Freeze i) Detach Wrap [0
Current Permission to Call  Type Employer Title Occupation Phone Stated Years Stated Months Stated Salary Stz
Y Y FULL TIME UNDEFINED Qw OTHER (000)-000-0000 1 12 15,000.00

Employment Information
Save and Stay Save and Return (‘;I Return

* Current [ *Years 1

*Months 12

* Permission to Call (¥
Permission to Call Additional Info

*Type | FULL TIME v Pay Day tl
= Employer | UNDEFINED Phene ' (000)-000-0000 * Frequency MONTHLY v
Occupation OTHER v Extn 1231 Currency US DOLLAR =
Title QW Contact | AS0AS *Income At 15,000.00
Department  ADASD Contact Title 123132 Salary 15,000.00
Employee 1D | 1212 Contact Phone  (000}-001-2323
Contact Extn 1223 ——
Employment Address Comment ASDADAASDASDASDA *Years 1
* Country UNITED STATES v * Months 12
Address # 11 Pay Day 08/30/2017 e}
Address Line 1 ADRS A * Frequency MONTHLY v
Address Line 2 DRAS *Income Amt 15,000.00
Zip 01185 = salary 15,000.00
Zip Extn 123123 Verifiad

e This “Pay Day’ field is part of following functionalities
> Application Entry web service.
> API process
» Account on boarding web service.
» Correspondence and Letters elements.
> O tables
> OO Tables
> Reports and correspondence parameters
> Queue parameter

e Following field are propagated to servicing and shown under Customer Details
>Employments, once the application gets funded.
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Field Name Data Type Validation Mandatory
Pay Day Greater than or
Date equal to system N
date
Next Pay Day Calculated
based on Actual
Read Only N
Pay Day and
frequency
Frequency LOV NA Y
Addresses = Telecoms Employments = Tracking Attributes
Employment Information Gk add | A Edt | S view | & Audit
View = Format= [P Freeze i Detach Wirap [T
Current Permission to Call ~ Type Employer Occupation Title Next Pay Day Frequency Country Address City
Y Y FULL TIME 123 EMPLOYED 09/25/2017 WEEKLY UNITED STATES LAREDO

Employment Information
E Save and Stay El Save and Return (;JBEIum

* Current |+ Address Line 1 Phone (775)-886-3207
* Permission to Call [+ Address Line 2 Extn |0
*Type FULL TIME v Comment

= Employer 123

Occupation  EMPLOYED v

Tp T Pay Day 09/11/2017 By
Title Zip Extn Next Pay Day 08/25/2017
Department City  LAREDO * Frequency WEEKLY W
* Country UNITED STATES M Stabe [TEXS v

Address =

e Next Pay Day is updated based on frequency.

Ex: if the first captured Pay Day = “1/15/2017”, Frequency = Weekly and Current Date =
1/1/2017

If the system date moved to 1/16/2017, system should update the Pay Day to 1/22/2017.

e “Pay Day” and “Frequency’ fields are added to “CUS_EMPL_MAINT - EMPLOYMENT
ADDRESS MAINTENANCE” transaction.

> There is a validation where the Pay Day should be greater than system date.

o New “Next Pay Day” and “Frequency” fields are added to “Employment Information”
widget in “Collections” tab in servicing.

Employment Information

Type Current f;rcn;hssm-n Employer Mext Pay Day Freguency Address
FULL TIME ¥ Y 123 9/25/2017 WEEKLY LAREDO T
3

e All employment details are shown in this widget based on selected customer.
e Following columns are available in “Employment Information” widget.

Field Name

Next Pay Day
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A new “Customer Preferences” tab is added in Servicing next to “Customer Details” tab.

Frequency

This tab is having following fields.

Field Name | Data Type | Details Rendered | Mandatory
Relation This field will display Always
Type LOV only the relationship
(RELATIO types which are v
N_TYPE_C attached to account
D) and should be
enabled.
Communicat Values: Always
ion Mode EMAIL
New LOV Y
TELECOM
ADHOC TELECOM
Type LOV TELECOM_TYPE_CD Always Y
Value Display the respective Always
phone numbers or
email id’s based on
selected
communication mode
LOV/Text Display the text box v
Field when communication
type =ADHOC
TELECOM
Format : ### #i# #iHH
Extn Text Field NA When N
Communi
Permission | Check Box NA cation v
to Call (Default N) Type =
TELECO
Time Zone | TIME_ZON NA M/ADHOC N
E CD TELECO
_ M
Best Dayto | CALENDA
Call R_DAYS_ NA N
CD
Start Time Text B(_)x NA N
(Numeric)
Period TIME_PER
IOD_CD NA N
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End Time Text qu NA N
(Numeric)
Enable Check Box NA Always N
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Deceased customer relation type is not displayed in Relation Type LOV.
In customer preference tab, Edit button will only allow user to enable or disable the
record.

If user selects a specific relation type and a communication mode as “EMAIL”,
system will display the respective mail id of the selected customer in “Value” field
(Read only).

If user selects a specific relation type and communication mode as “TELECOM”,
system will populate the phone numbers (Address, Employment & Telecom) in
“Value” (Searchable LOV) field from Customer Details.

- Customer Preference “value” field display only the telecom records (Address,
Employment & Telecom) which are having Permission to call = “Y”.

— Based on the selected phone number following fields are populated (Read Only).

Extn

Permission to Call

Time Zone

Best Day to Call

Start Time

Period

End Time
If user selects a specific relation type and communication type as “ADHOC
TELECOM”, system display a Type field and text field to capture phone number in
“Value” field and following fields are editable.

Extn

Time Zone

Best Day to Call

Start Time

Period

End Time

- While adding an ad hoc telecom number, default value of Permission to call is “Y”
and it is read only.

- Once the user saves the record, ADHOC TELECOM number will be added to
“Telecom” tab and internally non monitory transaction is posted.

This tab allow only one enabled record for each communication mode for each
customer.

If user tries to add a same communication mode again, system display an error
message “Communication Mode is ready exists for this Relationship type”.
System disable the corresponding existing customer preference records when
following transactions are posted.

MARK CUSTOMER AS DECEASED

CHANGE TO PRIMARY CUSTOMER

DISABLE/ENABLE NON PRIMARY CUSTOMER RELATIONSHIP

SWAP RELATIONSHIP

1

L

L

1
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Ongination x  Customer Service x

Search  Customer Service: 1006226531  Review Reguest (Pending: 0)  Queue Assignment

Account(s): 1006226531: BAUER CHRISTIAN
View v Format~ [ Freeze EfiDetach | ol wrap 50}

Company Branch Sub Unit Account #
uso1 USHQ UNDEFINED 1006226531

Summary  Collections ~ Customer Service  Account Details  Customer Details | Customer Preferences] Transaction History  Pmt Modes Bankruptcy =~ RepojForeclosure  Deficiency  Collateral Bureau  Timel > ¥

Customer Preferences

View v Formatv [ Freeze ff Detach <l wrap 0]
Relation Type Communication Mede
PRIMARY TELECOM
PRIMARY ADHOC TELECOM
PRIMARY EMAIL ADDRESS
PRIMARY ADHOC TELECOM

S view || 2 Audit
® current () Show All ) Group Follow-up
Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest D
LOAN VEHICLE (FR) 232 USD 10,252.84 1,512.88 ACTIVE:DELQ 02/01/20

Ik add |/ Edit

Email Phone Enable Type

N
(775)-886-3207 N
345(252)-523-5235 N

EMPLOYMENT
OTHER HOME PHONE

TESTETEST.COM Y

21312(413)-413-4134 Y ANSWERING SERVICE

El view | < Audit

3

Extn P

Customer Preferences

* Relation Type v

* Communication Mode v

E Save and Add E Save and Stay

Phone Start Time

Extn Period

Permission to Call _ End Time
Time Zone Period

Best Day to Call * Enabled

E Save and Return

{a Retun Il

o Preferences captured at “Customer Preferences” tab are displayed in “customer
preference” widget at “Collections” tab in servicing for selected customer in “Customer

Information” widget.

Customer Preferences
Communication Mode
EMAIL ADDRESS
ADHOC TELECOM

Value Type Time Fone
TEST@TEST.COM
213124134134134 ANSWERING SERV... US/ALASKA

Best Day to Ca

MOMNDAY

> In case of “TELECOM/ ADHOC TELECOM” communication modes following fields
are populated in “Customer Preferences” widget.

- Extn

- Permission to Call
- Time Zone

- Best Day to Call
- Best Time to Call

2.20.3 Seed Data
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CUSTOMER PREFERENCES

SNO | TABLE

KEY DATA

Type

1 LOOKUP_TYPES

COMM_PREFERNCE_MODE_CD

INSERT

2 LOOKUPS

COMM_PREFERNCE_MODE_CD|EMAIL

INSERT

3 LOOKUPS

COMM_PREFERNCE_MODE_CD|TEL

INSERT

4 LOOKUPS

COMM_PREFERNCE_MODE_CD|ADHOC_T
EL

INSERT
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CUSTOMER PREFERENCES
SNO | TABLE KEY DATA Type
5 TRANSLATION_DATA SYS|SYS|SYS|UCS|002010|COMMUNICATI | INSERT
ONMODEALREADYEXISTSFORTHISRELAT
IONSHIPTYPE|SYS|MSG-SE
6 FLS_ACCESS FLL.SER.UCS.CUSTOMERPREFERENCE.T | INSERT
AB
7 FLS_ACCESS FLL.SER.UCS.CUSTOMERPREFERENCE.A | INSERT
DD.BUTTON
8 FLS_ACCESS FLL.SER.UCS.CUSTOMERPREFERENCE.E | INSERT
DIT.BUTTON
9 FLS_ACCESS FLL.SER.UCS.CUSTOMERPREFERENCE.VI | INSERT
EW.BUTTON
10 FLS_ACCESS FLL.SER.UCS.CUSTOMERPREFERENCE.A | INSERT
UDIT.BUTTON
Pay day enhancement
SNO | TABLE KEY DATA Type
1 FLEX_TABLE_ATTRIBU | INP_BMP_TNM|TNM_EMP_ACTUAL_FREQ | INSERT
TES _CD
2 FLEX_TABLE_ATTRIBU | INP_BMP_TNM|TNM_EMP_ACTUAL_PAY_ | INSERT
TES DAY_DT
3 TXN_CODE_PARAMETE | CUS_EMPL_MAINT|TNM_EMP_ACTUAL_F | INSERT
RS REQ_CD
4 TXN_CODE_PARAMETE | CUS_EMPL_MAINT|TNM_EMP_ACTUAL_P | INSERT
RS AY_DAY_DT
5 TRANSLATION_DATA SYS|SYS|SYS|ULN|001094|PAYDAYDATES | INSERT
HOULDBEGREATEROREQUALTOSYSTEM
DATE.|SYS|MSG-SE
6 TRANSLATION_DATA SYS|SYS|SYS|UCS|001094|PAYDAYDATES | INSERT
HOULDBEGREATEROREQUALTOSYSTEM
DATE.|SYS|MSG-SE
7 TRANSLATION_DATA SYS|SYS|SYS|TNM|001094|PAYDAYDATES | INSERT
HOULDBEGREATEROREQUALTOSYSTEM
DATE.|SYS|MSG-SE
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2.21 Insurance rebate enhancements

2.21.1 Overview

At present in OFSLL, if user wants to know the rebate quote for insurance before cancelling it then
user has to post Payoff quote. But in order to get the individual quote from a web service and take
a decision whether to cancel it or not, now providing a new monetary transaction ‘Compute
Insurance Rebate Quote’. The result of this transaction will be exclusive result for individual
insurance rebate quote in detail.

e If user using the web service to cancel the insurance, then system not sending the
outcome of the transaction in the result screen/block, now system will show the results in
detail.

e If user want to know the insurance premium rebate for individual active insurances
without any cost involved, how using the new monetary transaction user can know the
quote in detail.

e Ifinsurance is taken based on the mileage, then system will provide the insurance
premium rebate based on the current usage in case which is less than the insurance
premium rebate amount calculation using linked Refund Calculation Methods. i.e. if active
insurance refund calculation method is ‘PRO RATE BASIS’, system will compute two
rebates, one with ‘PRO RATE BASIS’ and 2" ‘PRO RATE MILEAGE'. Finally system will
arrive the less of two. If system arrives the negative amount, it will result as ‘0’ rebate.

2.21.2 Description

e Insurance Setup Changes:

> Provided a new Lookup value under ‘Setup > Products > Insurance > Loan > Add or
EDIT or View > Result’ as ‘Deduct Fee From’. Default value is ‘Premium Amount’.
- ‘Deduct Fee From’ attribute will be available for Account On-Boarding web
service, if user not provided then system will take the default value which is

‘Premium Amount’ (existing calculation method)

- This filed will be added in the conversion screen, if it is not provided systems will
default with ‘Premium Amount’ value
- This will have two lookup values:

Premium Amount: system will deduct the cancellation fee from premium and
then compute the rebate (existing calculation method)

Rebate Amount: System will deduct the ‘Cancellation Fee’ from the rebate
amount computed in OFSLL in order to obtain the final rebate amount. (i.e.
‘Cancellation Fee’ will not be reduced first from the selling price prior to the
rebate calculation).

e Origination changes:

» Provided a new read only field under ‘Origination > Contract > Insurance >
Add/EDIT/VIEW > Cancellation/Refund > Deduct Fee From, it will auto populate the
value from the Insurance Loan setup on selection of “Insurance Plan”

e Servicing/Collections screen changes:

> Provided a new read only field under ‘Servicing/Collections > Customer Servicing >
Account Details > Contract Information > Insurances > View > Cancellation/Refund >
Deduct Fee From, it will auto populate the value from the Origination insurances.

» Provided a new read only field under ‘Servicing/Collections > Customer Servicing >
Account Details > Insurances > View > Cancellation/Refund > Deduct Fee From, it
will auto populate the value on posting the ‘Insurance Addition’ monetary transaction.

e Conversion screen changes:
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> Provided the read only Deduct Fee From field in ‘Conversion Accounts > Account
Boarding > Contract > Insurances’ Tab, this will auto populate when user selects the
insurance Plan

e Changes in “Insurance Cancellation” monetary transaction:
> Provided existing ‘Current Usage’ parameter.
> User has to maintain the following filed for Usage Based insurance rebate.

Usage Details OFSLL field

The mileage at Origination/ Servicing/ Collections > Collateral > Vehicle >
purchase Valuation > Wholesale > Usage

Mileage contract term Origination/ Servicing /Collections > Collateral > Vehicle >

Usage Details > Total

Actual mileage ‘Current Usage’ is existing transaction parameter and is used
while user loading the ‘Insurance Cancelation’ monetary
transaction

>  While posting the INS_CANCEL transaction, if current usage is more than zero
then system will check if there are any mileage details maintained for primary
collateral then system will compute two rebates
— Oneis - using the existing process
- Second — using new ‘Refund Calculation Method’ ‘Pro Rata (Mileage)’

Then system will show the lesser of above two methods to arrive the final rebate if
mileage rebate is arrived in negative, then system will post with zero.

e Pro Rate (Milg) =

Product Selling Price * Miles Remaining

Term in Miles

> Product Selling Price = Customer Service > Account Details > Insurances >
Insurance Information >Premium Amt

> Miles Remaining = Customer Service > Collateral > Vehicle > Usage Details > Total
(plus +) Valuation > Usage (minus - ) Current Usage from Transaction Parameter
(should be greater than zero then only system will compute the rebate)

> Term in Miles = Servicing > Collateral > Vehicle > Usage Details > Total

e Provided a ‘Compute Insurance Rebate’ transaction to get the cost free individual quote
for active funded insurances

e User will be able to see the insurance rebate amount for all the active funded Insurances
attached to an account. Following are the parameters of this transaction.

PAYOFF QUOTE Should be greater than or equal to Insurance effective date
VALID UPTO DATE

INSURANCE TYPE INSURANCE_TYPE_CD

CURRENT USAGE If provided, system will use this value for Pro Rata (Mileage)
based rebate calculation.

e If the transaction ‘PAYOFF QUOTE VALID UPTO DATE’ is less than the insurance
‘Policy Effective Date’ then system wouldn’t calculate the ‘Rebate’ amount for those
insurance products.
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e If user didn’'t select any specific insurance type, then system will show the rebate for all
active insurances exists for that account and system also consider the insurance

‘Effective Date’ is less than or equal to transaction PAYOFF QUOTE VALID UPTO DATE
date.

e Following is the sample results which will be shown in ‘Insurance cancelation’ and
‘Compete Rebate Quote’

> If deduct fee from is Premium Amount — system will deduct the Cancellation Fee
from the ‘Premium Amount’ [Existing]

— ‘Derived Premium Amount’ = ‘Premium Amount’ minus (-) ‘Cancellation Fee’
- ‘Estimated Refund Amount’ = as per the ‘Refund Calculation Method’
— Interest Accrued or Rebate Interest

> If deduct fee from is Computed Rebate Amount — system will deduct the
Cancellation Fee from the final Rebate Amount’ i.e. after computing the rebate
amount using the ‘Premium Amount’ then deduct the cancellation fee. [New]

- For ‘Compute Rebate Amount’ txn’s result should have [ if user provide the value
for Current usage then system has to compare against Pro mileage and existing
calculation]

= ‘Derived Premium Amount’ = ‘Premium Amount’

* ‘Rebate <<INSURANCE TYPE>> = as per the ‘Refund Calculation
Method’

= ‘Cancellation Fee’ = Cancellation Fee
= ‘Estimated Refund Amount’ = Rebate Amount’ — ‘Administration Fee’
= |nterest Accrued or Rebate Interest

- For ‘Insurance Cancellation’ txn’s result should have
If INSURANCE REFUND AMOUNT is NULL

= ‘Derived Premium Amount’ = ‘Premium Amount’

= ‘Rebate <<INSURANCE TYPE>> = as per the ‘Refund Calculation
Method’

= ‘Cancellation Fee’ = Cancellation Fee
= ‘Estimated Refund Amount’ = Rebate Amount’ — ‘Administration Fee’
= Interest Accrued or Rebate Interest

If INSURANCE REFUND AMOUNT is not NULL i.e. even if user provide the
Mileage, system will not consider the user provided value.

= ‘Estimated Refund Amount’ = INSURANCE REFUND AMOUNT

= Interest Accrued or Rebate Interest
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2.21.3 Screenshot
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Setup > Insurance > Loan

Insurance x

Loan | Line

Insurance

view v Format~ [ Freeze HfiDetach | <J wrap
Code &7 Description

LN-CE-VR-INS-002
4

INSURANCE LIFE

Insurance

Code LN-CE-VR-INS-002
* Description INSURANCE LIFE
=Start Dt 10/20/1095 [
=End Dt 12/31/4000 B
~Enabled ¥

B Mew Insurance

% Create Copy

& )
Start Dt End Dt Enabled

10/20/1995 12/31/4000 ¥

Result

*Insurance Type INSURANCE LIFE
* Insurance Company EVER GREEN

* Cancellation Refund ¥
Allowed

* Grace Days 15
*Refund Calculation Method RULE OF 78 / SUM OF DIGITS
* Cancellation Fee 0

* Grace Days Cancellation ¥
Ece Allowed

Insurance Type

INSURANCE LIFE  EVER GREEN Y

v

Insurance
Company Allowed

Select the deduct fee from

|* Deduct Fee From | PREMIUM

[ Close

4 add | ZEdt | 5l view | <7 udit

Cancellation/Refunt Grace Days Refund Calculati

15 RULE OF 78 / SL
3

| [ save and stay || [ save and Return | GaReturn

Selection Criteria

= Company ALL v
= Branch ALL hd
*Product ALL v

*sState ALL hd

* Currency ALL hd

Origination > Funding > Contract > Insurance

Contract (2) Repayment Itemizations Trade-In

Insurance Information

View + Format ~ E’ Freeze %Det&ch

Insurance -
Insurance Type ErmE Policy #
|77 ITM CREDIT INS_
ITM CREDIT INS..
ITM INSURANCE..

4

Insurance Information

Insurance Plan
Insurance Type ITM CREDIT INSURANCE

Sub Type SINGLE
Insurance Company
Policy #
Effective Dt

Term 0
Expiry Dt
Commission Rule
Premium Amt 0.00

Subvention

qﬁ Wrap

Insurances ESC =~ Compensation

o) Calculate

Term Premium Amt Effective Dt

a 0.00
1) 0.00
1) 0.00

Commission Amt 0.00
Phone
Extn
Phone
Extn

Beneficiary

Primary
Secondary

Proceeds

Disbursements Fees = ACH Coupons References

[ it ][ Bl view | < udt |

Expiry Dt Insurance Plan Sub Type Comm
SINGLE
SINGLE
SINGLE

»

| GaRetum |

Cancellation/Refund

Cancellation Refund Allowed —
Grace Days
Calculation Method NONE

Grace Days Cancellation Fee —
Allowed

Cancellation Fee
|Deduct Fee From |
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Servicing/Collections > Customer Service > Account Details > Insurance

Summary || Collections

Primary Benefidary
Secondary Beneficiary

Customer Service

Account Details

Customer Details

Policy Cancellation Dt

Customer Preferences

Cancellation/Refund

Transaction History =~ Pmt Modes = Bankruptcy

(Elyew ]| & auie |

Effective Dt Premium Amt

Refund Allowed —

Grace Days Cancellation Fee _
Allowed

Cancellation Fee
Complete Refund —

Term Remaining

Refund Calculation Method

Grace Days

Estimated Refund Amt

Received Refund Amt

Itemization

Account Details | Statements = Rate Schedule Insurances Condition Details | Securitization = Contract Information
Insurance Information
View = Format = E Freeze % Detach qﬂ Wrap Eﬁ
Contractual Insurance Type Company Policy #
No data to display.
1
Insurance Information
Policy Information Status
Sub Status
Contractual — Insurance Mode
Insurance Type Phone
Insurance Plan Phone 2
Company Itemization
Policy # Expiry Dt
Effective Dt Term
Premium Amt Commission Amt
Commission Rule Comments

Repo/Forec » ~

Term Status

| <@Return |

| Deduct Fee From

Servicing/Collections > Customer Service > Account Details > Contract Information >

Insurance
Summary = Collections =~ Customer Service  Account Details = Customer Details ~ Customer Preferences = Transaction History = Pmt Modes = Bankruptcy | Repo/Fo > ~
Account Details = Statements = Rate Schedule = Insurances = Condition Details = Securitization ~Contract Information
Contract | El view |
View ~ Format = E Freeze % Detach <l wrap Gﬁ
Contract Dt Amt Financed Term Maturity Dt Due Day  Finance Charge Total of Pmts Down Pmt Final Pmt #
[ o5/01/2017 25,000.00 12 05/01/2018 1 693.56 25,603.56 0.00 2,141
] »
Contract | Repayment Itemizations Trade-In Insurances ESC Compensation  Subvention Proceeds —Disbursements Fees ACH  Coupon | » ™
Insurance Information | =l view |
View v Format~ [ Freeze HfiDetach | o wrap (o))
Insurance )
Insurance Plan Insurance Type Sub Type B Policy # Phone Extn
. ITM CREDIT INSURANCE LIFE SINGLE
ITM CREDIT INSURANCE DISABILITY SINGLE
ITM INSURANCE GAP SINGLE
] »
Insurance Infermation
| Gagetum |
Effective Dt Cancellation Term 0
Policy Information Expiration Dt Remaining
Premium Amt 0.00 Refund Allowed —
Insurance Plan Term 0 Refund Method NONE
Insurance Type IL_[I'M CREDIT INSURANCE Commission Rule Estimated Refund Amt 0.00
) Commission Amt 0,00 Received Refund Amt 0.00
: iUb Type SINGLE Primary Complete Refund —
nsurance Company
. |'D v Secondary Grace Days 0
o ';V B Cancellation Fee Allowed
Fhone Cancellation/Refund Cancellation Fee 0.00
Bxin Comment
Phone2 Policy Cancellation Dt [ Deduct Fee From |
Extn2
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Servicing > Conversion Accounts > Account Boarding > Contract > Insurance

Applicants = Business =~ Requested Decision Contract Collateral = Account Details = Comments = Verification
Contract Information | ZEdt || B view || < audit |
View v Format~ [ Freeze fi Detach «Jl wrap ©) | Select Instrument |
Contract Rovd Dt Contract Dt Term Index Type Index Rate Margin Rate Rate  Balloon Amount
[ 01/20/2016 01/20/2000 36 FLAT RATE 0.0000 49900 4.9900 0.00
4 3
Details = Repayment Repayment Schedule =~ Payment Change Schedule | Ttemizations Insurances ESC Escrow =~ Compensation  Subvention » -
Insurance Information | ZEdit || B view || < audit |
View = Format - Eﬁ Freeze % Detach cﬂ Wrap Gﬂ
Insurance Plan Insurance Type  Sub Type %:r:]s;;aar;cye Policy # Effective Dt Expiry Dt Premium Amt
No data to display.
4 3
Insurance Information
| {aRetumn |
Term Secondary
Policy Information Commission Rule
Commission Amt Cancellation/Refund
Insurance Plan hone
Insurance Type Extn Allowed —
Sub Type Phone 2 Grace Days
Insurance Company Extn 2 Calculation Method
Policy # Grace Days Cancellation —
Effactive Dt Beneficia Fee Allowed
Expiry Dt Cancellation Fee
Premium Amt Primary Comment
| Deduct Fee From |
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Servicing/Collections > Customer Service > Customer Service > Maintenance

Transaction Batch Information

Summary = Collections = Customer Service = Account Details

Call Activities  ~ Maintenance Comments  Promises — Checklists

Customer Details

Tracking Attributes = Field Investigatio > ~

Customer Preferences

T » ~

A add | AEdit | Elview | < Audit |

Transaction Processing Details

REBATE INTEREST = USD «<61.23>

. DERIVED PREMIUM AMOUNT = USD 4,925.00
REBATE INSURAMCE LIFE = USD 3,265.34
ESTIMATED REFUND AMOUNT INSURANCE LIFE = USD 3,265.34

#=%=% Transaction Posting Successful ===+

View = Format = Freeze % Detach cﬂ Wrap Eﬂ s§} Post
' 'Date Monetary Transaction Status
. 09/27/2017 Y INSURANCE CANCELLATION POSTED
09/20/2017 Y PAYOFF QUOTE OPEN
09/20/2017 Y BACK DATED PAYOFF QUOTE POSTED
09/20/2017 Y PAYOFF QUOTE POSTED
09/20/2017 Y PAYOFF QUOTE POSTED
Parameters
View ~ Format~ [ Freeze iDetach | & Wrap 0]
Parameter Value
[ 7w DaTE 09/01/2017
INSURANCE TYPE INSURAMNCE LIFE
POLICY EFFECTIVE DATE
INSURANCE REFUND AMOUNT
PAYMENT AMOUNT i]
CANCELLATION REASON UNDEFINED
CURRENT USAGE i]
Result
View v Format = E’ Freeze % Detach qﬂ Wrap Eﬂ

L% Void

Batch

Z=E===2

Required

=< < =Z=Z <=

ORACLE



Summary | Collections

Call Activities  Maintenance Comments = Promises

Customer Service = Account Details

Customer Details

Customer Preferences

T » ™

Checklists | Tracking Attributes | Field Investigatio > ~

Transaction Batch Information % Add || &7 Edit View || < Audit
View v Format v |5} Freeze i Detach ¢l wrap (B £} post  [53 Void
& &y
Date Monetary Transaction Status Batch
09/22/2017 Y COMPUTE INSURANCE REBATE QU... OPEN N
[9/22/90117 Y COMPUTE TN’%I]RWTF Ul POSTED I
1 09/22/2017 Y |COMPUTE INSURANCE REBATE QU... \POSTED N
Parameters
View » Format~ [Ep Freeze HiDetach | < Wrap i)
Parameter Value Required
. PAYOFF QUOTE VALID UFTO DATE 05/10/2017 Y
INSURANCE TYPE N
CURRENT USAGE 0 Y
Result
View = Format = % Freeze ﬁ' Detach ¢ Wrap Elﬂ
Transaction Processing Details
. DERIVED PREMIUM AMOUNT = USD 5,000.00
REBATE INSURAMNCE LIFE = USD 5,000.00
ESTIMATED REFUND AMOUNT INSURANCE LIFE = USD 5,000.00
REBATE INTEREST = USD <183.20>
*=%=% Transaction Posting Successful ===
2.21.4 Seed Data
SNO | Table Key Data Type
1 TXN_CODES INS_REBATE_QUOTE POSTED
2 TXN_CODE_PARAMETERS INS_REBATE_QUOTE|TXN_INSURA POSTED
NCE_TYPE_CD
3 TXN_CODE_PARAMETERS INS REBATE_QUOTE|TXN_POQ DT | POSTED
4 TXN_CODE_PARAMETERS INS REBATE_QUOTE|TXN_USAGE_ | POSTED
CUR
5 TXN_CODE_PARAMETERS INS_CANCEL|TXN_USAGE_CUR POSTED
6 FLEX TABLE_ATTRIBUTES INP_BMP_TXN|TXN_USAGE_CUR POSTED

2-114

ORACLE



2.22 Account data conversion enhancements

2.22.1 Overview

Data conversion process is enhanced to accept 24 month payment history data that will be
reported in the Metro Il report under the field ‘Payment History Profile’. As part of account
conversion customers should able to convert the 24 payment history data from the legacy system
to accounts to report the proper payment history.

In case of 24 months payments history data, OFSLL stores the account payment history string i.e.
24 alpha-numeric characters in ACC_CRB_FULL_PMT_HISTORY column of ACCOUNTS table.
Post this, with account contract date, system derives each month/year and corresponding
payment rating from each of the 24 (or less) characters available. In this column, payment history
data is stored such a way that last month’s payment rating code will be displayed at the right most
side.

E.g. 01234566666666666666666

Above mentioned payment history profile will be displayed on the Customer Service —
Transaction History — Payment Rating screen by showing the latest rating code (displayed at the
right most side as mentioned above) first.

Now whenever the account picked up by Metro_II_DATA table population batch job,
Metro_II_DATA.MET_BASE_PMT_HISTORY_PROFILE field will be populated with payment
rating from the left to right in most recent to least recent order.

E.g. 6666666666666666543210BB

In Metro Il report also, system reports the payment rating from the left to right in most recent to
least recent order under field 18 - Payment History Profile of base segment.

2.22.2 Description

For 24 month payment history:

e New field ‘ACC_CRB_FULL_PMT_HISTORY’ has been added to API_ACCOUNTS and
IACCOUNTS tables to accommodate 24month payment history profile.

e Conversion control file api_acc_111.ctl has been modified to accommodate above
mentioned new column.

e lItis a prerequisite that 24 months payment history profile string should be prepared as
per the specifications mentioned in the 2015 version of Credit Reporting Resource guide.
Additional changes in API table:

e Following new fields has added to API_ACCOUNTS and IACCOUNTS tables to support
the same for legacy accounts conversion for more accurate functioning in OFSLL
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> ACC_RAT_RUN_DT_NEXT

> ACC_RATE_START_OF YEAR
> ACC_CHGOFF_AMT

> ACC_DDT_RUN_DT_LAST

> ACC_CRB_FIRST_DLQ DT

> ACC_CLOSE_DT

> ACC_OPEN_IND

Due Date History Conversion:

e Providing the ACCOUNT_DUE_DATE_HISTORY table fields as part of conversion, i.e.
all tables columns will be available in API_ ACCOUNT_DUE_DATE_HISTORY and
IACCOUNT_DUE_DATE_HISTORY table.

e Atpresentif ACCOUNT_DUE_DATE_HISTORY.ADH_TXN_SET_ID is null, still system
is allocating the payment to that bill because ‘ADH_PRIMARY_IND’ is ‘Y’ (that means, bill
is in active status).

e For converted accounts, user can load the data with ADH_PRIMARY_IND as ‘Y’ and
ADH_TXN_SET_ID as ‘null’.

e Conversion accounts have active unpaid dues on or before the conversation date
(ACC_BACKDATE_DT) but TXNS table have only one transaction on conversion date, in
case of any reversal there won’t be any Billing transactions in ‘TXNS’ table so, reversal
case won’t come at all.

e Please Note: If we allow Bills till the conversation date (ACC_BACKDATE_DT) then
system failed to report the Metro Il filed 25 (FCRA Compliance/ Date of First
Delinquency) so, we can maintain the ADH_PRIMARY_IND as ‘Y’ and
ADH_TXN_SET_ID as ‘null’.
2.22.3 Screenshot

NA
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2.23 Backdate a Payoff Quote

2.23.1 Overview

OFSLL has been enhanced to post backdated payoff quote, the payoff quote amount as on the
date less than the current process date. This is required for when a bankruptcy is filed by the
customer and after so many days after court admitting the customer then OFSLL should provide
the payoff amount as on the petition date.

2.23.2 Description

At present user can generate a back dated ‘Payoff Quote’ Transaction; however the past payoff
amount calculated is in-correct. Following are the changes developed:

e Since new monetary transaction is now available to generate a back dated payoff quote,
existing payoff quote transaction (PAYPOFF) has been modified so that it will not accept
any back date for ‘Transaction Date’ and ‘Payoff Quote Valid Up to Date’ i.e. these dates
will not be less than the GL date.

e Provided a new ‘Backdated Payoff Quote’ Monetary Transaction with following

parameters-
Parameter code Validation
PAYOFF QUOTE VALID UP TO Maximum of Contract Date
DATE (ACC_CONTRACT_DT) or Account Back
dated date (ACC_BACKDATE_DT)
ASSESS PAYOFF QUOTE FEE Processed as existing
PAYOFF QUOTE LTR PRINT Processed as existing
COMMENT User Input — free text

e System will allow back dated payoff quote only up to the contract date or backdate date
(whichever is maximum) of the account.

e In case if the back date entered is beyond the maximum of contract date and backdated
date of the account, system will display an error message ‘Back dated payoff quote is not
allowed beyond the contract date or backdated date of the account !’

e After user provided a valid back date for ‘Payoff Quote Valid Up to Date’, system will
compute the backdated quote and display under Results section of maintenance screen

2117 ORACLE



2.23.3 Screenshot

Summary = Collections Customer Service Account Details | Customer Details = Customer Preferences  Tri » ™
Call Activities ~ Maintenance Comments Promises Checklists = Tracking Attributes | Field Investigatio » ~
Transaction Batch Information =k Add || 7 Edit View || < Audit
View ~ Format « Freeze ﬁ' Detach &l Wrap Elﬁ .,,} Paost ._gé Void
& & | j
Date Monetary Transaction Status Batch
IGQIZDIZOIT Y BACK DATED PAYOFF QUOTE POSTED N
0a/20/2017 Y BACK DATED PAYOFF QUOTE POSTED M
09/20/2017 Y BACK DATED PAYOFF QUOTE POSTED M
Parameters
View ~ Format - E’ Freeze Eﬂ' Detach & Wrap Elﬁ
Parameter Value Required
. PAYOFF QUOTE VALID UPTO DATE 09/01/2017 Y
ASSESS PAYOFF QUOTE FEE NO Y
PAYOFF QUOTE LTR. PRINT NO Y
COMMENT PROVIDED TO Y
Result
View v Format= [Ep Freeze 54 Detach «ll Wrap (B
Transaction Processing Details
[ ADVANCE / PRINCIPAL = USD 25,683.96
FEE LATE CHARGE = USD 90.00
REBATE INSURANCE LIFE = USD <3,265.34=
REBATE INTEREST = UsSD <315.67>
PAYOFF = USD 22,192.95
**#=% Transaction Posting Successful ==+
2.23.4 Seed Data
SNO | Table Key Data Type
1 TXN_CODE_PARAMETERS PAYOFF_BACKDT|TXN_COMMENT POSTED
2 TXN_CODE_PARAMETERS PAYOFF_BACKDT|TXN_PAYOFF_FEE_| POSTED
ND
3 TXN_CODE_PARAMETERS PAYOFF_BACKDT|TXN_POQ DT POSTED
4 TXN_CODE_PARAMETERS PAYOFF_BACKDT|TXN_POQ LTR_PRIN | POSTED
T_IND
5 TXN_CODES PAYOFF_BACKDT POSTED
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2.24 Payment reversal enhancements

2.24.1 Overview

All account level monetary transactions are posted by system batch or user. Some cases like
backdated transactions, system will reverse and repost. In such cases user should able to know
the system reversed transactions and user reversed transactions like payment reversal. All
system corrected Monetary transactions posted (as part of back dated transaction processing-
reversal and re-posting) as INTERNAL’ and actual Monetary transactions with the corresponding
user name on Customer Service > Transaction History > Transactions screen.

Using payment posting web service system allows reversing the payments, but payment
transactions can be posted on the exact same day for the exact same amount. In such cases,
user should able to correct off one or both using a ‘Reference’ field.

2.24.2 Description

2-119

‘Transactions’ screen changes:

e Showing the ‘Posted By’ column in ‘Servicing/Collections > Customer Service >
Transaction History > Transactions’ tab after ‘Reason’ column.
> This column will refer TXNS.CREATED_BY column to display the value
> This is applicable for all products types (Loan/Line/Lease)

- Also provided a new three radio buttons, ‘System’, ‘User’, and ‘All Txns’ under
new label ‘View’

- By default, ‘All Txns’ radio button will be selected

- If user selects,
=  System — system shows only ‘Posted By’ is INTERNAL’
= User — system shows only ‘Posted By’ is not INTERNAL’
= All Txns — system shows all transactions.

Payment posting web service changes:

e At present, system is checking the ‘PaymentDate’ and ‘PaymentAmount’ fields to validate
the payment transaction exists on the ‘AccountNumber’ that needs to be reversed.

e Enhanced, system will check if the action is ‘REVERSE’ and if ‘PaymentReference’ is
provided, then system will validate this field with existing good payments along with the
existing validation to decide on the payment to be reversed.

e If ‘PaymentReference’ is not provided (i.e. while Post and Reverse actions) and it is null
in OFSLL, then also system will reverse the payment transaction subject to the
availability of a unique payment that can be reversed.

e If there are multiple records found with the same reference number (along with date and
amount) then system will send an error message ‘Multiple Records found, Not able to
reverse the payment transaction!’

e Payment Reference is an existing field which will be used for identifying the unique
record. While posting the payment user is expected to provide the uniqgue number for
each payment. System won'’t validate the reference keys with existing reference.

e Sample request XML provided below
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<?xml version="1.0"?>
<PaymentPostingRequest>
<UserCode>RBOINA</UserCode>

<PaymentPosting>
<GroupSubTypeCode>WEB</GroupSubTypeCode>
<AccountNumber>20170400010250</AccountNumber>
<PaymentDate>2017-05-01</PaymentDate>
<PaymentAmount>6230</PaymentAmount>
<PaymentModeCode>ACH</PaymentModeCode>
<ReasonCode>REGULAR</ReasonCode>

<PaymentReference>RBOINA_0527</PaymentReference> -- New
validation element

<PaymentComment>PAYMENT</PaymentComment>
<CurrencyCode>USD</CurrencyCode>
<Action>REVERSE</Action>
</PaymentPosting>
</PaymentPostingRequest>

2.24.3 Screenshot

Servicing/Collections > Customer Service > Customer Service > Transaction History >
Transactions

Summary | Collections | Customer Service Account Details =~ Customer Details = Customer Preferences  Transaction History = Pmt Modes Bankruptcy = Repo/Foreclosure = Defidency | » ™

Balances Transactions Sale Transfer Transactions =~ Payment Rating ~ Due Date History | Repayment Schedule =~ Work Orders

Transactions View Audit
SortBy @ PostDt O TxnDt  view Options Good Payments O All Payments ) Good Fees ) All Fees @ Good Txns O All Txns | view System () User @ All Txns
View = Format |§| Freeze ﬂ' Detach Wrap GB Ea Reverse Export to Excel
v
Amount Details Balance Amt E‘a"r;zﬁ: Pavn:_\enqg Payment Type Reference Mode Reason Posted By
101.00 23,265.65 USD UNDEFINED NONE INTERNAL
150.91 23,164.65 USD INTERNAL
223.00 23,164.65 USD UNDEFINED NONE RBOINA
0.00 23,164.65 UsD RBOINA
2,569.35 DUE DT 10/01/2017 23,164.65 USD RBOINA
129.00 23,164.65 USD UNDEFINED NONE RBOINA
30.00 23,164.65 USD MAVEEN
0.00 POSTED ON 09/18/2017 23,164.65 UsD MHAVEEN
99.54 23,164.65 USD NAVEEN
2,569.35 DUE DT 09/01/2017 23,164.65 USD MNAVEEN <
l
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2.25 SET-XPR Batch Job to support MDB

2.25.1 Overview

As per the existing functionality the database makes synchronous outbound calls to producer

data dump web service, to dump the data into external system and acknowledged the database if

process was either successful or failure. However, during this process there is a chance of
database session time out.

Using MDB (Message Driven Bean), both database call and session time out can be avoided as

the trigger between database and producer data dump web service is managed using MDB
messaging.
The following external producer data dump batch jobs are upgraded to support the MDB flow:

e Batch Job SET-XPR is to dump producer data into Dealer Track.
e Batch Job SET-XPR2 is to dump producer data into Route One.

2.25.2 Description

Following are the changes post the upgrade of batch job:

1. Two new system parameters are introduced to enable producer data dump to route through
MDB. If the value of system parameters are set to ‘Y’, system uses MDB flow. Else, existing
flow is used.

e OUTBOUND_DLR_TRACK_Q (OUTBOUND CALL FOR DEALER TRACK)
e OUTBOUND_ROUTEONE_Q (OUTBOUND CALL FOR ROUTEONE)

to Y’, system invokes MDB flow and generates an outbound JMS message though the
configured MDB interface with the following details:

> Type: OUTBOUND

> Sub Type: POST_DEALER

> Job ID: Job Request ID

> Source: DLR_TRACK / ROUTEONE

Note: For information on configuring MDB, refer to Patch Installation document.

3. OFSLL checks the JMS message (for the above message type) and invoke ‘Post Dealer
SOAP service’ to dump the producer details maintained in the system into external interface.

Before doing so, system reads external interface details from the CSF mapping. For
information on CSF mapping details, refer to Patch installation guide.

| Error.

2.25.3 Seed Data
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On executing the SET-XPR / XPR2 Batch Job, if the value of above system parameter is set

Based on the data dump, the corresponding status of Batch Job is updated as either Success

SNO | TABLE KEY DATA Type
1 FLEX_TABLE_ATT | SET_SYP_SYSTEM| OUTBOUND_DLR_TRACK_Q INSERT
RIBUTES
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SNO | TABLE KEY DATA Type

2 FLEX_TABLE_ATT | SET_SYP_SYSTEM| OUTBOUND_ROUTEONE_Q INSERT
RIBUTES

3 SYSTEM_PARAM | OUTBOUND_DLR_TRACK_Q INSERT
ETERS |SET_SYP_SYSTEM|ALL|ALL|ALL|ALL|ALLJALLJALL

4 SYSTEM_PARAM | OUTBOUND_ROUTEONE_Q INSERT
ETERS |SET_SYP_SYSTEM|ALL|ALL|ALL|ALL|ALL|ALLJALL
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3. Patches and Bugs
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-NA-

4. Security Fixes
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5.Limitations and Open issues

5.1 Limitations and open issues

5-1

26544631

Refresh issues noted in Setup - Access - Screen & Webservice tabs.
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6.1

6.2

6. Components of the Software

Documents accompanying the software

The various documents accompanying the software are as follows:

e Release Note

e [nstaller Kit

e User Manuals and Installation manuals - These can be accessed from the link

e http://docs.oracle.com/cd/E72985 0l/homepage.htm

Software Components

Software Components of OFSLL 14.4.0.0.0 that form part of this release are as follows:

e Core

>
>

Ul Components Ear file JSF, XML, XLF, JSFF)

Stored Procedures (Packages, Views, Java Stored procedures)
Reporting Components(Data models(xdm), Reports(xdo, rtf))
BIP / canned reports

e |Interface

>

Stored Procedures (Packages, Views, Types)
The WSDL files for the service supported

XSD Structure (dictionary) for the web service
Configuration files for the web service

Java classes for the web service

The service documents — describing the services

Extensibility Document — Describes customization for the services.

e [nstallation utilities

>

Script based installation for Database components
Installation documents for Database, Ul, Web services
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7. Annexure — A: Environment Details

Component Deploymen | y;achine Operating | sofpware Version
t option System
Oracle WebLogic
Enterprise
Edition(Fusion
Middleware 12.2.1.3.0
Infrastructure installer
—includes ADF and
Application Oracle RCU)
server Enterprlse
Linux 6.7+
&7.0 Oracle JDK 1.8.0_144
(64 Bit) and
Sun Application
_SPARC Development 12.2.1.3.0
with Oracle Framework
Oracle Solaris 11
Financial (64 Bit)
Services Centralized | Database Oracle Database 12.1.0.2.0
Lending and Server Enterprise Edition
Leasing
Reporting Oracle Business
Server Intelligence Publisher 12.2.1.3.0
Windows 7, *Microsoft Edge 38
Windows
10* Internet Explorer 11.0
Client Mozilla Firefox 55
Machines
Google Chrome 60
Apple Safari 8
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8. Annexure — B: Third Party Software Detalils

Apache SOAP 2.3.1
Jason Hunter & Brett McLaughlin JDOM 2.0.6
Apache Ant 1.10.1
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9. Annexure — C: Module Code and Description

ORG Origination

Cs Customer Service
CoL Collection

CRB Credit Bureau
ACX Account Boarding
API Application Conversion Interface
LN-CE Loan

LN-OE Line

LS-CE Lease

TXN Transaction

UIX User Interface
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